
Global Service and Support (GSS) Technical Publications

P/N 9012608-000
Revision AA

KLA-Tencor Confidential—Restricted Distribution

Preliminary

9019320-000 

Revision AC

Alpha-Step® D-500 and D-600 User Manual



Document Number: 9019320-000, Revision AC KLA-Tencor Confidential - Restricted Distribution

P
re

li
m

in
ar

y
 



KLA-Tencor Technical PublicationsOne Technology Drive,
Milpitas, CA. 95035

KLA-Tencor Corporation

9019320-000 / AC  i
KLA-Tencor Confidential - Restricted Distribution

Alpha-Step® D-500 and D-600 User Manual



Copyright 
Copyright © 2016–2017 by KLA-Tencor. All rights reserved worldwide. No part of this 
publication should be reproduced, modified, transmitted, transcribed, stored in retrieval 
systems, or translated into any human or computer language, in any form or by any means, 
electronic, mechanical, magnetic, chemical, manual, or otherwise, without the express 
written permission of KLA-Tencor, One Technology Drive, Milpitas, California 95035. 
KLA-Tencor might revise this document at any time without notice.

Trademarks
Alpha-Step® is a trademark of KLA-Tencor Corporation. KLA-Tencor® and the KLA-
Tencor logo are registered trademarks of the KLA-Tencor Corporation. All other brand 
and product names might be trademarks of their respective companies.

Disclaimer

Distribution is restricted to customers of this product who have a current, signed
nondisclosure agreement (NDA) on file with KLA-Tencor. KLA-Tencor employees
must receive written approval from a KLA-Tencor employee at the Director Level or
above before distributing this document to anyone outside of KLA-Tencor.

Reprint Acknowledgements
This document contains excerpts from the following SEMI® Standards and/or Safety 
Guidelines: SEMI S1-0708E, "Safety Guidelines for Equipment Safety Labels," and 
SEMI S2-0709, "Environmental Health, and Safety Guidelines for Semiconductor 
Manufacturing Equipment,"  Copyright  © Semiconductor Equipment and Materials 
International 2009. All Rights Reserved. Used by Permission. SEMI is a registered 
trademark of Semiconductor Equipment and Materials International. www.semi.org

Send any comments to: GSS.Document.Control@kla-tencor.com

KLA-Tencor Document Number: 9019320-000

Revision: AC

“We are committed to assisting our customers in obtaining maximum value from 
KLA-Tencor products by providing excellent support at exceptional value.”

ii  9019320-000 / AC
KLA-Tencor Confidential - Restricted Distribution

www.semi.org
www.semi.org
GSS.Document.Control@kla-tencor.com


Table of Contents
Chapter 1 Safety. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1
1.1 Introduction .............................................................................................................2
1.2 Safety Notice ...........................................................................................................2

Chapter 2 Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3
2.1 Introduction .............................................................................................................4
2.2 How to Use this Guide ............................................................................................4
2.3 Instrument Overview ..............................................................................................5
2.4 Features and Options ..............................................................................................6

2.4.1 Hardware Features ..........................................................................................6
2.4.2 Software Features and Options .......................................................................7

Chapter 3 Setting Up the System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
3.1 Location Considerations .......................................................................................10

3.1.1 Facility Specifications ...................................................................................10
3.1.2 Vibration and Noise ......................................................................................11
3.1.3 Air Currents and Temperature Fluctuation ...................................................11
3.1.4 AV Table Option ...........................................................................................11

3.2 Unpacking .............................................................................................................12
3.2.1 Shipping Contents .........................................................................................12

3.3 Pre-power Preparations .........................................................................................13
3.4 Cable Connections ................................................................................................15
3.5 Cable Hook-up Instructions ..................................................................................16
3.6 Final Inspection .....................................................................................................18
3.7 Powering up the System .......................................................................................19
3.8 Shipping ................................................................................................................20

Chapter 4 Description of Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23
4.1 Introduction ...........................................................................................................24
4.2 Screen Layout .......................................................................................................24

4.2.1 General Description ......................................................................................25
# 9019320-000 Rev. AC KLA-TENCOR CONFIDENTIAL – RESTRICTED DISTRIBUTION P-170 User Guide iii 



Table of Contents
4.2.2 Alpha-Step Development Series Application Drop-Down Lists .................. 27
4.3 Windows and Tab Features .................................................................................. 35

4.3.1 General Description ...................................................................................... 35
4.4 Measurement Head Hardware Description ........................................................... 36

4.4.1 Video Camera Assembly .............................................................................. 36
4.4.1.1 Pivot Block Assembly........................................................................... 37

4.5 Protecting the Stylus Arm ..................................................................................... 38
4.6 Measurement Capabilities .................................................................................... 40

4.6.1 Scan Stage ..................................................................................................... 41
4.7 Scan Parameter Tab .............................................................................................. 42

4.7.1 Setting Scan Parameters ................................................................................ 42
4.7.2 Definition of Scan Parameters ...................................................................... 43

4.7.2.1 Parameters ............................................................................................. 43
4.7.2.2 Calculation Settings .............................................................................. 45

4.7.3 Auto Functions .............................................................................................. 49
4.7.3.1 Auto Functions Parameter Definitions.................................................. 50

4.8 Using Scan Recipes .............................................................................................. 52
4.8.1 Saving a Scan Recipe .................................................................................... 53
4.8.2 Loading a Scan Recipe ................................................................................. 53
4.8.3 Changing a Scan Recipe ............................................................................... 53

Chapter 5 Basic Operation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
5.1 Introduction ........................................................................................................... 56
5.2 Powering up the Instrument .................................................................................. 56
5.3 Loading the Sample .............................................................................................. 57
5.4 Control Panel Tab ................................................................................................. 62

5.4.1 Video Controls and Zoom ............................................................................. 62
5.4.1.1 Viewing the Stylus in the Video Window ............................................ 63
5.4.1.2 Stage Positioning................................................................................... 64
5.4.1.3 Using the Stage Controls....................................................................... 65

5.4.2 Automatic Saving ......................................................................................... 66
5.5 Engaging the Stylus .............................................................................................. 67

5.5.1 Using the Engage Button .............................................................................. 67
5.5.2 Using the Scan Button .................................................................................. 68

5.6 Magnifying the Sample Image .............................................................................. 68
5.7 Profiling a Sample ................................................................................................ 69

5.7.1 Loading a Sample ......................................................................................... 69
5.7.2 Position the Sample ...................................................................................... 69
5.7.3 Set Scan Parameters ...................................................................................... 70

5.8 Profiling from a Scan Recipe ................................................................................ 72
iv P-170 User Guide # 9019320-000 Rev. AC
KLA-TENCOR CONFIDENTIAL – RESTRICTED DISTRIBUTION



Table of Contents
5.8.1 Loading a Scan Script ...................................................................................72
5.9 Reading the Cursors, Saving and Printing Data ...................................................74

5.9.1 Reading the Cursors ......................................................................................75
5.10 Manual Stage Leveling .......................................................................................77
5.11 Camera Settings ..................................................................................................78

5.11.1 Camera Parameters Dialog Box ..................................................................78
5.11.2 Save Camera Parameters .............................................................................79
5.11.3 Measure Illumination Uniformity ...............................................................79
5.11.4 Keystone Correction ...................................................................................80
5.11.5 Set Keystone Correction Factor ..................................................................81
5.11.6 Select Scale Type ........................................................................................81
5.11.7 Set Camera View Width/Height .................................................................81

Chapter 6 Working with 2D Profiles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  83
6.1 Introduction ...........................................................................................................84
6.2 Data Analysis ........................................................................................................84

6.2.0.1 Data Windows ....................................................................................... 85
6.2.1 Data Control Tab ...........................................................................................94

6.3 Leveling the Profile ..............................................................................................97
6.4 Measuring Profile Features .................................................................................102

6.4.1 Reading the Cursor Data .............................................................................103
6.4.2 Calculation Setup ........................................................................................108

6.5 Scaling Data ........................................................................................................109
6.6 Data Analysis Tab ...............................................................................................110

6.6.1 Data Analysis Tab Features ........................................................................111
6.6.2 Using the Data Analysis Tab ......................................................................111

6.7 Saving and Exporting Calculation Results .........................................................113
6.7.1 Printing Calculation Results ........................................................................113
6.7.2 Printing the Profile ......................................................................................113
6.7.3 Printing using the Screen Capture Function ...............................................113

6.7.3.1 Full Screen Capture............................................................................. 114
6.7.3.2 Active Window Screen Capture.......................................................... 114

6.7.4 Saving Data .................................................................................................114
6.8 Software Filter Settings ......................................................................................115

6.8.1 Using Cutoff Filters ....................................................................................115
6.8.2 Using Polynomial Filters ............................................................................116
6.8.3 Using Step Fit ..............................................................................................116
# 9019320-000 Rev. AC P-170 User Guide v 
KLA-TENCOR CONFIDENTIAL – RESTRICTED DISTRIBUTION



Table of Contents
Chapter 7 Advanced Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
7.1 Introduction ......................................................................................................... 118
7.2 3D Scanning ........................................................................................................ 118

7.2.1 Setting up and Running a 3D Scanning ...................................................... 118
7.2.2 Viewing a 3D Data File .............................................................................. 119

7.3 Sequence Scans ................................................................................................... 120
7.3.1 Sequence Control Panel .............................................................................. 120

7.4 Stitch Pre-Saved Data ......................................................................................... 124
7.4.1 Opening the Stitch feature .......................................................................... 124
7.4.2 Stitch Control Panel Description ................................................................ 125

7.4.2.1 Stitching .............................................................................................. 126
7.4.2.2 Displaying the Stitched Profile ........................................................... 127

7.4.3 Multiple Scans ............................................................................................ 127
7.4.3.1 Using the Multiple Scan Feature......................................................... 127
7.4.3.2 Using the Calculations for Multiple Profiles ...................................... 130

7.5 Height Histogram ................................................................................................ 131
7.5.1 How to Use the Height Histogram .............................................................. 131

Chapter 8 Apex 2D/3D - Getting Started  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133
8.1 Introduction ......................................................................................................... 134

8.1.1 License Agreement ..................................................................................... 134
8.2 Overview of Apex 2D/3D ................................................................................... 135

8.2.1 Starting the Software .................................................................................. 135
8.2.2 Loading a Studiable .................................................................................... 135
8.2.3 Applying an Operator or Carrying out a Study ........................................... 138

Chapter 9 Thin Film Stress Module  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143
9.1 Introduction ......................................................................................................... 144

9.1.1 Overview ..................................................................................................... 144
9.2 Thin Film Stress Window ................................................................................... 145
9.3 Using the Thin Film Stress Option ..................................................................... 147

9.3.1 Saving Data ................................................................................................. 147
9.3.2 Taking a Pre-stress Scan ............................................................................. 147
9.3.3 Saving and Loading a Scan Recipe/Sequence Recipe ................................ 148
9.3.4 Loading and Positioning the Sample .......................................................... 149

9.4 Taking a Difference Measurement ..................................................................... 154
9.4.1 Selecting a Sequence Recipe ...................................................................... 154
9.4.2 Loading and Positioning the Sample .......................................................... 154

9.5 Taking a Single Post Stress Management ........................................................... 156
vi P-170 User Guide # 9019320-000 Rev. AC
KLA-TENCOR CONFIDENTIAL – RESTRICTED DISTRIBUTION



Table of Contents
9.6 Recalculating Stress Measurements ....................................................................157
9.7 Use a Difference Measurement to Subtract from a Scan Profile ........................158

9.7.1 Taking a Background Scan .........................................................................158

Chapter 10 System Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  161
10.1 Introduction .......................................................................................................162
10.2 Linear Calibration Procedure ............................................................................163

10.2.1 Long Range Calibration ............................................................................163
10.2.2 Short Range Calibration ............................................................................167
10.2.3 Linear Calibration Details .........................................................................171

10.2.3.1 Linear Calibration Frequency............................................................ 171
10.2.3.2 Long Ranges...................................................................................... 171
10.2.3.3 Short Ranges ..................................................................................... 172
10.2.3.4 Linear Calibration Reminders ........................................................... 172

10.2.4 Troubleshooting Linear Calibration ..........................................................174
10.2.4.1 Alignment Voltage is too Low.......................................................... 174
10.2.4.2 Calibration Failure............................................................................. 175

10.3 Calibrating the Measurement Head ..................................................................176
10.3.1 Calculating the Calibration Factor ............................................................176

10.4 Changing the Stylus ..........................................................................................178
10.5 Stylus Tip Centering .........................................................................................179
10.6 Software Maintenance ......................................................................................181

10.6.1 Backing Up Files .......................................................................................181
10.6.2 Restoring Data and Scan Recipes .............................................................181

10.7 Help Files ..........................................................................................................182

Appendix A Profiler Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 183
A.1 Alpha-Step Development Series Profiler Specifications ...................................184
# 9019320-000 Rev. AC P-170 User Guide vii 
KLA-TENCOR CONFIDENTIAL – RESTRICTED DISTRIBUTION



Table of Contents
viii P-170 User Guide # 9019320-000 Rev. AC
KLA-TENCOR CONFIDENTIAL – RESTRICTED DISTRIBUTION



List  of  Tables
Table 10-1 Typical Cases Requiring Calibration ...................................... 172
Table A-2 Alpha-Step Development Series Profiler Specifications ........ 184
Table A-3 System Configuration ............................................................. 185
# 9019320-000 Rev. AC KLA-TENCOR CONFIDENTIAL -- RESTRICTED DISTRIBUTION D-500 & D-600 User Manual ix 



List of Tables
x D-500 & D-600 User Manual KLA-TENCOR CONFIDENTIAL -- RESTRICTED DISTRIBUTION # 9019320-000 Rev. AC



List  of  Figures
Figure 3-1 Cable Hook Up Instructions...................................................... 16
Figure 3-2 Computer Back Panel with Cable Connections ........................ 17
Figure 3-3 Stage Block Protects the Scan................................................... 20
Figure 3-4 Stage Restraints......................................................................... 21
Figure 3-5 Fiberglass Threaded Tape Holding ........................................... 22
Figure 4-1 Alpha Development Series Screen Layout ............................... 24
Figure 4-2 Data Window ............................................................................ 27
Figure 4-3 File Drop-Down List ................................................................. 28
Figure 4-4 Settings Drop-Down List .......................................................... 29
Figure 4-5 Graph Setup window................................................................. 29
Figure 4-6 Repeat Scan Window Control................................................... 30
Figure 4-7 Tools Drop-Down List .............................................................. 31
Figure 4-8 Load Position Control Panel ..................................................... 32
Figure 4-9 Windows Drop-Down Lists ...................................................... 33
Figure 4-10 Help Drop-Down List ............................................................... 34
Figure 4-11 Applications Tool Bar............................................................... 34
Figure 4-12 Measurement Head Assembly .................................................. 36
Figure 4-13 Scan Parameters Tab................................................................. 42
Figure 4-14 Setup Window Calculations Tab............................................... 46
Figure 4-15 Auto Functions Settings Window ............................................. 49
Figure 4-16 Accessing Auto Functions from Settings Menu ....................... 50
Figure 4-17 Accessing Auto Functions from Setup...................................... 50
Figure 5-1 D-500 Stage Table .................................................................... 57
Figure 5-2 D-600 Stage Table .................................................................... 59
Figure 5-3 D-600 Precision Locator (Universal Chuck) ............................ 60
Figure 5-4 Load Positions Video Capture .................................................. 61
Figure 5-5 Control Panel Tab ..................................................................... 63
Figure 5-6 Stylus Near Sample Surface...................................................... 67
Figure 5-7 Lens Magnification Control ...................................................... 68
Figure 5-8 Abort Scan Message Box.......................................................... 73
Figure 5-9 Sample Data Window ............................................................... 74
Figure 5-10 Data Control Tab with Cursor Information............................... 75
Figure 5-11 Front View of Stage with Tilt Control Knob ............................ 77
Figure 5-12 Camera Utilities ........................................................................ 78
Figure 5-13 Video Before and After Keystone Correction........................... 80
Figure 6-1 Data Window Example ............................................................. 84
Figure 6-2 Data Window Tool Bar Drop-Down Lists ................................ 86
# 9019320-000 Rev. AC KLA-TENCOR CONFIDENTIAL -- RESTRICTED DISTRIBUTION D-500 & D-600 User Manual xi 



List of Figures
Figure 6-3 File Drop-Down List.................................................................  86
Figure 6-4 Edit Drop-Down List ................................................................  87
Figure 6-5 Tools Drop-Down List..............................................................  87
Figure 6-6 Merge Data Control Window ...................................................  88
Figure 6-7 Help Drop-Down List ...............................................................  89
Figure 6-8 Files Displayed in Drop-Down List..........................................  90
Figure 6-9 Data Window Alternative Drop-Down List..............................  90
Figure 6-10 Data Window Alternative Drop-Down.....................................  92
Figure 6-11 Data control Tab .......................................................................  94
Figure 6-12 Cursor Control Tab ...................................................................  95
Figure 6-13 Data Display Window with Unleveled Profile .........................  97
Figure 6-14 Profile After Leveling...............................................................  98
Figure 6-15 Average Mode for Leveling Profile (Demo) ............................  99
Figure 6-16 Control Panel Tab Showing Cursor Data ...............................  103
Figure 6-17 Data Display Window with Multiple Cursor Pairs .................  105
Figure 6-18 Data Display with Zoom Box for Data Zoom ........................  106
Figure 6-19 Data Zoom in the Data Display window ................................  106
Figure 6-20 Graph Setup Window..............................................................  109
Figure 6-21 3 Profiles loaded in Data Display Window ............................  110
Figure 6-22 Tool Bar Description ..............................................................  111
Figure 6-23 High Pass and Low Pass Filters ..............................................  115
Figure 7-1 Scan Parameters Tab...............................................................  118
Figure 7-2 Sequence Control Pane ...........................................................  120
Figure 7-3 Deskew Confirmation Function in Control Pane....................  121
Figure 7-4 Active Stitching windows.......................................................  125
Figure 7-5 Data window with Stitched Composite Profile.......................  126
Figure 7-6 List of Data Files loaded into Data Display Window.............  130
Figure 7-7 Height Histogram in Data Display Active window ................  131
Figure 8-1 Empty Apex Document ..........................................................  135
Figure 8-2 General Toolbar ......................................................................  136
Figure 8-3 Example Data Directory .........................................................  137
Figure 8-4 Applying an Operator .............................................................  138
Figure 8-5 Carrying out a Study ...............................................................  138
Figure 8-6 3D Representation of the Measured Motor Cylinder..............  139
Figure 8-7 Measurement of the Angle and the Distance between Grooves 140
Figure 8-8 Extraction of an Oblique Profile .............................................  140
Figure 8-9 Removing the Circular Form ..................................................  141
Figure 8-10 Separating Roughness and Waviness .....................................  141
Figure 8-11 Calculating Roughness Parameters.........................................  142
Figure 9-1 Thin Film Stress Control Window..........................................  145
Figure 9-2 Alpha-Step D-600 Wafer Stress Chuck ..................................  149
Figure 9-3 Universal Chuck (for D-600) ..................................................  150
Figure 9-4 Alpha-Step D-500 Wafer Stress Chuck ..................................  151
Figure 10-1 50 µm Step Measurement Feature ..........................................  163
Figure 10-2 Measurement Feature (Precise Stage Leveling) .....................  164
Figure 10-3 Measurement Feature Centered in Middle of Scan Length ....  165
xii D-500 & D-600 User Manual KLA-TENCOR CONFIDENTIAL -- RESTRICTED DISTRIBUTION # 9019320-000 Rev. AC



List of Figures
Figure 10-4 Linear Calibration Panel ......................................................... 166
Figure 10-5 Leveling Scan Stage................................................................ 166
Figure 10-6 Scan Over 50 µm Step Height ................................................ 167
Figure 10-7 1 µm Step Measurement Feature ............................................ 168
Figure 10-8 1 µm Step Measurement Feature after Precise Stage Leveling 169
Figure 10-9 1 µm Step Height Measurement Feature ................................ 170
Figure 10-10 Linear Calibration Panel ......................................................... 170
Figure 10-11 Linear Calibration Panel - Software Reminders ..................... 173
Figure 10-12 Linear Calibration Reminder Panel......................................... 173
Figure 10-13 Warning for Error in Electro-Optical Alignment Voltage ...... 174
Figure 10-14 Error Message - Unable to Engage for Scan........................... 175
Figure 10-15 Error Message - Scans are Corrupted ..................................... 175
Figure 10-16 Calibration Data Dialog Box................................................... 177
Figure 10-17 Stylus Inserted into Stylus Clamp........................................... 178
Figure 10-18 Camera Parameters Dialog Box.............................................. 179
# 9019320-000 Rev. AC KLA-TENCOR CONFIDENTIAL -- RESTRICTED DISTRIBUTION D-500 & D-600 User Manual xiii 



List of Figures
xiv D-500 & D-600 User Manual KLA-TENCOR CONFIDENTIAL -- RESTRICTED DISTRIBUTION # 9019320-000 Rev. AC



1

Safety
Contents

1.1 Introduction .........................................................................................2

1.2 Safety Notice .......................................................................................2
# 9019320-000 Rev. AC KLA-TENCOR CONFIDENTIAL -- RESTRICTED DISTRIBUTION D-500 & D-600 User Manual 1 



Chapter –Safety
1.1 Introduction

This section contains the safety information related to using software.

1.2 Safety Notice

WARNING

The exclamation point with an equilateral triangle is intended to alert the user to the 
presence of important operation and servicing instructions in the literature 
accompanying the product.

Laser Safety

This unit employs an embedded Class IIIa diode laser. Only qualified persons 
should remove the cover or attempt to service this unit due to the risk of eye injury. 
If the unit is opened and the laser beam is directly accessed do not stare into the beam 
or view directly with optical instruments.

Laser Properties

Type: Diode Laser

Wavelength: 635 nm

Laser Output: Constant Wave 5 mW max.
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Chapter 2–Introduction
2.1 Introduction

This manual describes in detail the operation of the Alpha-Step Development Series 
Stylus Profiler. This manual is intended as a tutorial and reference for individuals 
who use the Alpha-Step D-500 or Alpha-Step D-600 profiler systems to inspect and 
analyze sample surfaces, and as a general guide to configuration and maintenance of 
the instrument.

• “How to Use this Guide” on page 4

• “Instrument Overview” on page 5

• “Features and Options” on page 6

2.2 How to Use this Guide

It is assumed throughout this manual that the user has a general understanding of 
using personal computers, operating in a Windows environment, using a standard 
mouse and keyboard, and understands basic Windows Operating system 
conventions.

To get the most out of this manual, first-time users should proceed sequentially 
through the following chapters to get an overview of the instrument and its 
operation:

Chapter 2, Introduction discusses how to use the manual, terminology used, and 
an overview of the instrument and its features.

Chapter 3, Setting up the Instrument details the procedures necessary for 
installation of the instrument and the proper procedure for packing the instrument 
for moving or shipping.

Chapter 4, Description of Features provides information on starting the 
instrument and a description and overview of the controls and features.

Chapter 5, Basic Operation describes how to use the instrument and walks the user 
through making a measurement.

Chapter 6, Working with 2D Profiles provides a description of the analysis 
features and how to use them on profile data.

Chapter 7, Advanced Features provides a description of the advanced software 
features available to the user such as, 3D scanning, Stitching, Sequence Scanning, 
Histogram, and multiple profiles.
4 D-500 & D-600 User Manual KLA-TENCOR CONFIDENTIAL -- RESTRICTED DISTRIBUTION # 9019320-000 Rev. AC 



Chapter 2–Introduction 
Chapter 8, Apex2D/3D - Getting Started provides information about configuring 
Apex 2D/3D to work with the Alpha-Step system.

Chapter 9, Thin Film Stress Module provides information about the use of the 
Wafer Stress software option for analysis of thin film stress.

Chapter 10, System Maintenance discusses the Alpha-Step Development Series 
service policy, troubleshooting, and changing the stylus.

Appendixes listing the Alpha-Step Development Series of instruments 
Specifications and Options and Accessories are also provided at the end of this 
manual.

2.3 Instrument Overview

The KLA-Tencor Alpha-Step Development Series Stylus Profiler is a 
computerized, high-sensitivity surface profiler that measures step height, roughness 
and waviness in a variety of applications. It features the ability to measure precision 
step heights from under 10 angstroms to as large as 1.2 mm. The profiler 
incorporates a new optical deflection height measurement mechanism and magneto 
static force control system that results in a low force (loads as small as 0.03 mg) and 
low inertia stylus assembly, making it the most innovative bench top profiler on the 
market today.

These innovations combine to produce a surface profiler capable of measuring soft 
films and substrates without surface damage. The Alpha-Step Development Series 
profiler provides an affordable, high-resolution surface measurement capability that 
nicely complements other analytical instruments. A complete listing of 
specifications and features can be found in Appendix A, “Profiler Specifications”.

The instrument is available in two hardware configurations: Alpha-Step D-500 
manual stage and the Alpha-Step D-600 with motorized stage controls up to 
150 mm travel.

The Alpha-Step Development Series profiler provides the following features:

• Measurement of vertical features ranges from under 10Å to over 1 mm with a 
vertical resolution better than 1Å for the 2.5 µm range setting and 100nm 
resolution for the 1.2 mm range setting. Measurements can be taken in metric or 
English units, which are selectable independently for horizontal and vertical 
parameters.

• Up to 400,000 data points per profile guarantees that the horizontal resolution is 
generally limited by the stylus radius and not the number of data points.
# 9019320-000 Rev. AC KLA-TENCOR CONFIDENTIAL -- RESTRICTED DISTRIBUTION D-500 & D-600 User Manual 5 



Chapter 2–Introduction
• Measurement of many roughness and waviness parameters with the roughness 
and waviness separated by user-selectable cutoff filters.

• Motorized positioning of the sample surface to within 0.5 microns in X-Y using 
the Alpha-Step D-600 configuration.

• Many easy to use features, including software adjustable force control, intuitive 
user interface, easy mouse control of measurement cursors and stage position.

• Accommodates samples over 200 mm in diameter and heights up to 30 mm.

• 3D Rendering advanced analysis package extends the measurement capabilities 
of the Alpha-Step D-600 platform without optional hardware requirements.

2.4 Features and Options

2.4.1 Hardware Features

Computer - An Intel processor running Windows 7 available to KLA-Tencor at the 
time of manufacturing. KLA-Tencor uses only vendors with worldwide service and 
technical support.

Monitor - 19 in. Flat Panel or equivalent display monitor accompanies the 
Alpha-Step Development Series systems.

Motor Controls - All system controls are accomplished with the computer 
keyboard and mouse. No special control hardware is necessary.

KLA-Tencor Measurement Head - All Alpha-Step Development Series systems 
come standard with the low force frictionless pivot stylus head and a force control 
feedback system. The force control and frictionless pivot permit accurate profiling 
of the surface topography with minimal stylus contact force. The stylus arm has a 
minimal moment of inertia, so it is much less susceptible to environmental noise.

The measurement head incorporates a video camera imaging system that allows the 
user to accurately position the sample under the stylus. The Alpha-Step 
Development Series systems includes a 1x -4x digital zoom.

Vacuum Sample Hold-Down - The vacuum hold-down enables a sample to be held 
securely in the center of the stage and is available with the Alpha-Step D-500 and 
D-600 systems.
6 D-500 & D-600 User Manual KLA-TENCOR CONFIDENTIAL -- RESTRICTED DISTRIBUTION # 9019320-000 Rev. AC 



Chapter 2–Introduction 
2.4.2 Software Features and Options

Operating System - The Alpha-Step Development Series Systems use the 
Windows 7 operating system.

Alpha-Step Development Series Software Interface – KLA-Tencor uses standard 
Windows graphical user interface conventions and drop-down lists to navigate and 
control the software functions. All system functions can be accessed by using the 
mouse or keyboard controls to navigate the drop-down lists.

Data Analysis Features - The Alpha-Step Development Series software comes 
standard with calculations for many popular parameters, refer to Chapter 4, 
“Description of Features,” on page 23 for specific definitions of the parameters 
calculated.

Thin Film Stress Option - The Thin Film Stress Option calculates the stress levels 
in a deposited film by measuring the deflection or curvature that the stress induces 
in the substrate, (refer to Chapter 9, “Thin Film Stress Module,” on page 143).

Precision Locator for Thin Film Stress Option - A universal stress chuck is 
available to enable exact positioning of a sample relative to a fixed reference, flat or 
notch. The chuck allows various positions for the locating pins and standoffs to 
accommodate wafers from 50 mm to 200 mm. Call KLA-Tencor Customer Support 
for more information.

Sequence Feature - Sequence software allows the user to program the stage for 
multiple measurements, test patterns, or set a routine to collect multiple profiles for 
2-D rendering. The user can save Sequence Files and correlate them with Scan 
Recipes to enhance the instruments repeatability and ease of use (refer to Chapter 7, 
“Advanced Features,” on page 117) for a detailed description of the features.

3D and Advanced Analysis Software - The 3D and advanced analysis option 
expands the capabilities of the Alpha-Step Development Series instrument. The 
software allows the user to render 3D images of the sample surfaces. It provides a 
suite of leveling and form removal utilities, profile extraction from any angle in a 
2-D or 3-D image, particle and grain analysis, FFT and advanced filtering, batch 
processing of data, and report writing capabilities. This option is available only on 
the Alpha-Step D-600 system.

Stitch Feature - The Stitch feature allows the user to extend the usable profile scan 
length. The stitching function in the sequence recipe enables the user to combine up 
to 10 profiles with user defined overlap to make a long profile. The stitched profile 
is available right after the sequence scan finishes. Another independent stitching 
feature can combine up to 5 profiles end to end to make a long profile. The 
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independent stitching function needs the user to manually combine the pre-saved 
profiles.
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Chapter 3–Setting Up the System
3.1 Location Considerations

The stylus profiler is a delicate instrument. It is sensitive to vibrations, acoustical 
noise, air currents and temperature changes. Successful results with your instrument 
depends on the extent to which it is isolated from these environmental effects.

3.1.1 Facility Specifications

Power

Four standard AC outlets (110 V, 5A, 60Hz in the USA STANDARD and 220 V, 5A, 
50Hz in other parts of the world option). Even if the power source is known to be 
clean and reliable, a surge protector is recommended. If power failure is a common 
occurrence, use an Uninterruptible Power Supply (UPS) device. A UPS device 
supplies power for 30 minutes so that an orderly shutdown can be performed.

Vacuum

Software on/off control:0.125 in. nominal line providing a minimum of –250 mm 
Hg at a flow rate of 0.236 l/s. A vacuum pump can be ordered as an option with the 
instrument if sufficient house vacuum is not available.

Dimensions

Alpha-Step D-500: 10 in. Wide x 16 in. Deep x 10 in. High

Alpha-Step D-600: 15 in. Wide x 24 in. Deep x 13 in. High

Ambient Temperature

Specified operating range: 70° ± 9°F (21° ± 5°C); Max. operating range: 70° ± 20°F 
(21° ± 11°C). For best accuracy: 2° F maximum change/hour Storage: 0° to 115°F 
(-18° to 45°C).

Environment

Floor vibration (from 2-40 Hz) should be less than 0.2 mG (G= gravitational force 
of approximately 32 ft/s2 or 9.8 m/s2). Acoustic noise should be less than 80dB.
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3.1.2 Vibration and Noise

If possible, place the profiler on the ground floor or basement level to minimize 
building vibrations. The pivot assembly is the sensitive portion of the instrument. 
The Alpha-Step Development Series profiler comes with internal shock/isolator 
mounts built into the base of the instrument ensuring a basic level of isolation.

For optimum performance, provide a rigid, sturdy table that can support 100 lb or 
more and is large enough to accommodate the size of the Alpha-Step Development 
Series profiler. There should also be sufficient room beneath the table for a 
computer. The monitor, keyboard and mouse should be placed near the instrument 
on a separate surface.

It is always recommended that the instrument be mounted on an isolation table or 
heavy granite slab that is isolated from floor vibration for highly sensitive 
measurements (that is, artifacts less than 500 to 1000 angstroms or in noisy areas).

3.1.3 Air Currents and Temperature Fluctuation

All the Alpha-Step Development Series profiler instruments have covers to reduce 
the effects of air currents during a measurement. It is suggested to locate the 
instruments away from any type of air flow to get best performance. It is best to 
place the instrument in a room where a relatively constant temperature is maintained 
to minimize long-term temperature-dependent effects on the measurement.

3.1.4 AV Table Option

KLA-Tencor supplies, as an option, a simple and inexpensive means of isolating 
your Alpha-Step Development Series profiler from mechanical vibrations— the 
AV table is a stand alone closed air system that reduces vibration affecting the 
instrument. The AV is a desktop floating air table that is slightly larger than the 
instrument footprint.
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3.2 Unpacking

Retain all packing material and report any obvious damage caused by improper 
handling to the shipping company. Contact KLA-Tencor for assistance in filing a 
claim against the shipping company if any components of the Alpha-Step 
Development Series profiler have been damaged in transit.

The Alpha-Step Development Series profiler is shipped assembled in a crate. The 
number of boxes varies depending on the exact equipment (options) ordered.

Computers are shipped in the computer manufacturer shipping containers. Unless 
special requests have been made, all software to be supplied by the computer 
manufacturer, with the addition of the Alpha-Step Development Series profiler 
software to control the instrument.

The Alpha-Step D-500 weighs about 30 lb; the Alpha-Step D-600 profiler weighs 
about 90 lb. It is suggested that two people remove the instrument.

3.2.1 Shipping Contents

Check that all components listed in the enclosed System Components List are 
included in the shipped containers and match the Packing List. Remove all the 
components from their shipping containers and save all packing materials and 
documentation in the event the instrument needs to be moved or shipped back to the 
KLA-Tencor factory. The following items are shipped with the basic system:

One Alpha-Step Development Series profiler Backup Software CD-ROM

One Stylus 2.0 µm (installed), unless otherwise specified in the order

Three AC power cords

Vacuum Adapter (Alpha-Step D-600 profiler systems only)

One USB cable

Computer with keyboard, mouse, and Software disks

Flat Panel Display monitor or equivalent
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3.3 Pre-power Preparations

The Alpha-Step Development Series profiler system is wrapped in plastic and then 
placed inside the shipping crate. This plastic wrapping is intended to keep the 
shipped instrument clean from exposure to the packing material prior to installation. 
If the instrument is being installed in a clean room environment do not remove the 
plastic wrap before entering the gowning area of the clean room where the 
installation occurs.

The following unpacking instructions assume the Alpha-Step Development Series 
profiler system to be installed in a clean room environment:

1. Inspect the boxes and crate for any signs of damage or mishandling.

2. Inspect the Tiltwatch™ and Shockwatch™ stickers on the outside of the 
crate. If the sensor indicates mishandling, contact KLA-Tencor immediately 
and do not unpack the system further until confirming with KLA-Tencor 
service department.

3. Use a wrench or socket ratchet to remove the bolts from the four sides of the 
crate.

4. Lift the crate top from the base by lifting straight up (for Alpha-Step D-600 
use two people to ensure that the instrument is not hit while removing the 
lid) and place aside.

5. Carefully lift the instrument off the foam base of the crate and place on a cart 
appropriate for the weight of the instrument (specified for more than 150 lb 
and clean room compatible).

6. Unpack the computer and monitor from their boxes and leave them in their 
respective plastic bag covers in preparation for placement into the clean 
room.

7. Move the system into the gowning area of the clean room.

8. Remove the plastic bag covers from the computer, monitor and Alpha-Step 
Development Series profiler system.

9. Carefully place the Alpha-Step Development Series profiler system on a 
sturdy floor mounted bench, or for better results, a vibration isolation table. 
(For more information regarding recommended vibration isolation tables 
contact KLA-Tencor Customer Service.)

10. Gently peel back the tape from the windscreen of the Alpha-Step 
Development Series profiler cover, and gently remove the restraining tape 
from the stage. The stage is held in position with a block at the front of the 
stage, ensure to remove the packing block and save this with the original 
packing material.
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NOTE

Apply light pressure to the stage when removing the tape to prevent the 
stage from lifting from the optical flat.

11. Locate the computer on the floor or near the Alpha-Step Development 
Series profiler instrument ensuring that the cables are not stretched taught, 
but hang loosely from the back of the instrument to the computer and 
monitor.

12. Locate the monitor, keyboard, and mouse on the bench top above or next to 
the computer and profiler.

13. Store the shipping crate and boxes in a dry accessible place. In the unlikely 
event that the instrument needs to be returned to the factory, it must be 
shipped in its original container.
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3.4 Cable Connections

The back panel of the Alpha-Step D-600 profiler has three connections. The 
Alpha-Step D-500 only has two connections, it does not have a vacuum connection.

Power - Standard IEC-320 terminated UL-Listed computer. The voltage is set at the 
KLA-Tencor factory.

USB - The Alpha-Step Development Series instrument uses a Standard A to B 
USB cable to connect the instrument to the PC controller and Alpha-Step 
Development Series profiler software. All Alpha-Step Development Series profiler 
instruments use USB connection for the video. One connection plugs into a 
computer USB port and the other connects into the Alpha-Step Development 
Series profiler back panel USB port as shown in Figure 3-1 and Figure 3-2.

Vacuum -The connection to the back of the instrument is a 1/4” OD flexible tubing 
(included). The vacuum pump needs to be supplied by the customer. The vacuum 
pump input port connection depends on the pump provided.
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3.5 Cable Hook-up Instructions

Figure 3-1 Cable Hook Up Instructions

Follow the Computer manufacturer's setup procedures to properly hookup the 
monitor, keyboard, mouse and other hardware such as printer, Ethernet, and many 
more.

Connect the cables for the Alpha-Step Development Series profiler instrument to 
the computer (see Figure 3-2 for back panel connector layout). The USB port for the 
profiler is labeled with Tool in the cak panel of the computer.

NOTE

If the USB cable is plugged into the wrong USB port, the computer asks the user 
to install the proper driver. Do not continue the stop, reconnect the USB cables to 
their proper port.
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Figure 3-2 Computer Back Panel with Cable Connections
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3.6 Final Inspection

1. Check that all the shipping restraints and stage block have been removed 
(see Figure 3-4 and Figure 3-5 for details).

2. Check that the power, USB, and vacuum (if needed) are connected properly 
and securely.

NOTE

Inspect that the cables are not stretched taut between the computer and 
Alpha-Step Development Series profiler instrument as this affects the 
proper functioning of the instrument and cause noise which can affect 
your measurements. If you are using a vibration isolation table, stretched 
cables limit the effectiveness of the isolation table to operate as specified.

If a vibration isolation table is being used:

1. Check to ensure the tabletop is free to move in all directions.

2. Check to ensure the cables in the back of the instrument have a sufficiently 
large service loop to ensure minimal vibration is transmitted through the 
cables to the isolation table.

NOTE

KLA-Tencor Warranty Policy does not cover damage to the stylus, the stylus arm 
assembly, or the pivot caused by operator error or carelessness.
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3.7 Powering up the System

The following procedure applies to new instruments:

1. Turn on the AC power to the computer (located on the front panel of the 
computer) and monitor.

NOTE

Allow the computer to startup completely before proceeding with the next step.

2. Turn on the AC power to the Alpha-Step Development Series profiler 
instrument (located on the back panel of the instrument).

NOTE

Wait 10 seconds before proceeding to the next step in order to allow the USB 
communications to establish a connection.

To start the Alpha-Step Development Series profiler software, double-click the 
Alpha-Step Development Series software icon located on the computer desktop. 
Then, Home All Stages is displayed automatically and the system is ready to use.
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3.8 Shipping

If the instrument needs to be returned to the factory or moved to another location, 
follow the shipping preparation instructions as follows:

Before powering down the system:

1. Disconnect the vacuum line from the back panel of the instrument.

2. Raise the measurement head to its upper limit.

3. Move the stage to its Home stage position (Applies to the Alpha-Step D-600 
system only).

4. Quit the Alpha-Step Development Series profiler software.

5. Shut down the computer using proper Microsoft Windows procedure.

6. Install the stage block as shown in Figure 3-3. Slide the block between the 
stage and front panel until it is snug (the stage block for the Alpha-Step 
D-500 model is smaller than shown in Figure 3-3).

Figure 3-3 Stage Block Protects the Scan
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NOTE

The protective block should be removed before starting up the instrument. Do not 
tap down on the block.

7. Restrain the stage and block using threaded fiberglass tape along the Y 
direction of the stage as shown in Figure 3-4.

8. Restrain the stage using two strips of threaded fiberglass tape along the X 
direction as shown in Figure 3-4 (For the Alpha-Step D-500 stage it might be 
necessary to use one tape strip across the stage to secure it).

9. Close the stage door cover, making sure that the cover clears the block 
between the stage and front cover.

10. Restrain the door cover using two strips of threaded fiberglass tape as shown 
in Figure 3-5.

11. Cover the instrument in a plastic bag to keep it clean from the packing 
material.

Figure 3-4 Stage Restraints
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Chapter 3–Setting Up the System
Figure 3-4 shows one vertical strap holding the stage and block, and two straps 
along the horizontal direction each approximately 3/4 in. from the center of the 
stage.

12. Place the Alpha-Step Development Series instrument on the bottom foam 
pad of the shipping crate. Center the instrument on the foam.

13. Slide the Crate cover over the base of the crate.

Figure 3-5 Fiberglass Threaded Tape Holding

Figure 3-5 shows the stage cover door closed over the block restraint coming out 
from under the stage cover door.

LIFT WITH TWO PERSONS

Use two people to hold the crate cover and slide it straight down over the 
instrument to refrain from hitting or damaging the system.

14. Tighten the eight bolts on all four sides using a ratchet or wrench.

15. Package the computer and monitor in their original boxes.

16. The system is ready to move to a new location or ship back to KLA-Tencor.
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Chapter 4–Description of Features
4.1 Introduction

This chapter gives a description of the instrument, software features and screen 
layout. Each of the features is defined, and where appropriate, reference to more 
detailed operation instructions is provided for the reader to learn more about that 
particular feature. Additionally, there is a description of the measurement head and 
pivot assembly.

4.2 Screen Layout

Figure 4-1 Alpha Development Series Screen Layout
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Chapter 4–Description of Features 
4.2.1 General Description

The Alpha-Step Development Series profiler application organizes functions in 
Windows and Tabs. Windows are used for the video camera view and data display. 
Windows can be resized, ordered or stacked, depending on the user preference. Tabs 
are generally used for controls. Tab controls as a default are docked into a set 
position. The Tabs can also be set to float and behave like a Window. If the user 
changes their mind they can return a floating tab to its default docking position. The 
user can have all the major functions of the software available in a single view or 
stacked in open windows or arranged in any order and size convenient to the 
operator. The features of the Alpha-Step Development Series profiler Software 
Application are explained in the following.

NOTE

Some controls might be disabled at times, depending on the mode of operation of 
the instrument.

1. Application Drop-down lists are always shown at the top of the Application 
Window. These menus are accessible any time by using the cursor to choose 
one of the drop-down items. If a selection is disabled it is not available.

2. Application Tool Bar is always displayed in the Main Application Window. 
The user cannot add or remove buttons to this tool bar. A list of the features 
and their description is given in the following.

3. Video Capture window displays the video view from the CCD camera 
located on the measurement head. The default is for the Video Capture 
Window to open when the application is opened.

4. Scan Parameter Control tab by default is docked at the bottom of the 
Alpha-Step Development Series profiler Application Window. This control 
tab displays the scan parameters. A more detailed description is given in 
“Scan Parameter Tab” on page 42.

5. Control Panel tab by default is docked to the right side of the application 
window. This control tab displays all of the stage controls for the video 
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display, video zoom, vacuum, X-Y stage motion and Z stage motion. A more 
detailed description is given in “Control Panel Tab” on page 62.

6. Other Control Tabs:

Sequence tab is available only for the D-600. This tab sets the scan 
recipe of sequence scans.

Cursor Control tab is displayed when the Data Window is opened. This 
tab has controls to adjust the cursor position and width. It also displays 
the High Pass and Low Pass filter settings.

Real Time Display (RTD) tab displays the profile in real-time as the 
stylus is moving across the sample surface. The RTD allows the operator 
to view the profile as it is being taken. It gives the user a rough idea if the 
scan is level and in the range of the measurement or needs to be aborted 
and restarted after making an adjustment.

Data Control tab is displayed when the Data Window is opened. This tab 
displays the cursor location, the leveling features, the Step Detect button, 
and Histogram button.

7. Data window is opened only after a profile scan is completed or the user 
loads a previous scan into the application.

8. Data Analysis tab is available only after the user selects parameters from the 
Calculations Window and then selects to calculate results. The Data 
Analysis can show results from a single Data Window or from all open Data 
Windows.
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Figure 4-2 Data Window

4.2.2 Alpha-Step Development Series Application Drop-Down Lists

The Alpha-Step Development Series profiler Application drop-down lists in 
general are features that apply to all Windows that are open in the case that multiple 
Data Windows are displayed. If a drop-down list lists an item that is disabled this 
means the function is not available at that time and requires either a loaded profile to 
be available or a setting to activated. A description of the drop-down lists is given in 
the followings.
# 9019320-000 Rev. AC KLA-TENCOR CONFIDENTIAL -- RESTRICTED DISTRIBUTION D-500 & D-600 User Manual 27 



Chapter 4–Description of Features
Figure 4-3 File Drop-Down List

File Drop-Down List

• Load Data File - This opens the Data Folder. Saved profiles can be loaded into 
the Alpha-Step Development Series profiler software for further analysis. 
Choose a filename to load the profile data. The profile is then viewed by opening 
the Data Display window.

• Save Data File - This opens the standard Windows save file dialog box. Choose 
a filename to save the current profile data. The profile is then saved in the folder 
selected.

• Load Sequence Recipe - This button opens the standard windows and asks the 
user to open a saved sequence recipe. The Sequence Control Pane uses the 
parameters of the loaded recipe. The user can also load the sequence recipe from 
the Sequence Control Pane as in Chapter 7, “Advanced Features,” on page 117.

• Save Sequence Recipe - This button prompts the user to name and save the 
current sequence recipe. The user can also save the sequence recipe from the 
Sequence Control Pane as described in Chapter 7, “Advanced Features,” on 
page 117.

• Load Scan Recipe - This opens a dialog box and the user can load a pre-saved 
2-D or 3-D scan recipe.

• Save Scan Recipe - This opens a dialog box and asks the user to name and save 
the current scan recipe.

• Print – This opens the standard dialog box prompting the user to choose a 
printer and the printer set up.

• Print Preview – This opens a standard Windows preview window that displays 
the current profile data as it would look for printout.
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• Print Set-up – This opens a standard Windows Printer Set-up Window that 
allows the user to choose the printer settings before printout.

• Exit – This quit the Alpha-Step Development Series profiler software (this 
does not shut down the computer).

Figure 4-4 Settings Drop-Down List

Settings Drop-Down List

• Graph Scales – This opens the control window for the graph parameters for data 
displayed in the Data Display window.

Auto Scale X – This check box displays the full length of the profile X data in the 
Data Display window when the box is checked. If the box is not checked, the X data 
is displayed in the range entered into the X Maximum and X Minimum text boxes.

X Maximum – This value is the upper limit that the X data is displayed in the Data 
Display window.

Figure 4-5 Graph Setup window

X Minimum - This value is the lower limit that the X data is displayed in the Data 
Display window.

Auto Scale Z - This check box displays the full range of the profile Z data in the 
Data Display window when the box is checked. The data is rescaled after leveling or 
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zooming. If the box is not checked the Z data is displayed in the range entered into 
the Z Maximum and Z Minimum text boxes.

Z Maximum - This value is the upper limit that the Z data is displayed in the Data 
Display window.

Z Minimum - This value is the lower limit that the Z data is displayed in the Data 
Display window.

• Calculations - This opens the Setup window to the Calculation tab. For 
more information on choosing the calculation parameters, refer to 
“Calculation Settings” on page 45.

• Auto Functions - This opens the Setup window to the Auto Functions tab. 
For more information on choosing the calculation parameters, refer to “Auto 
Functions” on page 49.

• Units - This opens the Units Window in which the user can change the scan 
display units in either metric or English units. The scale controls allow the 
X-Y scaling to be set separately from the Z scale.

English/Metric - The user can select to display the data in either English units or 
Metric units. The X Data Units and Z Data Units choices are displayed accordingly.

X Data Units – Select the radio button for the units in which the X data is displayed 
in the Data Display window.

Z Data Units - Select the radio button for the units in which the Z data is displayed 
in the Data Display window.

Figure 4-6 Repeat Scan Window Control

• Repeat Scans – This opens a Window to control the auto save and naming 
default for profile data. This feature allows the user to select a root name for 
scanned profiles that is automatically saved to a folder and named in numerical 
order.

• Number of Scans – This field sets the number of scans that is repeated in the 
same location when the user activates this feature and then starts a scan.
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• Enable – This check box turns the feature on and off. It is off when empty and on 
when there is check mark in the box.

• OK – This button closes the Window and accepts the values set before 
closing.

• Cancel – This button closes the Window without accepting any changes 
made before closing.

Figure 4-7 Tools Drop-Down List

Tools Drop-Down List

• Thin Film Stress - This opens the Thin Film Stress option window. For details on 
using Thin Film Stress, refer to “Chapter 9, “Using the Thin Film Stress 
Option,” on page 147.

• Stitch – This opens the Stitch control panel. This panel allows the user to add 
multiple profiles together to make a single larger profile up to 400,000 data 
points. The profiles being added must have the same data point spacing though 
they do not need to have the same length. For details on using Stitch, refer to 
Chapter 7, “Advanced Features,” on page 117.

• Tip Retract – This opens a menu that allows the user to choose from three 
predefined distances that the stylus is retracts from the sample surface after 
finishing a scan or by pressing the Home X-Y Stages or Load Positions buttons 
on the Main software screen.

Short – The system moves the Z-stage away from the sample surface for 
1 mm before stopping.

Medium – The system moves the Z-stage away from the sample surface for 
2 mm before stopping.

Long - The system moves the Z-stage away from the sample surface for 
3 mm before stopping.
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Figure 4-8 Load Position Control Panel

• Load Position – This opens the Load Position Control Panel. The user can save 
up to 10 stage locations each with a location heading. The user must enter a 
location name in the corresponding text box to save a stage location. The user 
can clear a stored location individually or all of the locations at one time.

• Store – This button allows the user to save to memory a specific X-Y Stage 
location, Z Stage location, and corresponding location heading.

• Clear – This button allows the user to clear the corresponding stage location 
and location heading from the software.

• Go To – This button allows the user to move the X-Y Stage and Z Stage to a 
predefined stage location corresponding to the specific location heading. For 
safety concerns, the Z stage moves only if the set position is higher than the 
current Z stage position.

• Clear All – This button allows the user to clear all the saved stage locations 
and location headings from the software.

• Close – This button closes the Load Position Control Panel and returns the 
user to the Main software screen.

• Home All Motors – This homes the Z stage and X-Y stage.
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• Home Scan Stage – This brings the Scan stage to home position. The stylus 
raises up to the distance defined in tip retract

• Linear Calibration – This brings up the linear calibration window.

• Data Analysis – Opens the Data Analysis tab and displays calculation 
results from the selected parameters in the Calculations tab. For more 
description of the Data Analysis features, refer to Chapter 6, “Data 
Analysis,” on page 84.

Windows Drop-down List

Figure 4-9 Windows Drop-Down Lists

• Close All – Closes all the open Data Windows inside the Alpha-Step 
Development Series profiler Application.

• Cascade – Arranges the open Windows overlapping each other one on top of the 
other with a small offset displaying the title bar.

• Tile Horizontally – Arranges the open Windows side by side and resizes them to 
fit the dimensions of the Alpha-Step Development Series profiler Application 
Window so that each one is equally visible.

• Tile Vertically - Arranges the open Windows along the vertical direction and 
re-sizes them to fit the dimensions of the Alpha-Step Development Series 
profiler Application Window so that each one is equally visible.

• View - This toggles on/off the visibility of the following panes, windows, or 
tabs: Video Capture window, Control pane, Data Control pane, Scan Parameters 
tab, Cursor Control tab, Real Time Display tab, and Sequence tab.
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Help Drop-Down List

Figure 4-10 Help Drop-Down List

• Contents – This brings up the user manual PDF file.

• About – Opens the Alpha-Step Development Series profiler software splash 
screen showing the software version, log level and company information.

Applications Tool Bar Icons

Figure 4-11 Applications Tool Bar

• Open – Opens a new Data Window

• Save – Opens the Save dialog box so the current data displayed in the active. 
Data Window can be named and saved.

• Print Preview - Opens Print Preview Window of the active Data Window to 
show what the user sees when the page is printed.

• Print – Opens the Standard Windows Print controls allowing the user to select a 
printer and print settings.

• Set-up – Opens the Alpha-Step Development Series profiler calculation 
selection and Auto Step functions controls. This Window allows the user to 
make selections of the parameters for calculating results as well as the Auto Step 
settings. A more detailed description is given in Chapter 4, “Scan Parameter 
Tab,” on page 42.

• Data Analysis – Calculates the parameters chosen in the Calculations tab of the 
Set-up Window on all the open Data Windows.

• Displayed Windows – Lists all the open Data Windows and including the Video 
Window. This drop-down list allows the user to select the active Window and 
move between different Windows.
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4.3 Windows and Tab Features

The Alpha-Step Development Series profiler software use the individual Windows 
to organize the features and offer flexibility to the user. The controls for the use of 
the Windows and tab features are described in this section. There is no limitation to 
how many windows can be opened at the same time.

4.3.1 General Description

• Windows - Any Window that is floating in the Alpha-Step Development Series 
profiler application environment can be resized or moved by using the cursor to 
grab an edge or corner and then hold down the Left Mouse Button and drag that 
part of the Window to make it bigger or smaller.

• Tabs – Are as a default, anchored in the Alpha-Step Development Series 
profiler application environment. Each tab has a drop-down control in the upper 
right corner that shows available mode options for the tab. Any tab can have the 
following modes:

• Float – This mode undocks the tab and sets it as a floating Window in the 
main Alpha-Step Development Series profiler application environment. If a 
tab is in Float mode, it has all the attributes described above for a window. 
To return a tab that is set to Float back to its original Docked position inside 
the Application window double-click the title bar of the Control window 
you wish to reset to a tab.

• Dockable – Returns a Floating tab Window to its default Docked location.

• A tab can be closed by clicking the upper right corner of the tab or Window 
(when it is Floating). If a tab is closed, it can automatically be reopened if the 
user selects the associated function.
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4.4 Measurement Head Hardware Description

The Measurement Head is the core of the Alpha-Step Development Series profiler. 
This part of the instrument enables high resolution and low force measurements. In 
addition to the measurement capabilities, the Measurement Head also incorporates 
important safety features and integrates them with the measurement hardware to 
make the Alpha-Step Development Series profiler easy to use, robust to user 
mistakes and easy to maintain.

The Measurement Head assembly is made up of two major sub-assemblies: The 
Pivot Assembly and the Video Camera Assembly. Each of these sub-assemblies is 
described in the followings.

Figure 4-12 Measurement Head Assembly

4.4.1 Video Camera Assembly

The video camera assembly uses a CCD camera array with an imaging lens. The 
camera is mounted at a 45 degree angle to the stylus so that the user can focus on the 
stylus tip as well as the sample surface to assist with sample positioning. The 
standard field of view is approximately 3.8 mm by 3.2 mm. The camera field of 
view can be changed using the software slider bar controls. Refer to Chapter 5, 
“Magnifying the Sample Image,” on page 68 for details on adjusting the camera 
zoom.
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4.4.1.1 Pivot Block Assembly

The pivot block assembly is the heart of the profiler. This assembly includes the 
moving components that allow for the high precision and low force control 
profiling. The pivot assembly also incorporates an emergency sensor switch, break 
away stylus spring clamp, pivot lock, and laser adjustment screws.

Pivot Assembly Feature Descriptions

Laser position adjustment screws on each side of the pivot block assembly are the 
set screw adjustments (see Figure 4-12). The left side set screws adjusts the vertical 
laser position on the detector. The right side set screw adjusts the lateral laser 
position. The set screws are only used if the instrument requires service (call the 
KLA-Tencor Service Department for making any adjustments to the laser position).

• Pivot Clamp – The pivot clamp is a spring clamp design that allows for easy 
exchange of the stylus. All the styli have tapered D-shaped mounts so they self 
align when placed into the pivot clamp. The spring clamp design also allows for 
the stylus to break away from the clamp if the stylus is accidentally hit or the 
pivot fails and moves too far. This break away design ensures that the stylus is 
kept as safe as possible to reduce accidental damage requiring replacement of 
the stylus.

• Stylus Lock – The pivot and stylus can be locked using the spring loaded dowel 
post. The pivot lock is used when exchanging the stylus and for realigning the 
pivot assembly after service. Detailed instructions on using the pivot lock are 
given in the followings.

• Emergency Sensor Switch – The dowel post also serves as an emergency switch 
with the stylus clamp and pivot. The end of the dowel has a tapered end which 
sits inside the stylus clamp. If the pivot is accidentally moved too far up or down 
the dowel makes an electrical contact with the stylus clamp and stops the Z 
movement. This feature protects the stylus and pivot from accidental damage or 
crashing into the sample or the stage.

Locking the Pivot Assembly

1. Move the stylus to a safe distance above the stage or sample then gently grab 
the red knob on the right side of the pivot assembly (see Figure 4-12).

2. Gently press the red knob towards the left and turn clockwise until you feel 
the dowel lock into the new position.

3. Release the red knob, the pivot is now in the locked position and ready for 
stylus exchange.
# 9019320-000 Rev. AC KLA-TENCOR CONFIDENTIAL -- RESTRICTED DISTRIBUTION D-500 & D-600 User Manual 37 



Chapter 4–Description of Features
Unlocking the Pivot Assembly

1. Move the stylus to a safe distance above the stage or sample then gently grab 
the red knob on the right side of the pivot assembly (see Figure 4-12).

2. Gently turn the red knob in a counterclockwise direction until you feel the 
dowel release from the locked position.

3. Allow the dowel to slide to the right into the unlocked position

4. Release the red knob, the pivot is now in the unlocked position and ready for 
scanning.

4.5 Protecting the Stylus Arm

The KLA-Tencor Warranty Policy does not cover damage to the stylus arm 
assembly or the pivot caused by operator error.

Although KLA-Tencor has made design precautions to guard against damage to the 
stylus arm assembly; there are cases where damage can occur. Damage can occur 
from the stylus hitting an object fixed to the stage that moves against the stylus 
shaft.

Specifically, the stylus can be damaged whenever it encounters an obstacle higher 
than the bevel height of the stylus tip that is higher than 0.4 mm. In addition, a 
shorter object can damage the stylus if it has sharp corners or burs that bite into the 
stylus tip.

The following cases illustrate ways in which you could damage the stylus arm 
assembly:

If you lower the stylus or start a scan when the sample is not directly under the 
stylus, damage to the stylus can occur by the stage moving the sample into the stylus 
from the side.

NOTE

Do not start a scan or move the stage unless you know that the stylus is directly 
over the sample or you could damage the stylus.

If the stylus is down and you move the stage without monitoring the video image, 
the stylus can hit the edge of an obstruction or precision locator and sheer the tip off.
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NOTE

If the stylus is down, do not move the stage without monitoring the video image or 
you can damage the stylus.

If you change the substrate or precision locator without resetting the height of the 
stylus, the tip can run into the sample when positioning the sample under the 
measurement head causing damage to occur. The measurement head must be at least 
6.4 mm above the top of the precision locator. 

NOTE

The stylus drops about 4 mm (165 mils) less than the measurement head.

NOTE

If you change the substrate or precision locator to a different height, reset the 
height of the stylus position. Otherwise, you can damage the stylus and 
measurement head.

NOTE

When designing custom jigs or fixtures, consider the precautions noted in this 
section. For instance, when designing a custom disk locator, its center section 
must be flush with the top of the disk surface. Damage can also occur when there 
is a hole in a jig, a vacuum hole, or a groove in a surface.
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4.6 Measurement Capabilities

It is useful to present information about the instrument capabilities so that the user 
can understand the abilities and limitations of the instrument. A strong 
understanding of the instrument makes choosing the appropriate scan parameters 
clearer thus getting more out of the instrument. Following is a description of some 
of the key capabilities and features of the Alpha-Step Development Series 
profilers:

• The Alpha-Step Development Series profiler has a vertical scan range of up to 
1.2 mm, without requiring any hardware options.

• The Alpha-Step Development Series profiler has a 16 bit vertical resolution on 
all instruments rivaling the highest resolution available on a desktop profiler.

• The Alpha-Step Development Series profiler can scan in both the forward and 
reverse directions.

• The Alpha-Step Development Series profiler has basic programmability to 
make multiple measurements and automatically save the data. (Available in the 
D-600 model only.)

• The Alpha-Step Development Series profiler can make 3D data sets and 
display the image in Apex software. (Available in the D-600 model only.)

• The Alpha-Step Development Series profiler records up to 400,000 data points 
for a single profile scan.

NOTE

The horizontal resolution is not only a function of the number of data points in a 
profile; it is also dependent on the stylus tip radius.

• The Alpha-Step Development Series profiler can scan at speeds ranging from 
0.01 mm per second to 0.4 mm per second.

• Integrated vacuum stage with software control (for D-600).

• You can use movable cursors to make horizontal and vertical measurements that 
is displayed as either surface or step height data. The screen constantly displays 
these measurements.

• Real-Time updates to any selected calculation parameters in the Data Analysis 
tab. The Analysis tab also supports Windows Copy, Paste, and Cut functions to 
easily select results and Paste them into a spreadsheet.

• You can expand each cursor into a band to define a range (Average Mode). This 
enables averaging of step height measurements relative to two ranges rather than 
two points.
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• The cursors can be used to specify new zero points for re-leveling. You can also 
level using the Average Mode by setting the two cursor ranges.

• The Alpha-Step Development Series profiler has Soft Zoom capability.

• Surface parameter values can be displayed in preset metric or English units. 
Units for horizontal measurements are set independently of vertical units.

4.6.1 Scan Stage

The Alpha-Step Development Series profiler has an encoded scan stage with 
high-resolution stepper motors to ensure accurate speed control and distance 
measurements. The scan stage rests on a high quality optical flat to ensure a smooth 
linear movement of the scan stage with minimal out of plane motion.

The scan stage can measure in both the forward and reverse directions. The user can 
measure a sample in both directions along the same scan line without having to 
move the sample on the stage. 3D data acquisition is aided in some ways in Reverse 
mode.
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4.7 Scan Parameter Tab

Figure 4-13 Scan Parameters Tab

The Scan Parameter tab is where the user selects all the scan parameters. After 
starting the Alpha-Step Development Series profiler Application software, the 
Scan Parameters tab is by default the visible tab along the bottom edge of the 
Application Window. At anytime the user can select the Scan Parameter tab with 
the cursor to bring it to the top position.

The Scan Parameter tab can be set to the Alpha-Step Development Series profiler 
Application environment. When it Floats it has the same characteristic as a Window. 
The user can dock the Scan Parameter Window at any time by double-clicking the 
top title bar of the Window. This restores the tab to its default Dock location.

4.7.1 Setting Scan Parameters

2-D Scan Parameters such as length, speed, stylus force, vertical range, scan 
direction, and data points must be chosen before a scan is taken. When 3D is 
checked, the scan can be a 3D scan and the values for parameters such as width, 
traces and spacing need to be entered.The Scan Parameter tab is where the user 
selects these parameters. In this section we describe how the user can change the 
parameters in the Alpha-Step Development Series profiler Application.

To edit the fields in the Scan Parameters window:

1. Position the cursor over the field you wish to change.

2. Click to highlight the field or click and drag the pointer over the field of 
interest to highlight the value. Release the mouse button.

3. Type the new value in the field.

Where an arrow indicates a drop-down list:

1. Position the cursor over the arrow and click to open the drop-down list.

2. Select the value you wish to enter in the field.
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4.7.2 Definition of Scan Parameters

In this section a description of the scan parameters is given. Some parameters are 
described further elsewhere; a reference to any further information is given in the 
relevant parameter description. Following is a description of each of the scan 
parameters.

4.7.2.1 Parameters

Speed - This sets the scan speed of the stage in mm/sec. The maximum scan rate is 
0.4 mm/sec. The minimum scan speed is 0.01 mm/sec.

NOTE

High speeds lose fine detail. Lower scan speeds are required to resolve the full 
height of a narrow peak, the edge of a corner, or the presence of a small feature.

Length - This sets the total scan length of the profile in millimeters.

The Alpha-Step D-500 maximum scan length is 30 mm.

The Alpha-Step D-600 maximum scan length is 55 mm.

NOTE

The minimum scan speed is limited by a minimum of 3 seconds scan time or 
larger than 30 m. If the scan parameters do not result in a 3 second scan time 
an error message is displayed. You are not be permitted to continue until one or 
both of the parameters are changed so the scan time exceeds 3 seconds.

Profile Type –This parameter sets the start position of the height sensor before a 
measurement. It allows the user to make use of the full sensor range in cases where 
the sample is well known and the stylus can be started on a low or high spot. It is 
useful to choose the smallest range that is capturing the full height of the desired 
feature measurement. Using this capability maximizes the measurement resolution 
by not requiring the user to choose a larger scan range and thus a lower 
corresponding resolution.

There are three profile type settings available: Step Up, Step Down, and Step 
Up/Down.

Step Up – This sets the start position for a scan on the height sensor to be at the low 
point of the range. This enables the user to make measurements over tall features 
such as a step up or upward sloping surface without being cut-off by the detector. If 
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the feature is greater than 50% of the chosen Range, more of the detector is set to 
leave room to see taller features.

Step Down - This sets the start position for a scan on the position sensor to be at the 
high end of the range. This enables the user to make measurements into deep 
features such as a trench or downward sloping surface without being cut-off by the 
detector. If the feature is greater than 50% of the chosen Range, more of the detector 
is set to leave room to see deeper features.

Step Up/Down - This sets the start position for a scan in the center of the detector. 
This setting has equal range up and down. This setting is recommended for most 
measurements and especially unknown samples.

NOTE

Step Up/Down is the only one that can be used for samples that require low force 
settings.

Range – This adjustment allows the user to choose the best full range to balance the 
full height of the sample measurement with the best resolution for the measurement. 
The chosen range represents the full height in Z available for a measurement. If the 
feature is larger than 50% of the scan range, it is clipped using the default profile 
type (Up/Down) unless one of the other Profile Type settings is chosen or the next 
largest Range setting.

NOTE

The 2.5 m range only allows the Step Up/Down setting. It is required to ensure 
the high resolution and repeatability of these smaller ranges.

The range settings are: 2.5 m, 10 m, 100 m, 550 m, and 1200 m.

Direction – This setting sets the scan stage scan direction. The scan stage can scan in 
the Forward and Reverse directions.

NOTE

The starting point for the Forward and Reverse direction is not the same. The 
user needs to first set the scan direction then reposition the stylus in relation to 
the sample feature to be measured.

Forward – The default direction is the Forward scan direction. This is the –Y 
direction in reference to the Sample Stage controls.

Reverse – The Reverse direction starts at the opposite end of the scan stage full 
range. This is the +Y direction in reference to the Sample Stage controls. The stylus 
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lifts and waits for the stage to register at the opposite end and return to execute the 
profile for the first scan. Subsequent profiles respond normally without delay.

Stylus Force - This parameter allows the user to change the stylus force applied on 
the sample. The force control is only functional in the 2.5, 10, and 100 m ranges in 
the Step Up/Down profile type. The force control range is from 15mg to as little as 
0.03mg.

Filter Level – This defines the number of data points that can be plotted in the 
profile. The number in the box is how many data points can be averaged and then 
the average plotted in those points place. This is a simple smoothing filter. The 
instrument always acquires data at 2000 points/sec. It is useful for most 
measurements to apply a filter setting to minimize noise from over-sampling.

Data Points - This displays the number of data points after filtering so that the user 
can decide if the number shown is sufficient for the measurement at hand before 
moving on.

NOTE

The number of data points needs to be large enough so that the lateral resolution 
of the profile is limited by the tip radius and not the number of data points.

3D Parameters

Width - This defines the width of the 3D image size. If the scan length is 0.8 mm and 
the width in the 3D parameter is 0.5 mm, the image size is 0.8 mm by 0.5 mm.

Traces - this defines how many traces are used for the 3D image.

Spacing - this defines the spacing between two adjacent profiles for 3D scans.

4.7.2.2 Calculation Settings

The Calculations Settings are where the user chooses which physical parameters to 
calculate with the Data Analysis tab. These results are computed for either the 
specific Data Window or globally for all the open Data Windows.

The user can make calculations on Raw profile data, Low Pass filter for Waviness 
calculations and the High Pass filter for Roughness calculations. Following is a 
description of each of the features in the Calculations Settings.

Opening the Calculations Settings window

The user can open the Calculations Setting window from the Alpha-Step 
Development Series profiler Application by selecting Calculations from the 
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Settings drop-down list. The Calculations Settings Window is displayed. The user 
can then select the parameters they wish calculated when an analysis is run.

Calculations Parameter Definitions
Figure 4-14 Setup Window Calculations Tab

Setup - Calculations tab lists the various standard data surface analysis calculations 
that are calculated and displayed in the Data Analysis Spreadsheet at the bottom of 
the screen.

Raw Data – These calculations are made on the profile data without a filter applied. 
A scan is assumed Raw, if it is loaded from a file or just scanned and displayed in a 
Data Window.

X (M Cursor) – This gives the X position of the Measurement cursor where it 
intersects the profile.

Z (M Cursor) - This gives the Z position of the Measurement cursor where it 
intersects the profile.

X (R Cursor) - This gives the X position of the Reference cursor where it intersects 
the profile.
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Z (R Cursor) - This gives the Z position of the Reference cursor where it intersects 
the profile.

X (M) – X (R) – This gives the lateral distance between the Measurement cursor and 
the Reference cursor, from center-line to center-line.

Z (M) – Z (R) - This gives the Height distance between the Measurement cursor and 
the Reference cursor. This is the measurement used for step height.

Max. Peak —This is a measurement of the highest point of the profile from the 
mean line of the entire profile.

Min. Valley — This is a measurement of the lowest point of the profile from the 
mean line of the entire profile.

Average Roughness Ra (raw) — This is the arithmetic average of the absolute 
values of the profile height deviations recorded within the evaluation length (L) and 
measured from the mean line. Ra = (|Z1| + |Z2| + |Z3| ….|ZN|)/N.

Root Mean Square Roughness (RMS) Rq (raw) — This is the root mean square 
average of the profile height deviations taken with the evaluation length (L) and 
measured from the mean line. Rq = {[(Z1-Zavg)2+(Z2-Zavg)2+...+(ZN-Zavg)2/N]}1/2.

Maximum Profile Peak Height Rp (raw) — This is the distance between the highest 
point of the profile and the mean line within the evaluation length (L).

Maximum Profile Valley Depth Rv (raw) — This is the distance between the lowest 
point of the profile and the mean line within the evaluation length (L).

Roughness (Peak – Valley) Rt (raw) – The P-to-V is a measurement of the lowest 
point to the highest point of the profile from the center-line of the R cursor to the 
center-line of the M cursor.

Area — The area is measured by projecting a line from the center-line of the 
Reference cursor to the center-line of the Measurement cursor and calculating the 
area subtended by the profile.

Slope - The slope is measured by calculating the slope of the line projected from the 
center dashed line of the reference cursor thru the center of the dashed line of the 
measurement cursor.

Angle – This calculates the angle in degrees of the slope determined by using the 
change in height between the Measurement and Reference cursors divided by the 
lateral distance between the Measurement and Reference cursors to the Baseline.
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Radius – This calculates the radius of curvature determined by the distance between 
the Measurement and Reference cursors.

Film Thickness – The film thickness is calculated by dividing the step height by the 
processing number. 

Waviness – These calculations are available when using the Low Pass filter in the 
Cursor Control tab. The calculations in the followings uses the same basic 
algorithm as described in the Raw Data section above. The calculations are made 
after the data has been filtered and displayed (refer to “Software Band Pass Filter” 
on page 115”).

Average Maximum Deviation Wz – The average of the successive values of Wti 
(maximum peak-to-valley) calculated over the evaluation length (L). This parameter 
is the same as Wz (DIN) when there are five sampling lengths within the evaluation 
length (L).

Wz Increment (MICRON) – This is the evaluation length (L) used in calculating the 
Wz value above. The segment length must be evenly divisible into the profile length 
to function properly.

Perimeter - Perimeter is measured by calculating the lineal distance of all of the data 
points between the center dashed lines of the measurement and reference cursors.

Roughness – These calculations are only available when using the High Pass filter 
in the Cursor Control tab. The calculations in the followings use the same basic 
algorithm as described in the Raw Data section above. The calculations are made 
after the data has been filtered and displayed. Refer to Chapter 6, “Working with 2D 
Profiles,” on page 83 for more information.

Average Maximum Deviation Rz (filtered) - The average of the successive values of 
Rti (maximum peak-to-valley) calculated over the evaluation length (L). This 
parameter is the same as Rz (DIN) when there are five sampling lengths within the 
evaluation length (L).

Rsk - The measure of the asymmetry of the profile about the mean line.

Rz Increment – This is the evaluation length (L) used in calculating the Rz value 
mentioned above. The segment length must be evenly divisible into the profile 
length to function properly.

Num Increments - This uses the data points to define the evaluation length used in 
calculating the RZ value mentioned above.
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4.7.3 Auto Functions

The Auto Function tab is where the user can turn on and off the Auto Level and 
Auto Measure functions as well as choose the method of calculating the step. These 
tools are intended for step measurements on well-defined step features. It allows the 
user to apply a consistent method of leveling multiple data sets and then calculating 
a step height (or depth). These tools are not intended for measurements with many 
features included or with poorly defined step edges.

The controls allow the user to choose parameters then that can be automatically 
applied to any scans when the data is plotted or opened in a Data Window. The Auto 
Functions set parameters for leveling and/or measuring a profile by a predetermined 
method. The user can choose between set cursor locations or by a Step Detect 
algorithm.

The Auto Functions Settings Window is displayed. 

Figure 4-15 Auto Functions Settings Window

There are many ways to display the Auto Functions Settings window:
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Figure 4-16 Accessing Auto Functions from Settings Menu

• In the Settings menu, click Auto Functions as shown in Figure 4-16. The Auto 
Functions window is displayed. 

Figure 4-17 Accessing Auto Functions from Setup

• In the Application toolbar, click Setup as shown in Figure 4-17. The Auto 
Functions window is displayed.

4.7.3.1 Auto Functions Parameter Definitions

Auto Level – This feature allows the user to level the profile data in one of two 
methods, using fixed cursor locations or using the Step Detect algorithm.

Auto Measure – This feature allows the user to measure a step height in one of two 
methods, using fixed cursor locations or using the Step Detect algorithm.

Step Detect – By choosing this radial button the software calculates the 
Measurement and Reference cursor locations using the algorithm for Auto Step 
Detect. The Step Detect algorithm detects the first edge of the first step in a profile 
based on the Threshold value (refer to the following Threshold description). The 
Reference cursor is positioned to the left of this edge. The Measurement cursor is 
positioned to the right of the first edge and to the left of the second edge detected by 
the software using the same Threshold value. The software assumes the step is 
between the first and second detected edges that are greater than the Threshold 
value. The user can choose either Fixed Width or Auto (refer to the following Auto 
Measure function) to determine the Reference and Measurement cursor widths.
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Auto Level

Fixed – This function allows the user to level the data by choosing specific cursor 
locations for the Measurement and Reference cursors. The user also can choose 
the width of both the cursors. Press the radio button to activate this function

R Cursor – This value is the X position of the Reference cursor that is used when the 
Fixed Level function is active. The user must enter a value smaller than the profile 
length and less than the value used for the Measurement cursor.

M Cursor – This value is the X position of the Measurement cursor that is used 
when the Fixed Level function is active. The user must enter a value smaller than 
the profile length and larger than the value used for the Reference cursor.

Width – This value is the width of both the Reference and Measurement cursors in 
the units of the X-Axis displayed in the Data Display window. The same width is 
used for both cursors

Step Detect – This radial button activates the level function using the algorithm for 
Auto Step Detect. The Reference and Measurement cursors are positioned to the 
left of the detected step. The position of the two cursors is determined by the 
distance of the leading edge of the detected step and the beginning of the profile. 
The user can choose either Fixed Width or Auto (refer to the following Auto 
Measure function) to determine the Reference and Measurement cursor locations.

Auto Measure

Fixed - This function allows the user to Measure a step height by choosing specific 
cursor locations for the Measurement and Reference cursors. The user also can 
choose the width of both the cursors. Press the radio button to activate this function

R Cursor – This value is the X position of the Reference cursor that is used when the 
Auto Measure function is active. The user must enter a value smaller than the profile 
length and less than the value used for the Measurement cursor.

M Cursor – This value is the X position of the Measurement cursor that is used 
when the Auto Measure function is active. The user must enter a value smaller than 
the profile length and larger than the value used for the Reference cursor.

Width – This value is the width of both the Reference and Measurement cursors in 
the units of the X-Axis displayed in the Data Display window. The same width is 
used for both cursors.

Step Detect

Method – The user can choose one of two algorithms to determine the step edges, 
1st derivative (f(x)’) or 2nd derivative (f(x)”). The software uses the chosen method 
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to find the first edge of a step that is greater than the Threshold value and the second 
edge of a step that is greater than the Threshold value.

Threshold – This value is given as a percentage value of the largest peak in the 
profile calculated using the 1st and 2nd derivative. The largest peak is given a value 
of 100%. All the other calculated peaks are scaled in proportion to the largest peak. 
The percentage value in the Threshold field causes the software to ignore any peaks 
that are smaller than the chosen percentage of the maximum derivative peak.

Width – This feature allows the user to choose a fixed cursor width or choose Auto 
width, each is described as follows:

Fixed – This field allows the user to enter a value in units of the X-Axis for the 
cursor widths. This value is used for both the Reference cursor and the 
Measurement cursor.

Auto – This field allows the user to choose the cursor width as a percentage value. 
The width of the Measurement Cursor is set as the percentage value of the detected 
step’s width. The width of the Reference cursor is set as distance from the 
beginning of the profile to the first edge of the step multiplied by the percentage set 
in the Auto text field.

Auto Filters: This field allows the user to choose the cutoff filter to automatically 
separate the waviness and roughness component. For the detailed description, refer 
to Chapter 6, “Working with 2D Profiles,” on page 83.

High Pass: This specifies the cutoff value for short wavelength filter cut off. The 
component with wavelength longer than the specified value is removed from the 
process profile.

Low pass: This specifies the cutoff value for long wavelength filter cut off. The 
component with wavelength shorter than the specified value is removed from the 
process profile.

Polynomial filter: When this filter is enabled, it finds step, removes the step from the 
data, ensures a low frequency fit to the data, removes the low frequency noise, and 
then re-creates the step. This filter improves the step height repeatability.

4.8 Using Scan Recipes

Scan Recipes are intended to simplify the measurement process for applications that 
use scan settings repeatedly or when many users are operating the instrument and 
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want to retain important settings. In this section we can discuss how to load a Scan 
Recipe, scan from it and save a Scan Recipe.

NOTE

It is assumed that the operator has already made the changes to the Scan 
Parameters tab before following the instructions in the following.

4.8.1 Saving a Scan Recipe

1. From the profiler Application window, click the File drop-down list located 
at the top left corner of the screen.

2. Scroll the cursor to Save Scan Recipe and click once. A dialog box is 
displayed. The scan recipe is saved in .rcp file format.

3. Type in a File name and press ENTER or click OK.

4.8.2 Loading a Scan Recipe

1. From the Application window, click the File drop-down list located at the 
top left corner of the screen.

2. Scroll the cursor to Load Scan Recipe and click once. A dialog box is 
displayed. Two types of scan recipes can be loaded: rcp format saved with 
D-500/D-600 or txt format imported from an older version of D-series 
profilers.

3. Choose a File name and press ENTER or select Open. This loads the saved 
Setup parameters and Calculation parameters.

4.8.3 Changing a Scan Recipe

Often a new Scan Recipe is a slight variation of one you have already written. 
Rather than always using the default Setup parameters as a template, any Scan 
Recipe can serve the same purpose.

1. Follow the Loading a Scan Recipe directions above.

2. From the Main software screen, choose File and click once.

3. The Scan Parameters window is displayed with the Loaded Scan Recipe 
choices. Make any changes to the parameters.

4. Follow the steps in Chapter 4, “Saving a Scan Recipe”.
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Chapter 5–Basic Operation
5.1 Introduction

This chapter describes the basic operation of the Alpha-Step Development Series 
profiler instrument and software. Included in this section are powering up the 
instrument, loading and unloading a sample, viewing and positioning with the video 
system and measuring a profile.

5.2 Powering up the Instrument

To start up the Alpha-Step Development Series profiler System, do the following:

1. Verify that the system power cord is plugged in.

2. Verify the computer and monitor are powered on. If not, press the Power 
button. Wait until the Windows Operating System is fully loaded, showing 
the desktop, before proceeding to the next step.

3. Turn on the power to the profiler on the back panel. Wait at least 10 seconds 
before running the profiler software to allow the Stage and computer to 
establish the USB connection.

4. Double-click the icon located on the Windows desktop.

The system raises the measurement head and then moves the sample stage to its 
home position.

5. The system is now ready to use.
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5.3 Loading the Sample

Loading a sample is a straightforward process. There is a process for the manual 
Alpha-Step D-500 instruments and a motorized process for the Alpha-Step D-600 
instruments.

Loading the sample using the manual stage (Alpha-Step D-500):

1. Open the sample stage cover and place the sample on the stage table or precision 
locator. See Figure 5-1.

Figure 5-1 D-500 Stage Table

NOTE

If you are using the precision locator, it is normally used in the 0 position.

2. Using the finger dials, manually move the stage so the sample is moved under 
the stylus.

3. When you have roughly placed the sample under the stylus, use the Z Stage 
controls to lower the stylus until you can see the stylus and sample in the Video 
window.
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NOTE

Do not bring the stylus down too quickly or you might crash the stylus into your 
sample surface and damage one or both of them.

4. Use the finger stage controls one at a time to fine position the sample under the 
stylus ready for a measurement.

Loading the Sample using the Motorized Stage (Alpha-Step D-600 only)

NOTE

Look to see that the stylus is not engaged or too close to the sample surface 
before proceeding further.

1. If the stage is not already at the sample load position (closest to the operator 
and out from under the stylus), on the Control Panel tab, click Load 
Positions, and use one of the preset stage positions or manually use the X-Y 
stage controls to move the sample stage out from under the stylus so you can 
safely load a sample, (see Figure 5-4 and refer to Load Positions on 
page 64).

2. After the stage moves to its forward Load position, a message is displayed 
on screen telling the user the stage is at the home position. Press ENTER or 
click OK to continue.
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3. Open the sample stage cover and place the sample on the stage table or 
precision locator. See Figure 5-2.

Figure 5-2 D-600 Stage Table
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NOTE

If you are using the precision locator as shown in Figure 5-3, it is normally used in 
the 0 position. There are locating pins for precision locating, which support 
samples in the size of 2-8 in..

Figure 5-3 D-600 Precision Locator (Universal Chuck)

4. Engage the vacuum switch, click Vacuum located on the main software 
screen in the Z Stage controls panel, as shown in Figure 5-4. Users can find 
the vacuum unnecessary for their sample and can skip this step.
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NOTE

D-600 stage table has vacuum rings as shown in Figure 5-2, turning off a vacuum 
valve which prevents the vacuum flow outside the related ring. You can choose 
different vacuum rings for different sample sizes.

5. Move the stage in the Y+ direction using the X-Y Stage controls until the 
sample is positioned under the measurement head. The user can see roughly 
how close the sample is with the naked eye.

6. Use the X-Y controls to position the sample for a measurement (see 
Figure 5-4 for positioning in X-Y for more detailed description of using the 
X-Y controls).

7. Close the sample stage door cover.

NOTE

Ensure that the measurement head is above the sample and clearly above the 
surface in the Video window or by using the naked eye to see that the tip is off 
the sample surface before closing the stage door cover.

Figure 5-4 Load Positions Video Capture
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5.4 Control Panel Tab

The Control Panel tab has all of the video, motor stage controls, together with data 
automatic saving function. This tab is where the user turns on or off the vacuum, 
adjusts video for brightness and contrast, adjusts magnification of the camera, move 
the stylus up and down when adjusting for setting up a measurement location and 
moving the sample stage.

The Control Panel tab can be set as a Window or Hidden. The Hide mode causes 
the tab to collapse along the right side of the Application window and not be 
visible. To see the tab again, the user moves the cursor over to the right edge of the 
window and the tab can be displayed again until the cursor is moved off the tab.

5.4.1 Video Controls and Zoom

The Video controls are divided into two groups:

Video – These controls adjust the view in the Video window. The video camera has 
a built in light level adjustment that is try to compensate for high light levels. This 
might affect the dynamic range of the contrast and brightness controls.

Illumination - The Illumination slider bar adjusts an LED light located on the Pivot 
assembly. Sliding the bar to the right makes the light brighter.

NOTE

Leaving the light on high is a heat source and can cause the sample to heat up 
over extended time.

Contrast - The Contrast slider bar adjusts the video camera and video card contrast. 
Sliding the bar to the right increases the contrast level.

Brightness - The Brightness slider bar adjusts the video camera and video card 
brightness level. Sliding the bar to the right increases the brightness level.

Zoom Lens – These controls adjust the digital zoom in the video camera. There are 
four digital zoom magnifications: 1x, 1.3x, 2x and 4x.
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Figure 5-5 Control Panel Tab

5.4.1.1 Viewing the Stylus in the Video Window

The Alpha-Step Development Series profiler measurement head integrates a 
high-resolution adjustable video camera. The video camera focus is set so that the 
stylus tip is always in focus. The user must move the Z stage to bring the sample 
into the field of view and focus of the stylus. After the sample has been loaded and 
the stage moved beneath the measurement head, the sample is visible in the Video 
window of the main software screen as shown in Figure 5-4 above. Using the Video 
window, the user can position the sample to the place of interest to start a scan. The 
sample motion consists of two parts:

• Z motion - motion of the measurement head up and down.

• X-Y motion - motion of the sample stage left and right, and back and forward.
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5.4.1.2 Stage Positioning

The user can control the X-Y stage position and Z Stage up and down motion of the 
measurement head using the cursor, click the arrow control for the intended 
direction. (Theta) Motion (rotation of the stage or sample) is controlled manually by 
the user (Note: Alpha-Step D-600 only).

X-Y Stages - The X-Y Stage control consists of four double arrows, representing the 
right and left X motion of the stage and the forward and back Y-motion of the stage. 
The current stage coordinates are displayed next to the double arrows of X+ and Y+. 
Each arrow direction also has a single inner arrow that is 50% of the double arrow 
speed. A slider bar controls the speed of the X-Y motion. Moving the slider control 
to the right increases the speed of the stage motion. The arrow directions correspond 
with the video display frame of reference.

Unit display selection - This switches the display of the of X-Y stage position in unit 
of Millimeter or Inch.

Display reference - This switches the reference of the display. The Instrument uses 
the back of the X-Y stage as 0,0. The Sample uses the center of the X-Y stage as 0,0.

Speed Bar – This slider control adjusts the speed for all the X-Y arrow buttons. 
Moving the slider to the right increases the speed for each button.

Go to Origin - This button moves the X-Y stage to predefined origin position of the 
stage. The user can define any position of the X-Y stage as the origin position.

Load Positions – This button opens the Load Position Control. This Control allows 
the user to move the stage to pre-saved stage locations and to save stage locations 
for future use. For details about how to set the load positions, refer to Load Positions 
on page 32.

Z-Stage - The Z-stage controls consist of two arrows, and a speed bar control. The 
Z-stage moves the stylus up and down. It is necessary to move the stylus close to the 
sample surface can be able to see the stylus and the sample surface in the Video 
Capture window as shown in Figure 4-1.

Arrow Buttons – Pressing the up or down arrow moves the Z-stage up or down 
respectively.

Display Frame under Arrow Buttons - It displays the current Z-stage position.

Set Button - This button moves the Z-stage to a predefined set position of the stage. 
The user can define any position of the Z-stage as the set position. For safety 
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concerns, the Z stage only moves to this position if the set position is higher than the 
current Z stage position.

Display Frame under Set Button - It displays the set Z stage position.

Lowest Z stage position - It is a soft limit and not allows the Z stage to move any 
lower (closer to the sample surface) than this predefined position. The user can 
manually input the predefined position and press the Set Button, or calibrate the 
predefined position with a sample by clicking the Cal button. 

Speed Bar – This slider control adjusts the speed for the two Z arrow buttons. 
Moving the slider to the right increases the speed for each button.

Engage – This button is automatically lower the Z stage at a safe speed until it 
detects the sample surface and stops.

Focus - This button automatically lowers the Z stage at safe speed until it detects the 
sample surface and stops. The stylus is lifted and keeps a distance from the sample 
surface. After the process is completed, the user can move the sample under the 
stylus and keep the sample in focus. 

5.4.1.3 Using the Stage Controls

To control the stage motion:

Click the double arrow direction in which you wish to move. Hold down the mouse 
button to continuously move in the chosen direction.

Click the single inner arrow to move at half the speed of the double arrow pointing 
in the same direction. Hold down the mouse button to continuously move in the 
chosen direction.

To adjust the Stage speed of motion, click the slider bar. Hold down the mouse 
button and move the mouse to the right to speed up the motion and to the left to slow 
down the motion.

Click the slider bar arrows and holding down the button also slides the speed control 
bar in the corresponding direction (see Figure 5-5).
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5.4.2 Automatic Saving

The automatic saving contains Auto Save and Auto Export functions.

Auto Save - When Auto Save is enabled, the scan profile is automatically saved as 
XML format.

Auto Export - When Auto Export is enabled, the Data Analysis Results table is 
automatically exported as CSV format.

Filename Base - The filename base of auto-saved data and/or the auto-exported file.

Append - The appended filename after the filename base. Users could choose either 
the Data-Time or a starting number.

NOTE

When using Date_Time, it appends _YYYY-MMDD_HHMMSS.

When appending a number, it appends “_0000”.  For example, if the number is 
10, it would append “_0010”.

Data Path - Users should select a data path for the automatic saving files.
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5.5 Engaging the Stylus

There are two methods to engage the stylus onto the sample surface: using the 
Engage button located on the Z stage control panel (see Figure 5-5), or by clicking 
Scan in the Video Capture window (see Figure 5-4).

5.5.1 Using the Engage Button

1. After the stylus is positioned over the sample, click Engage in the Z Stage 
control panel and click once. The profiler automatically brings the stylus 
down onto the sample surface and stops.

2. If the measurement requires precise positioning, first click Focus in the Z 
stage control panel, then move X-Y stage to the desired position, and then 
engage the stylus.

Figure 5-6 Stylus Near Sample Surface

NOTE

Always raise the stylus off the sample surface before moving the sample to a 
different location. Failing to lift the stylus off the surface before moving the X-Y 
stage can damage the stylus and the sample.
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5.5.2 Using the Scan Button

1. After the stylus is positioned over the sample, Click Scan located in the 
Video Capture window of the Main software screen. After the Scan is 
clicked, the instrument automatically engages the stylus on the sample 
surface and begins the scan. To cancel Engage or Scan the user can click 
Cancel located next to the Scan in the Video Capture window.

NOTE

Remember to raise the stylus off the sample surface and home the scan stage 
before repositioning the sample.

5.6 Magnifying the Sample Image

Figure 5-7 Lens Magnification Control

The user can magnify the sample video image to see more detail or make it easier to 
get a specific feature location. This zoom function is a digital zoom, and there are 
four zoom factors: 1x, 1.3x, 2x and 4x. After the zoom factor is selected, the 
software stores the factor for future usage.
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5.7 Profiling a Sample

Getting a profile using the Alpha-Step Development Series profiler is a very 
simple and straightforward process. After the user understands what settings to 
choose for the scan Parameters, there are some steps to be followed for getting the 
scan data. They are as follows:

1. Load the sample.

2. Position the sample under the stylus and focus on the area of interest.

3. Press the Scan button. For 3D scans, the user is need to select a directory and 
input the file name after press the Scan button. After the scan finishes, the 
3D results are automatically saved.

4. Display the Profile. For 3D scans, after the scan finishes, Apex is 
automatically open with the scan image.

5. Save the results for 2-D scans.

5.7.1 Loading a Sample

Follow the instructions for the appropriate profiler instrument, manual or motorized 
models in “Loading the Sample” on page 57.

1. Open the stage cover

2. Place the sample on the stage. Align the sample so that the profile is along 
the path of interest.

NOTE

The profile is scanned along the Y stage direction. The default direction is from 
the back to the front of the instrument, the –Y direction.

5.7.2 Position the Sample

Follow the instructions for the appropriate profiler instrument, manual or motorized 
models in “Control Panel Tab” on page 62.

1. Either manually or with the motor controls, move the sample stage so the 
sample is under the stylus.

2. When you have roughly placed the sample under the stylus, use the Z Stage 
controls to lower the stylus until you can see the stylus and sample in the 
Video window. Click Focus in the Z stage control panel, the sample to be in 
focused position and the stylus to be lifted from the sample surface.
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NOTE

Do not bring the stylus down too quickly or you might crash the stylus into your 
sample surface and damage one or both of them.

3. Use the fine position controls, either manual or motorized depending on the 
profiler model, to adjust the sample under the stylus until it is in position 
ready for a measurement.

5.7.3 Set Scan Parameters

Follow the instructions for choosing the appropriate Scan Parameters. Refer to 
“Scan Parameter Tab” on page 42 more detailed information.

1. Select the Scan Parameter tab on the bottom portion to be visible.

2. Set the scan parameters appropriate for the measurement

Click Scan 

1. Click Scan located in the upper left corner of the Video Capture window. 
For 3D scans, the software asks the user to select the folder and input a file 
name for the 3D scan. The 3D scan result is automatically stored after the 
scan finishes.

2. The stylus automatically lowers towards the sample surface until it engages 
the sample surface.

3. If the user does not Abort the scan by clicking Cancel, the instrument 
automatically begins the scan. The Real Time Display shows the profile as it 
is scanned.

4. When the scan is completed, the stylus lifts off the sample surface, the stage 
returns to its starting position above the start-of-scan location, and the Data 
Display window is opened with the profile plotted in dimensioned 
coordinates (see Figure 5-10). For 3D scans, the scan result is automatically 
open in Apex.

Display the Data

For 2-D scans, the profile is automatically displayed in a new Data window after the 
scan is completed. For 3-D scans, the final results is automatically opened in Apex. 
The profile is ready for further analysis.
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Save the 2D Profile

1. From the Data window Open the File drop-down list.

2. Select Save Data File or Save As Data File. A dialog box is displayed.

3. Type the name of the file you want to save in the dialog box and press 
ENTER.

NOTE

The Alpha-Step Development Series profiler Application can be set to 
automatically save a profile after each scan. A description of the Auto File Name 
function is given in Chapter 4, “Description of Features,” on page 23.
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5.8 Profiling from a Scan Recipe

To profile a sample, the instrument moves the scan stage beneath the measurement 
head while the stylus rests on the sample. The up and down movement of the stylus 
is detected by a laser and provides the profile data.

The Setup File screen specifies how the stage moves and how the data is to be 
analyzed. The Scan Parameters tab displays the settings for the scan speed, scan 
length, scan range, stylus force, maximum number of data points, and the profile 
type (only available on 10 m and larger scan ranges).

The “Scan Parameter Tab” on page 42 describes the technique for changing the scan 
parameters. Parameters should be changed, if needed, before initiating a scan. For 
this section, it is assumed that the scan parameters are already correctly set (refer to 
Chapter 4, “Setting Scan Parameters,” on page 42 for a description of the setup 
parameters).

5.8.1 Loading a Scan Script

The Scan Scripts are saved in a default directory in the Alpha-Step Development 
Series profiler Application folder. In the software directory there is a Setup folder. 
All the scan scripts and sequence scripts are saved in this folder unless the user 
manually chooses another location.

NOTE

It is not recommended to use a different folder location for saving the Scripts.

To view Scan Script parameters you first have to load a Scan Script:

1. In the Application window, select the File drop-down list.

2. Select the Load Scan Script.

3. A Windows File dialog box opens to the default directory.

4. Select the Scan Script you wish to view. The software allows to load scan 
recipes with rcp or txt formats.

5. The Scan Script parameters are automatically entered into the Scan 
Parameter tab fields.

6. Review the Scan Parameter values and make changes if necessary before 
starting a scan.
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To start Scan

1. Click Scan located on the Video Capture window.

2. The stylus descends to engage the sample surface. The Real Time Scan 
Display (located on the Main software screen below the Video image 
window) shows a trace as it is generated.

3. When the scan is completed, the stylus lifts, the stage returns to its starting 
position above the start-of-scan location, and the Data Display window is 
displayed with the profile plotted in dimensioned coordinates (see 
Figure 5-11). 3D scan result is automatically opened in Apex.

NOTE

The trace runs off scale or is not horizontal, refer to ““Manual Stage Leveling” on 
page 77.

To Abort a Scan

There are two ways to stop a scan after it is started; Click Stop on the top left corner 
of the Video Capture window or Press ESC.

NOTE

The scan can only be stopped after the stylus is engaged and the stylus has 
started moving.

After clicking Stop or pressing the ESC, a message is displayed: Scan aborted. 
Okay to raise the stylus and home the scan stage?

Figure 5-8 Abort Scan Message Box
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If you choose No, to lift the stylus off the sample surface:

• On the Control panel, in the Z stage pane, click the up arrow. Click once to 
disengage the tip off the sample surface then raise the Z stage up a short distance 
to allow safe positioning of the sample under the stylus tip.

• Ensure that in the video view and/or visually, the tip is clearly above the sample 
surface.

• Focus in the Z stage control panel is a good choice to lift the stylus off the 
sample surface and keep the sample in focus position.

5.9 Reading the Cursors, Saving and Printing Data

Figure 5-9 Sample Data Window

After the scan is taken, a new Data window displays the profile. The profile 
displayed in the graph display; the Data Control tab is automatically opened along 
the right side of the Application window. The Data Control tab displays the cursor 
information and leveling controls (for more detailed description of the Data 
Control tab, refer Chapter 6, “Data Analysis Tab,” on page 110).
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5.9.1 Reading the Cursors

The cursor positions are displayed in real-time in the Data Control tab. There are 
always a set of Primary cursors displayed in a Data Window, the Reference and 
Measurement cursors (R and M respectively).

To Move the Cursors

• To move the R cursor, position the mouse on the R cursor, click and hold the 
button. Move the mouse right or left to reposition the cursor in a desired 
location.

• To move the M cursor, position the mouse on the M cursor, click and hold the 
button. Move the mouse right or left to reposition the cursor in a desired 
location.

• The Delta Width and Delta Height calculate the difference or X distance 
between the two cursors and the difference or Z height respectively where the 
cursors intersect the profile.

The Delta Width - The horizontal distance between the R and M cursors (see 
Figure 5-10) along the X-Axis.

The Delta Height – The vertical distance between the R and M cursors (see 
Figure 5-10) where they intersect the profile along the Z-Axis.

Figure 5-10 Data Control Tab with Cursor Information
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Printing Data

1. From the Data window, click the File drop-down list.

2. Click Print Graph. A Standard Windows Print dialog box is displayed.

3. Select a printer and make any necessary changes to the printer settings 
before continuing.

4. Click Print.

5. The current view of the profile data is sent to the default printer.

NOTE

You can also review the profile before printing in the Print Preview page.

Saving Data

1. From the Data window, click the File drop-down list.

2. Click Save Data File. A dialog box is displayed.

3. Type the name of the file you want to save in the dialog box and press 
ENTER.
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5.10 Manual Stage Leveling

Figure 5-11 Front View of Stage with Tilt Control Knob

When making profile measurements toward the front or back of the stage, you can 
notice a significant tilt so that the profile displayed in the Real Time Scan Display 
window is at a severe diagonal or even clipped by moving off scale. This can be 
adjusted with the tilt adjustment. The stage has an adjustment along the scan 
direction. This adjustment dial changes the tilt along the Y-Axis (toward or away 
from the front door panel of the stage). Following is a description for adjusting the 
stage in the case of the profile that tilts uphill.

NOTE

It is assumed that in the description that the sample being measured is placed in 
the center of the stage.

The stage tilt adjustment knob is in the front of the sample stage, see Figure 5-11.

Turning the knob clockwise moves the front of the stage down.

Turning the knob counterclockwise moves the front of the stage up. Adjusting stage 
tilt using the Real Time Scan Display:

1. Position the stage and measurement head to take a scan.

2. Scan a sample.

3. Watch the Profile trace in the Real Time Scan Display window.

4. Adjust the Stage tilt using the following:
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If the profile is tilting upwards from left to right, turn the adjustment knob in the 
counter clockwise direction to level the scan, clockwise if the profile is tilting 
downward.

5.11 Camera Settings

Camera Utilities is used to set up the camera parameters for the video view. It is 
normally hidden. Use the CTRL + M to bring up the Camera Utilities on the top of 
video view as shown in Figure 5-12.

There are many parameters for setting up the camera. Most of them are already 
pre-calibrated and does not need any change. Several common used functions are 
selected to show how they work.

Figure 5-12 Camera Utilities

5.11.1 Camera Parameters Dialog Box

This dialog box contains the parameters to display the video view. Most of the 
parameters are already optimized for the video view and we strongly suggest NOT 
adjusting them.

If some of the parameters need be adjusted for some reason, make a copy of the 
original values before the adjustment so that you can return to the original settings. 
After the parameters are adjusted, close the Camera Parameter dialog box and click 
Save camera parameters under Camera Utilities to save the change. Two of the 
camera parameters are useful for certain customers:

• Auto Gain: Auto gain is a function to automatically adjust the video gain when 
imaging samples with different reflectivity. To turn on auto gain:
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1. Press CTRL + M to enable the Camera Utilities function it is not available 
on the top of video view. 

2. Select the Open camera parameters dialog under Camera Utilities.

3. Select the Image tab.

4. Select Auto under Master gain from Hardware Settings.

5. Click OK to close the Camera Parameters dialog box.

6. Under Camera Utilities, click Save Camera Parameters to save the 
change.

• Color temperature: This is to adjust the display color of the sample. To change 
the display color:

1. Press CTRL+ M to enable the Camera Utilities function it is not available 
on the top of video view.

2. Select the Open camera parameters dialog under Camera Utilities.

3. Select the Image tab.

4. Change the gain factors for the three base colors: Red, Green and Blue. Each 
of them has its own gain factor. Adjust the gain factors to get the preferred 
display color.

5. Click OK to close the Camera Parameter dialog box.

6. Under Camera Utilities, click Save Camera Parameters to save the 
change.

5.11.2 Save Camera Parameters

After any parameter is adjusted in Camera Parameters dialog box, the user must 
click this function to save the changes.

5.11.3 Measure Illumination Uniformity

This measures brightness variation of the video view. When this function is selected, 
three parameters of the sample brightness are displayed on top of the video view: 

Max – the maximum brightness of all the pixels of the camera

Min - the minimal brightness of all the pixels of the camera

Delta – the difference between Max and Min
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5.11.4 Keystone Correction

Figure 5-13 Video Before and After Keystone Correction

The video camera assembly images the sample and the stylus with a 45 degree 
angle. The raw sample image directly from the video camera is skewed as in 
Figure 5-13(A).

To have a uniform sample image with video camera, the software has the keystone 
correction function to correct the image skew of Figure 5-13(A). Figure 5-13(B) is 
the camera image after the keystone correction. To toggle on/off Keystone 
correction:

1. Press CTRL+ M to enable the Camera Utilities function if it is not available 
on the top of video view. 

2. Enable the Apply keystone correction function under Camera Utilities. 
Now the camera view is corrected with keystone and the scale bar is 
available on the top left corner of the video.

3. Disable the Apply keystone correction function under Camera Utilities to 
disable keystone correction.

4. To hide the Camera Utilities functions, press CTRL+M again.

NOTE

During scanning, the Keystone correction is temporarily disabled.
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5.11.5 Set Keystone Correction Factor

Do not change this value. This is the value used in keystone correction.

5.11.6 Select Scale Type

The user can select grid scale or X-Y scale for the video view.

5.11.7 Set Camera View Width/Height

Do not change these values. These are the size of the video view.
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Chapter 6–Working with 2D Profiles
6.1 Introduction

After you have Setup the Scan parameters (Chapter 4, “Description of Features,” on 
page 23) and taken a scan (Chapter 5, “Basic Operation,” on page 55), the software 
displays the profile in a Data window. Chapter 5 discusses using the Data window 
and Data Control tab to analyze and manipulate the data. The data or profile in this 
chapter refers to 2-D profiles unless otherwise specified.

6.2 Data Analysis

Figure 6-1 Data Window Example

The Alpha-Step Development Series profiler software supports multiple profiles 
displayed in a single Data window (up to 10 profiles in a single window). The 
profiler Application also allows many Data windows to be displayed at the same 
time. The user has several ways of moving between the open Windows.

After a profile scan is completed and displayed in the Data window, or a profile is 
loaded into the Application the software automatically displays the Data window on 
top of the Video window; the software also moves the Data Control tab along the 
right side to the top and the Cursor Control tab along the bottom of the 
Application window. The description of the Data Window, Data Control tab, and 
Cursor Control tab are given as follows.
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6.2.0.1 Data Windows

Any profile data, either directly after making a scan or after opening a previously 
saved data file, is displayed in a Data window. The profiler software can display 25 
Data windows at the same time, or more with a simple registry change.

NOTE

There is a limit of 10 profiles displayed in the same Data window.

The Data window has the following features:

Drop-down lists – The drop-down lists are described in detail in a following section.

Alternate drop-down list – The alternate drop-down list is opened by using the right 
mouse button inside the graph region. The menu is shown in Figure 6-2. A detailed 
description of the features is given as follows.

Cursors - The controls contain the X and Z position values of the Reference cursor 
(R), the Measurement cursor (M), and the mouse cursor. It also has the difference 
between the relative X and Z positions of the R and M cursors. The values are 
continuously updated to reflect the current position of all the cursors. The user can 
enter a specific value into the X or Z position text box to move the cursor to that 
position on the profile.

The Leveling Cursors - The R and M cursors are also used as the Leveling cursors. 
The leveling function is described later “Leveling the Profile” on page 97.

The Graph – This contains a plot of the profile height (the vertical axis) at each 
horizontal location within the scan (the horizontal axis). The graph can display the 
raw data or the filtered roughness or waviness data, or both. The graphs’ axis are 
scaled as determined by the Graph Setup window (refer to “Scaling Data” on 
page 109). The default setting is AutoScale in the Z-Axis and the length of the 
profile as set in the Setup window for the X-Axis. Multiple files that are imported 
into the same window can be directly compared with the AutoScale function turned 
off. The measurement cursors also displayed in this window and are manipulated as 
described in “Measuring Profile Features” on page 102.
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Data Window Drop-Down Lists
Figure 6-2 Data Window Tool Bar Drop-Down Lists

The Data Window drop-down lists are features that apply to any of the Data 
Windows. If a drop-down list lists an item that is unavailable this means the function 
is not available and requires changing a setting to activate it. A description of the 
drop-down lists is given as follows.

File Drop-Down List

Figure 6-3 File Drop-Down List

Load Data File - This opens the Data Folder. Saved profiles can be loaded into the 
profiler software for further analysis. Choose a filename to load the profile data. The 
profile is then viewed by opening the Data Display window.

Add Data File - This allows the user to load additional profiles into the same Data 
window. The data files must have the same settings or the software is not allowing 
the user to load the file.

Save Data File – This opens a standard Windows Save dialog box. The dialog box 
prompts you to name and save the profile in the active Data window. The profile is 
saved in the Data folder in the software folder as an XML file. An option to save as 
a DAT text file is also available.

Print – This opens the standard Windows Printer dialog box prompting the user to 
choose a printer and the printer set up.

Print Preview – This opens a standard Windows preview window that displays the 
current profile data as it would look for printout.

Page Set-up – This displays a standard Windows Printer Set-up window that 
allows the user to choose the printer settings before printout.
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Close – This closes the Data window.

NOTE

When the Data window is closed it does not prompt the user to save the data 
first. Any unsaved data might be lost.

Edit Drop-Down List

Figure 6-4 Edit Drop-Down List

Copy Graph –This functions just like the standard Windows Copy feature. It allows 
the user to copy a Data window to the Clipboard, it can then be Pasted into another 
program or presentation. Ensure that this function only copies the scan data, it does 
not copy the cursors.

Tools Drop-Down List

Figure 6-5 Tools Drop-Down List

Merge Data – This opens the Merge Data Control. The user can merge up to 10 files 
into the active Data window. The user must first have separate Data windows open 
with the profiles that they wish to be Merged into the active Data window.
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Figure 6-6 Merge Data Control Window

Available Data – this field lists the profiles available to Merge other than the active 
Data window.

Selected – this field lists the profiles that have been selected to Merge into the active 
Data window.

Add Button – Using this button adds a single selected profile from the Available 
Data field.

Add All Button – This button adds all the profiles listed in the Available Data field 
to the list in the Selected Data field.

Remove Button – Using this button removes a single selected profile from the 
Selected Data field.

Remove All Button – This button removes all the profiles listed in the Selected Data 
field.

Clear Button - This button removes all the profiles listed in the Available Data field.

Calibrate Height – Begins the instrument height calibration procedure.

NOTE

It is expected that the user has already placed the calibration standard onto the 
stage and made a first measurement (more detailed description of the procedure 
is given in Chapter 10, “System Maintenance”)

Data Analysis – Calculates the parameters selected in the Calculations Control and 
then displays the results for the active Data window in the Data tab (a more detailed 
description of the data analysis and Data tab is given as follows)
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Help Drop-Down List

Figure 6-7 Help Drop-Down List

About Alpha-Step D - This opens a splash screen presenting information about the 
software version and copyright information.
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Files Displayed in Drop-Down List

Figure 6-8 Files Displayed in Drop-Down List

The title bar of the Data window has a drop-down list that shows the active profile in 
the Data window. If there are multiple profiles loaded in the Data window, the 
drop-down list shows the other profiles in the order they were loaded into the Data 
window.

Figure 6-9 Data Window Alternative Drop-Down List

Figure 6-9 Shows commonly used tools that are also found in the Tool Bar 
drop-down lists.
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Data Window Alternate drop-down list

There is a secondary way for the user to access some of the more common functions 
inside the Data window, an alternative menu. With the cursor inside the graph region 
press the Right Mouse button, a drop-down list is displayed. The descriptions for the 
items are given as follows.

Zoom – Opens the lists of Data Analysis Zoom options.

• In – This option re-scales the profile data axis to half the previous view and 
centers the data in the Data window.

• Out – This option scales the data axis out by double the previous view. It is 
expands the view until the original data scale is reached

• Zoom window – This option places a zoom box in the Data window that the 
user can re-size and select a specific portion of the profile data to display in 
the Data window. A more detailed description is given in “Data Analysis” 
on page 84.

• Show Full Scan – This option returns the Data Display to the original profile 
full-scale view.
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Set Zero On – This feature opens a list of options to set the zero reference point for 
calculating the measurement parameters.

• Reference Cursor – This sets the zero reference line for any parameter 
calculations to the location where the Reference cursor intersects the Profile 
data.

• Measure Cursor - This sets the zero reference line for any parameter 
calculations to the location where the Measure cursor intersects the Profile 
data.

• Cursor location - This sets the zero reference line for any parameter 
calculations to the location where the user places the cursor and then Presses 
the Left Mouse Button.

Figure 6-10 Data Window Alternative Drop-Down

Cursor Visible – This option toggles the cursors in the Data Display window on and 
off.

Baseline Visible – This option toggles the Baseline in the Data Display window on 
and off.

Horizontal Graph – This option toggles the horizontal scale lines in the Data 
Display window on and off.

Vertical Graph - This option toggles the vertical scale lines in the Data Display 
window on and off.

Add Cursor – Adds an additional cursor pair in the active Data Display window (up 
to 5 cursor pairs can be displayed in a single Data window). Refer to “Adding 
Additional Cursors” on page 105 for more a detailed description.

Remove Last Cursor – Removes the last cursor pair displayed in the Data Display 
window until there is only the original red cursor pair available in the window.
92 D-500 & D-600 User Manual KLA-TENCOR CONFIDENTIAL -- RESTRICTED DISTRIBUTION # 9019320-000 Rev. AC 



Chapter 6–Working with 2D Profiles 
Reset Cursors – Removes all the cursors in the Data Display window except for the 
Main Red cursor pair.

Graph Scales – Displays the Graph Scale window. Refer to “Scaling Data” on 
page 109.

Calibrate Height - This option allows the user to set the instrument height 
calibration for the specific range in use at the time.

NOTE

Never use this function without the appropriate calibration standard. Follow the 
instructions in Chapter 10, “Calibrating the Measurement Head”carefully or you 
risk changing the calibration of the instrument and any measurements you make 
after that.

Data Analysis – Opens the Data Analysis tab and displays calculation results from 
the selected parameters in the Calculations tab. For more description of the Data 
Analysis features; refer to “Data Analysis” on page 84.
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6.2.1 Data Control Tab

Figure 6-11 Data control Tab

Level Method - This box determines what method is used to level the scan data. 
There are 4 methods available:

• Least Square Fit – This leveling method is defined as: a line that minimizes 
the sum of the squares of the deviations of the measured values of Z from 
those predicted in the profile. In this case the best line fit is calculated on the 
profile data between the cursor locations. This method is recommended for 
non-step height measurements or surfaces where there is no obvious best 
place to level the data.

• Cursor Location – This method uses the location and width of the cursor to 
level the profile. Only the placement of the R and M cursors and the data 
shaded by the cursors in Average Mode are used to level the profile.

• Auto Level Fixed – This levels the profile using the settings in the Setup 
window Auto Functions tab, Auto Level section, and Fixed radio button 
(refer to Chapter 4, “Auto Functions,” on page 49).

• Auto Level Step – This levels the profile using the settings in the Setup 
window Auto Functions tab, Auto Level section, and Step Detect radio 
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button (refer to Chapter 4, “Scan Parameter Tab,” on page 42 for more 
details).

• All Data Files in Active window. If there are multiple data files added into 
the same window, and this option is checked, all the data files as in 
Figure 6-11, can be leveled by the selected leveling method.

• Level Data Button – This button when pressed uses the leveling routine with 
the radial button chosen: the Cursor Location, Least Square Fit, Auto Level 
Fixed, or Auto Level Step.

Step Detect Button – Pressing this button runs the Auto Step algorithm predefined 
by the user in the Auto Parameters window located in the Setup Parameters 
Control Panel (refer to Chapter 4, “Scan Parameter Tab,” on page 42 for more 
detailed description) on the profile in Focus.

Display Filters - When a filter is active, this box allows the user to choose whether 
to display the Filtered profile, the Raw Data profile or both. Each profile is 
displayed in a different color. Only the Raw Data radial button is available when no 
filtering is activated. There are four types of filtered functions possible, Low Pass, 
High Pass, Polynomial, and Step Fit. Refer to “Software Filter Settings” on 
page 115 for more information on the band pass filters and the Step Fit function.

Reload Raw Data button – This button re-displays the Raw Data Profile as it was 
before any filtering, leveling or other data manipulation was executed on the data 
set.

Height Histogram button – This button displays the Height Histogram window. 
The Height Histogram is described in “Height Histogram” on page -110.

Figure 6-12 Cursor Control Tab

Filters - This contains the High Pass and Low Pass cut off slide controls, text box for 
filter cut off value and on/off check box. Moreover, the on/off check box for the 
Polynomial Filter is also contained here. The Filter controls are described in more 
detail in “Software Filter Settings” on page 115”.

• High Pass – The High Pass filter control allows the user to turn on and off a 
filter for surface roughness analysis. The control allows the user to adjust a 
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slider bar or directly type a filter cut off value into the text box 
corresponding to that filter.

• Low Pass – The Low Pass filter control allows the user to turn on and off a 
filter for surface waviness or curvature analysis. The control allows the user 
to adjust a slider bar or directly type a filter cut off value into the text box 
corresponding to that filter.

• Polynomial Filter: The Polynomial filter control allows the user to turn on 
and off a polynomial filter. When this filter is turned on, it finds step, 
removes the step from the data, ensures a low frequency fit to the data, 
removes the low frequency noise, and then re-creates the step. 

Cursor Control – The Cursor Control arrows allow the user to move the cursors or 
widen the cursors in small increments

• R – This button activates the arrow controls for the Reference cursor

• M - This button activates the arrow controls for the Measurement cursor

• Right/Left Arrow Buttons – Left and right arrow buttons move the 
designated cursor to the right or left respectively each press of the button by 
the mouse cursor. The cursors do not move continuously if the button is held 
down.

• Up/Down Arrow Buttons – The up and down arrow buttons allow the user to 
widen or contract the designated cursor width for the Averaging Mode used 
in leveling the data.
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6.3 Leveling the Profile

If a surface to be measured is not parallel to the scan motion, the resulting trace is 
not be in level, causing inaccuracies in the analysis of the data. The Alpha-Step 
Development Series profiler provides two methods for leveling a profile:

• Software Leveling: The software has four methods of leveling. The user can 
manually level the data after a scan or the leveling can be set in the Setup 
parameters Auto Features tab to automatically level the profile by user 
specified parameters. The different software leveling methods are described as 
follows. Hardware leveling should be considered first to minimize software 
leveling artifacts.

• Mechanical Leveling: Mechanical leveling is discussed in Chapter 5, “Manual 
Stage Leveling,” on page 77.

The Leveling cursors are used to define the data set used in the leveling operation. 
After a scan the Data Display window is displayed with displaying the profile and 
cursors located at the default locations. After a scan the data is as shown in 
Figure 6-13.

Figure 6-13 Data Display Window with Unleveled Profile
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Before data analysis is attempted, it is often necessary to perform the leveling 
operation described in this section.

The data to be leveled using a linear rotational transform, which maintains the 
lateral positional accuracy. The baseline to be set using the average of the Z data 
contained within the R and M cursors.

To manually level a profile

1. Drag the R (reference) pointer to the location on the profile that you wish to 
be the baseline for any measurement.

2. Use the mouse cursor, drag the M (measurement) pointer to the second 
location you wish to be the baseline for any measurement.

3. Click Level Data located in the Level Method box. 

NOTE

Ensure that the Cursor Location radial button is active before leveling the data.

4. If desired, to undo the leveling use the mouse to click Reload Raw Data.

Figure 6-14 Profile After Leveling
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Average Mode

The Leveling cursors can also be used in Average Mode. We define this mode as 
when the user expands the cursor width to include more of the profile data for use in 
leveling. Instead of a single vertical line, each cursor can be expanded to cover a 
section of the profile. When the cursor is expanded, a red shaded region represents 
the section of the profile that is included for averaging. Each cursor can be expanded 
separately and can have a different width. The values within this band are then 
averaged together and treated as a single point for the leveling calculation.

Figure 6-15 Average Mode for Leveling Profile (Demo)

Figure 6-15 shows leveling of a profile where there are many sections that could be 
chosen but a single point would not be repeatable.

To level the profile in Average Mode using the mouse control:
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1. Using the mouse, drag center line of the R (reference) pointer to the location 
on the profile that you wish to be the baseline for any measurement.

2. Using the mouse, drag the center line of the M (measurement) pointer to the 
second location you wish to be the baseline for any measurement.

3. Using the mouse, drag the hashed edge of the right or left side of the R 
pointer. Move the mouse to the right or left to expand or contract the area 
used for the Averaging Mode.

4. Using the mouse, drag the hashed edge of the right or left side of the M 
pointer. Move the mouse to the right or left to expand or contract the area 
used for the Averaging Mode.

5. Reposition the two R and M cursors, if necessary, to fine adjust the scan data 
you wish to use for leveling.

6. Click Level Data located in the Level Method box.

NOTE

Ensure that the Cursor Location radial button is active before leveling the data.

7. To undo the leveling, if desired, click Reload Raw Data and the software 
re-displays the profile as it was before leveling.

Using the Average Mode with the Cursor Control

1. Choose the R or M cursor button in the Cursor Control at the bottom right 
of the Data Display window. This activates the arrow keys for either the R 
or M cursor.

2. Use the mouse cursor and Alpha-Step on the up or down arrow key to 
expand or contract the designated cursor respectively. A single push of the 
button widens or narrows the cursor one pixel in the chosen direction. The 
button must be pushed each time to change the cursor rather than holding the 
button down continuously.

Auto Level - Fixed and Step

The Alpha-Step Development Series profiler software has two Auto Level features 
available to the user. Both of these leveling methods, Auto Level-Fixed and Auto 
Level-Step are defined in the Setup parameters Auto Features tab with user 
specified parameters (refer to Chapter 4, “Description of Features,” on page 23).

Auto Level-Fixed
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1. Choose the Auto Level-fixed radial button in the Leveling Method box.

2. Press the Level Data Button, the profile is leveled using the predefined 
cursor positions set in the Auto Features tab found in the Setup Control 
Panel.

Auto Level-Step

1. Choose the Auto Level-Step radial button in the Leveling Method box.

2. Press the Level Data button. The profile is leveled using the Step Detect settings 
set in the Auto Features tab found in the Setup Control Panel.
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6.4 Measuring Profile Features

After the profile has been leveled, the data is ready for critical examination. 
Following are the instructions for how to use the Alpha-Step Development Series 
profiler software features to make measurements on a profile.

Positioning the Cursors

The R and M cursors are also the measurement cursors. The user controls the 
cursors in the same manner as described in the leveling section above. The user can 
move the R and M cursors in one of two ways, using the mouse to position the 
cursor, or by using the Cursor Controls arrow keys in the Data Display window.

Positioning the Cursors for a Measurement using the Mouse

1. Move the pointer over the R cursor then drag the R cursor to the location on 
the profile that you wish to be the reference point.

2. Move the pointer over the M cursor and drag the M cursor to the location on 
the profile that you wish to be the second location measured relative to the 
reference point.

3. The Data Display shows the difference in Z and X position between the R 
and M cursors at any given time. The user can read these values from the 
Cursors control box (only for the main, red cursors) to get the height of a 
profile feature or the lateral distance of a profile feature.

Positioning the Cursors for a Measurement using the Cursor Control

1. Choose the R or M cursor button in the Cursor Control at the bottom right of 
the Data Display window. This is activates the arrow keys for either the R or 
M cursor.

2. Use the mouse cursor and click the right or left arrow key to move the 
designated cursor to the right or left respectively. A single push of the button 
moves the cursor one pixel in the chosen direction. The button must be 
pushed each time to move the cursor rather than holding the button down to 
move the cursor.

3. The Average Mode is available to the user for making a measurement as well 
as for use during leveling. It operates in exactly the same way as described in 
the Leveling section above.
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Using the Average Mode using the Mouse control

1. Position the cursors as explained in the “Average Mode” on page 99.

2. Move the mouse cursor to the right boundary of the M cursor, drag the 
pointer and expand it to a desired width.

3. Move the mouse cursor to the right boundary of the R cursor, drag the 
pointer and expand it to a desired width.

4. Position the M cursor on the step height or feature you wish to measure. The 
value is displayed in the Cursor Display box.

Using the Average Mode with the Cursor Control

1. Choose the R or M cursor button in the Cursor Control at the bottom right of 
the Data Display window. This is activates the arrow keys for either the R or 
M cursor.

2. Use the mouse cursor and click the up or down arrow key to expand or 
contract the designated cursor respectively. A single push of the button 
widens or narrows the cursor one pixel in the chosen direction. The button 
must be pushed each time to change the cursor rather than holding the button 
down continuously.

6.4.1 Reading the Cursor Data

Figure 6-16 Control Panel Tab Showing Cursor Data

NOTE

The profile is displayed and distorted by a much more sensitive scale on the 
vertical axis than on the horizontal axis. Do not try to estimate angles from the 
screen because angles that displayed to be significant on the screen might not 
be. There is a calculation feature in the software that calculates the angle or the 
slope for a section of the Chapter 4, “Calculation Settings,” on page 45.
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The position of the measurement cursors is defined by the bold center line of each 
cursor with the intersection of the profile. If Averaging Mode is being used, the 
features to be measured from the cursor center-line and not from one of the edges.

As you move the cursors, measurement data is continually updated in the Cursor 
Box to the upper right of the profile graph. The following values are displayed in the 
Cursor Box:

X: (millimeters) Horizontal position of the mouse cursor along the scan axis.

Z: (Angstroms) Vertical position of the mouse cursor along the height axis.

R: Reference cursor information

X: Horizontal position of the reference cursor along the scan axis.

Z: The height of the profile at the intersection of the reference cursor and the scan.

W: Width of the R cursor shaded region

M: Measurement cursor information

X: Horizontal position of the measurement cursor along the scan axis.

Z: The height of the profile at the intersection of the measurement cursor and the 
scan.

W: Width of the M cursor shaded region

Delta Width: Horizontal (X) distance between cursors (in Average Mode, the 
horizontal distance between the center-line of the two cursors).

Delta Height: Vertical (Z) distance between profile intersections of the R and M 
cursors (in Average Mode, the vertical distance between the average values of 
height within the two averaged regions).

To select the units for the cursor data display, select Units from Settings drop-down 
list. You can change the scan display units in either metric or English units. The 
scale controls allow the X-Y scaling to be set separately from the Z scale. For more 
information about unit setup, refer to Units on page 30.
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Adding Additional Cursors

Additional cursors can be added to the Data Display window allowing multiple 
feature measurements. Each additional cursor set is displayed in a different color. 
Up to four additional cursor pairs can be added for a maximum of five cursor pairs 
in the display. The additional cursors make the calculation measurements on the 
section of the profile between the Matching R and M cursors.

Figure 6-17 Data Display Window with Multiple Cursor Pairs

NOTE

Only the Red Primary Cursors can be used to level the profile. The added cursor 
pairs are used in the calculations only. Each cursor pair has different color.

To add additional cursors

1. From the Data Display window right-click to open the functions menu.

2. Select the Add Cursor option.

3. A new set of R and M cursors are displayed in the Data Display window.

To add additional cursors, repeat the above directions. The cursors can be sized and 
moved the same as the initial R and M cursors.
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Figure 6-18 Data Display with Zoom Box for Data Zoom

Data Zoom in the Data Display window

There are multiple Zoom options available to the user. You can use the In function 
or the Window function to activate a zoom box in the Data Display window.

Zoom In - Is reducing the horizontal display by 50%. The Zoom In function can be 
used repeatedly to visualize smaller features and see higher resolution information.

Figure 6-19 Data Zoom in the Data Display window

Zoom window - Displays a green box in the Data window. The user can position the 
box over any part of the profile, expand or shrink the box and re-display the data set 
contained in the box expanded in the Data Display window. After the area of 
interest is chosen, right-click to redraw the zoomed area in the Data window or 
Cancel the operation all together.
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Following is a brief tutorial of how to use the Zoom functions with figures for 
clarification.

To use Zoom In

1. From the Data window, right-click to open the Alternative drop-down list.

2. Use the cursor to select the Zoom options; this displays the Zoom 
drop-down list.

3. Click In option.

To open the Zoom Box

1. From the Data window, right-click to open the functions menu.

2. Select the Zoom option to open the Zoom drop-down list.

3. Click Window. A green Zoom box is displayed in the Data Display 
window.

To reposition the box

1. Position the mouse cursor inside the Zoom box.

2. Click and hold the mouse button, a four arrow cursor is displayed.

3. Move the mouse to reposition the Zoom box over a section of the profile you 
wish to magnify.

4. Release the mouse button.

5. Right-click to Zoom. The boxed data set is expanded in the Display screen.

6. Repeat the above steps to Zoom into another feature of interest.

To display the Zoomed Data

1. While the zoom box is active in the Data window, right-click again to open a 
menu to accept or cancel the zoom area.

2. Select the Zoom option to display the new magnified view of the profile 
section.
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6.4.2 Calculation Setup

A number of physical parameter calculations such as step height, slope, angle, 
radius, roughness parameters and so on are available in Data Analysis tab.These 
results are computed for either the specific Data window or globally for all the open 
Data windows. 

You can make calculations on Raw profile data, Low pass filter for Waviness 
calculations and the High pass filter for Roughness calculations. For details about 
the calculation settings, refer to Chapter 4, “Calculation Settings,” on page 45.
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6.5 Scaling Data

The Graph Setup window allows the user to set the display axis for profiles. In cases 
where various profiles need to be compared directly it is easier to make the 
comparison using identical axis scales. This tool allows the user to choose the scale 
for data display needed for easier comparison. The default setting is Auto Scale in 
both X and Z.

Figure 6-20 Graph Setup Window

To display the Graph Setup window

1. From the Data Display window, right-click to open a drop-down list.

2. Select Set Graph Scales and the Graph Setup window is displayed.

To change the Scale

1. Deselect the check boxes for Auto Scale.

2. Type a number in the X Maximum field.

3. Type a number in the X Minimum field.

4. Type a number in the Z Maximum field.

5. Type a number in the Z Minimum field.
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NOTE

If the user would like to use the new graph scale values for more than one scan, 
select the Use these values as defaults check box. Otherwise the graph scales 
can be set to the default auto scale for any additional scans.

6. Click Ok to apply the new settings and close the Graph Setup window.

6.6 Data Analysis Tab

The Data Analysis tab is where the calculation results are displayed. The tab can be 
set to a window as described in the previous section (Chapter 4, “Scan Parameter 
Tab,” on page 42). The Data Analysis tab presents the calculation results for any 
Data windows that are displayed. If the user selects to calculate for the active Data 
window, then only the results for that window are presented. A tutorial for making 
calculations on a single Data window or with multiple Data windows is given as 
follows.

Figure 6-21 3 Profiles loaded in Data Display Window

Figure 6-21 shows the results for a single data window with 3 profiles loaded. The 
average and standard deviation are also displayed with the results.
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6.6.1 Data Analysis Tab Features

Tool Bar Description

Figure 6-22 Tool Bar Description

Save – Opens the standard Save dialog box. The results are saved as a text file.

Print – Opens the standard Windows Print dialog box to choose a printer. The 
action prints the results in a table form.

Copy – When the user highlights any of the rows, columns, or cells of the results, 
clicking Copy saves a copy to the Windows clipboard.

Export All – Pressing this button exports all the information in the Data Display tab 
and Scan Parameters tab in csv format. It also records current time, tool and 
operator information.

Select All – Pressing this button causes the software to highlight all the rows and 
columns in the Data Display tab making it easy to then copy or export the values to 
another program like a spreadsheet.

Help – Opens the help files for the Alpha-Step Development Series profiler 
application.

6.6.2 Using the Data Analysis Tab

After the user selects the parameters in the Calculations window and chooses to 
analyze the profile, the results are presented in the Data Analysis tab. The software 
calculates the selected parameters between the R and M cursors. If additional 
cursors are used, the results for each of these cursor sets are displayed with the 
corresponding color of the cursor in the Data Analysis tab as well. There are several 
ways to open the Data Analysis tab.

NOTE

To open the Analysis tab with any of the methods described in the followings it 
requires the user to have selected at least one parameter in the Calculation 
Control.
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To display the Data Analysis tab from the Data window

1. From the Data window, select the Tools drop-down list.

2. Click Data Analysis.

3. The software calculates the selected Calculation parameters set in the 
Calculations window.

To display the Data Analysis tab from the Application window

1. From the Application window, select the Tools drop-down list.

2. Click Data Analysis.

3. The software calculates the selected Calculation parameters set in the 
Calculations window.

In the case where multiple Data windows are open and the user wishes to display 
results for all of the open windows:

1. From the Application window, select Data Analysis from the toolbar.

2. The software calculates the selected Calculation parameters set in the 
Calculations window.

NOTE

The Data Analysis tab displays the Average and Standard deviation of the 
parameter results from all the profile data from all the open Data windows.
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6.7 Saving and Exporting Calculation Results

The Alpha-Step Development Series profiler Application has several ways the user 
can save and export Analysis Results. In all windows, tabs and the Application 
windows, the user can use standard Microsoft Copy and Paste functions to the 
Clipboard to then enter results, graphics and annotations to a spreadsheet or other 
presentation software.

In this section we can discuss how to use the Application features to save or export 
analysis results.

6.7.1 Printing Calculation Results

After you have displayed the Results window, by using the Calculate Results 
feature, these results can then be printed.

1. Select Print in the Results window.

2. The software displays the Windows Printer dialog box for your default 
printer.

3. Click OK or the press ENTER to print the results.

4. Close the Results window to return to the Data Display window.

6.7.2 Printing the Profile

1. From the Data Display window, click the File drop-down list.

2. Click the Print menu. The Printer dialog box is displayed.

3. Select Print or press ENTER to print.

6.7.3 Printing using the Screen Capture Function

The Alpha-Step Development Series profiler software supports the Microsoft 
Operating System Print Screen function. This feature allows the user to capture a 
screen image of the current monitor screen view or of the active window view and 
save the image to the clipboard. The user then can paste the screen capture image to 
any graphic program or word processor program that accepts the format.
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6.7.3.1 Full Screen Capture

1. After you have displayed the profile, Results, or any part of the Alpha-Step 
Development Series profiler software, simultaneously hold down the 
PRINT SCRN.

2. The monitor screen view window is saved to the Clipboard.

3. Use the Paste function to place the Clipboard image into a word processor or 
graphics editing program (CTRL-V).

4. The image is copied into the open word processor or graphic program.

5. The image is ready to make any annotations, captions, or include in a 
presentation.

6.7.3.2 Active Window Screen Capture

1. After you have displayed the profile, Results, or any part of the Alpha-Step 
Development Series profiler software, simultaneously hold down the 
CTRL-ALT-PRINT SCRN keys.

2. The Current window is saved to the Clipboard.

3. Use the Paste function to place the Clipboard image into a word processor or 
graphics editing program (CTRL-V).

4. The image is copied into the open word processor or graphic program.

5. The image is ready to make any annotations, captions or include in a 
presentation.

6.7.4 Saving Data

From the Main Software window

1. Click the File drop-down list in the top left corner of the screen.

2. Click Save Data File. A dialog box is displayed.

3. Type the name of the file you want to save in the dialog box and press 
ENTER.

From the Data Display window

1. Click the File drop-down list in the top left corner of the Data Display 
window and click Save As.

2. Enter the file name to save in the Save As dialog box and press ENTER
114 D-500 & D-600 User Manual KLA-TENCOR CONFIDENTIAL -- RESTRICTED DISTRIBUTION # 9019320-000 Rev. AC 



Chapter 6–Working with 2D Profiles 
6.8 Software Filter Settings

The Alpha-Step Development Series profiler software enables you to separate the 
waviness and roughness components of your data by selecting a Cut Off Filter. The 
filter controls are located on the Cursor tab. The Filters provide an adjustable short 
wave cutoff filter allowing you to isolate wavelengths. The cut off filters are:

• Short wavelength filter cut off, known as High Pass

• Long wavelength filter cut off, known as Low Pass

Besides, this a Polynomial Filter is provided, which removes the low frequency 
noise and improves the step height repeatability

6.8.1 Using Cutoff Filters

The software Band Pass Filters are controlled by the user choosing a cut off value. 
This cut off value is then used in the High Pass or Low Pass filter algorithm. The 
filtered data is displayed in a different color to the raw profile data. The user can 
choose to display only the filtered data, both the filtered data and the raw data, or 
only the raw data using the radial buttons in the lower right corner of the Data 
Display Window. A description of setting the software filters is given as follows.

Figure 6-23 illustrates the isolation of the roughness on the surface of the bump 
from the curve. The orange profile shows the High Pass filter and the olive green 
profile shows the Low Pass filter. Original profile is shown in black.

Figure 6-23 High Pass and Low Pass Filters
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Select the High Pass filter, Low Pass filter or both filters, click the corresponding 
check box. Checking a Filter box displays a colored profile of the filtered scan data 
in the Graph Display that matches the color box to the right of the filter type Check 
Box (see Figure 6-17).

To adjust the Cut Off Filter Level

Use the mouse to highlight the number in the filter cut off text box for the filter type 
you are using. Type a number into the text field and press the ENTER to recalculate 
the filter value and refresh the profile display.

-or-

Drag the pointer on the slider bar and move the slider right or left to adjust the cut 
off value of the filter.

The number displayed in the text box is the length value that the High Pass or Low 
Pass filter in use to calculate the filtered profile. Using a larger number for the Filter 
Cut Off value can correlate to larger features being filtered, which also corresponds 
to lower frequencies. Using a smaller number value in the Filter Cut Off value can 
correlate to smaller features being filtered, which also corresponds to higher 
frequencies.

6.8.2 Using Polynomial Filters

When Polynomial filter is enabled, it finds step, removes the step from the data, 
ensures a trinomial fit to the data, removes the low frequency noise, and then 
re-creates the step. The filtered data is displayed in green while the raw profile data 
is in black. This filter improves the step height repeatability.

6.8.3 Using Step Fit

This function is located on the Data Control panel, rather than the Cursor Control 
tab. When it is enabled, the data is fit with a periodic rectangular profile that slopes 
linearly up or down. The output parameters for Period step are: Period, Duty Cycle, 
and Height. The duty cycle is expressed as the ratio of the length of the high 
segment of the period to the length of the low segment. The goodness-of-fit criterion 
used in the curve fit is the least absolute error, not the least squares error. The 
Periodic Step fitting algorithm produces meaningful results only if it is applied to 
section data that has a truly periodic contour, or if it is applied to single surface step, 
which can be interpreted by the software as a segment of a longer periodic contour.
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Chapter 7–Advanced Features
7.1 Introduction

This chapter describes the advanced features available in the Alpha-Step 
Development Series profiler Application software. The chapter gives a tutorial to 
guide the user through setting up and using these advanced features.

NOTE

3D scanning and Sequence Scans are only available for D-600 which has the 
motorized stage.

7.2 3D Scanning

3D scanning enables measuring the topology of an area with many individual scans. 
The individual scans are combined together to form a 3D image. The data for 3D 
scanning is saved as an .AMB file and can only be viewed in the Off-Line software 
Apex. 3D scanning is for the Alpha-Step D-600 profilers only.

7.2.1 Setting up and Running a 3D Scanning

1. Select the Scan Parameters tab.

Figure 7-1 Scan Parameters Tab

2. Set up the scan parameters for the individual scans including scan Speed, scan 
Length, Profile type, scan height Range, scan Direction, Stylus Force and 
Filter Level. Refer to “Chapter 4, “Scan Parameter Tab,” on page 42 for the 
definition of these parameters.

3. Select the 3D option to enable the 3D scanning.

4. Type the Width of the scan area
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5. Type the number of Traces of the 3D scan. If either the value for Width or 
Spacing is changed, the traces are updated automatically.

6. Type the Spacing between the traces. If the value of the number of traces is 
changed, the spacing is updated automatically.

7. Click Scan in Video Capture to start the 3D scan. A pop-up window is displayed 
to select a directory and enter a file name for the 3D scan.

8. After the scan is finished, the result is saved in the selected directory. At the 
same time, Apex automatically starts and opens the 3D result. If Apex is already 
open and has data inside, the new 3D result appends at the end of the Apex file.

To save or load the 3D recipe, it is performed the same way as explained in 
Chapter 4, “Using Scan Recipes,” on page 52.

7.2.2 Viewing a 3D Data File

Viewing a 3D file requires using a third party software package, Apex, sold with the 
3D option. After a 3D scan finishes, the computer saves the 3D data as .AMB file, 
and at the same time, automatically opens Apex and sends the result to Apex. Apex 
can be also used to analyze saved 2-D or 3-D Data.

1. Double-click the Apex icon on your desktop or start the program from the 
Windows Start menu.

2. Select the File drop-down list or use the Open a Studiable icon on the tool 
bar of the Apex software screen.

3. Navigate to the Data folder, or the folder that the 3D file you are interested 
in viewing is located.

4. Select the file you want to open and the 3D top view of the data is displayed 
in the window.

5. Click Open.

6. The data is displayed in Apex.
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7.3 Sequence Scans

Sequence scanning is available for Alpha-Step D-600 profilers only. It enables the 
user to take advantage of the motorized stage to program multiple 2-D or 3-D 
measurements to make statistical measurements on a sample. The saved sequences 
have file extension of .seq or .stp.

7.3.1 Sequence Control Panel

Figure 7-2 Sequence Control Pane

Recipe

Sequence – This button opens the saved Sequence Recipes folder from which an 
already saved sequence recipe can be loaded for use. The name of the loaded 
sequence is displayed in the box next to the sequence button. If a new sequence 
recipe is built and saved, the sequence name is also displayed in the box next to the 
sequence button.

Scan - This button opens the saved scan Recipes folder from which an already saved 
scan recipe can be loaded for use in the sequence scan. When a sequence recipe is 
loaded, the associated scan recipe is automatically loaded. The user can change the 
scan recipe used in the recipe by loading a new scan recipe. The scan recipe name is 
displayed in the box next to the scan button.

Clear – This button clears or sets all the fields to default values in the Sequence 
Control Pane.

Save – This button saves the changes made to the current sequence. This button is 
disabled if the sequence is new. If any change is made to a loaded sequence recipe, 
the user must first save the recipe to run the sequence.

Save as – This button opens a window to ask the user to save the current parameters 
in the Sequence pane as a new sequence recipe in a user defined folder.
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Deskew

Mode – There are two modes for Deskew: No deskew or single site deskew. The 
default is No Deskew. If No Deskew is selected, the sequence scan is directly 
executed with the sites list. If single site deskew is selected, all the scan sites are 
recalculated during the sequence scan with respect to the adjustments to the deskew 
site:

• Adjust X: if this is selected, the X-coordinate of the deskew site is used as the 
X-coordinate of the first scan site, and the X-coordinate of all the other sites are 
adjusted the same way as the first site.

• Adjust Y: if this is selected, the Y-coordinate of the deskew site is used as the 
Y-coordinate of the first scan site, and the Y-coordinate of all the other sites are 
adjusted the same way as the first site.

Steps to do a sequence scan with Deskew function enabled:

1. Active the Sequence Control pane, load or setup a sequence recipe.

2. Click Start, under Run Mode to start the sequence recipe.

3. After selecting the folder and entering the file name to store the data, with 
the popup window, the Deskew function is displayed at the bottom of the 
Control Pane.

Figure 7-3 Deskew Confirmation Function in Control Pane

4. The stage then moves to the first scan site, focuses on the sample and then 
lifts up the stylus.

5. Navigate the sample to a new location that is the deskew position for the 
Sites List.

6. Click OK, see Figure 7-3, to accept the current stage location as the Deskew 
site. Then the sequence scan starts.

-or-

7. Click Cancel to quit the Deskew function. Click Stop, under Run Mode to 
stop the sequence scan or move the stage to a new location and the Deskew 
function is available again.
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Coordinates

Instrument – All the coordinates in the Sequence pane use the instrument as the 
reference. The 0,0 of the coordinate is the home position of the X-Y stage.

Sample - All the coordinates in the Sequence pane use the Sample reference. The 
0,0 of the coordinate is the center of the sample chuck.

Stage

Units - The user can select the units for display for the X- and Y-values in Sequence 
Control Pane. The default units are in Millimeters, the other choice is Inches. 
Toggling the units automatically re-displays all X, Y values in the sequence control 
pane in the new unit type.

Position – During the stage movement, the X- and Y-values display the stage 
position and are updated simultaneously as the stage moves. The user can also input 
new coordinates in the X and Y text boxes by clicking Move, and then the stage 
moves to the input position. If the user simply inputs new coordinates without 
clicking Move, the input values are kept until the user changes it or the stage moves.

Sites

Sites Table – This shows the sites used for the sequence scan. If the Mode is 
Discrete, the user can modify the X-Y coordinate of any selected site individually. If 
the Mode is Matrix, only the first X-Y site value is editable, and the sites coordinate 
in the sites list can be updated with the first X-Y site coordinate together with the 
parameters in Matrix Mode.

Add – For Discrete Mode, this adds a new site to the Sites Table next to the selected 
site in the Sites Table. The new added site uses the current stage coordinates as its 
X-Y coordinate. For Matrix Mode, the Add function is creates a new Sites Table 
with the current stage coordinate as the first site coordinate together with the 
parameters in Matrix Mode.

Goto – Selecting a site in the Sites List and clicking GoTo drives the stage to the 
selected site.

Delete – If the Sites Mode is discrete, the Delete button deletes the selected site 
from the Sites List. If the Sites Mode is Matrix, clicking Delete is deleting all the 
sites: a window is displayed telling the user the sequence is a matrix and asking 
whether the user wants to delete all the sites.

Mode - This defines the sequence to be Matrix or Discrete sequence with the 
drop-down selection.
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• Discrete - If this is selected, the sequence can be a discrete sequence. All the 
following parameters Mode can be disabled, and the user can add or edit any site 
individually. If the Sites Table is created using Matrix Mode, changing Mode 
from Matrix to Discrete keeps these sites.

• Matrix - This defines the Sites list is in a Matrix type. Changing Mode from 
Discrete to Matrix is creates a new Sites Table with the first available site 
together with the parameters in Matrix Mode.

• Rows (Y) - The user needs to define the number of rows and the pitch between 
the adjacent rows for the Sites matrix.

• Columns (X) - The user needs to define the number of Columns and the pitch 
between the adjacent columns for the Sites matrix.

• Stitch -This option can be available only when the scan recipe is a 2-D scan 
recipe. If this option is checked, the tool can scan up to ten individual scans and 
then stitch the profiles together to form a long profile. In this way, the scan 
length can be extended to full 200 mm, instead of 55 mm scan length for a single 
scan. If the scan length of the 2-D Scan Recipe used in the Sequence is bigger 
than the input pitch size, there can be some overlap of two consequent scans, and 
the overlapped region can be used to stitch. If the scan length is bigger than the 
pitch size, there is no overlap between consequent scans. The individual profiles 
are simply added together to form a long profile.

• Populate - If there is no site in the Sites table, this creates the matrix sites list 
using current stage coordinates and Matrix parameters. If there are sites in the 
Sites table, this is updating the sites table using the first site in the Sites table and 
the Matrix parameters.

Run Mode

Start – Clicking this button executes the sequence scan. A displayed window is asks 
the user to select the folder and input file name to store the sequence files. If any 
change is made to the Deskew or the Sites List in the sequence recipe but not saved, 
an error message is displayed and ask the user to save the recipe before running it.

Stop – This button stops the sequence execution and is only available after the 
sequence scan has started.

Site – During the sequence scan, this shows the user the current scan sites number 
relative to the total sites number.
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7.4 Stitch Pre-Saved Data

The stitch option in the Sequence Pane stitches the data during the Sequence Scan. 
There is another stitch feature under Tools Functions that enables the user to stitch 
scan data any time. These scan data do not need to be from the sequence scan. This 
feature allows the user to stitch the scan profiles after the scan finishes. The 
individual profiles that are stitched together must have the same data resolution or 
the software is not be able to combine them and an error message is displayed.

7.4.1 Opening the Stitch feature

To start the Stitching feature from the Main software screen:

1. With the mouse cursor, select the Tools drop-down list at the top left corner 
of the Main software screen.

2. Select the Stitch option.

The Stitch control panel is displayed.

An alternate method for starting the Stitch feature:

1. From the Main software screen, press the ALT + T keys to open the Tools 
drop-down list.

2. Press S to open the Stitch function.

To start the Stitching feature from the Data Display window:

1. With the mouse cursor select and click the Tools drop-down list at the top 
left corner of the Data Display window.

The Stitch control panel is displayed.
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7.4.2 Stitch Control Panel Description

Figure 7-4 Active Stitching windows

Stitching – This panel allows the user to add multiple profiles together to make a 
single larger profile up to 400,000 data points. The profiles being added must have 
the same data point spacing though they do not need to have the same length.

Base Profile – This button opens a Load Data window. The user selects the profile 
for the base or first profile to which the other profiles can be added. The data file is 
loaded into the software.

Append Profile – This button opens a Load Data window. The user selects the 
profile that can be added to the end of the base profile. The two data files are loaded 
into the software.

Stitch Button – This button runs the algorithm to add the Appended profile to the 
Base profile or the previously combined profiles if more than two profiles are being 
added together.
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Figure 7-5 Data window with Stitched Composite Profile

Figure 7-5 shows the Data window with a stitched composite profile after adding 2 
of the same profile end to end.

7.4.2.1 Stitching

1. Open the Stitch Control Panel.

2. Press the Base Profile button to load the first profile. A Load Data window 
is displayed.

3. Choose a profile that is the first profile of the composite profile and click 
OK to load the profile data into the software.

4. Click Append Profile in the Stitch control panel. The Load Data window is 
displayed.

5. Select the profile that is the second profile in the composite profile and click 
OK to load this profile data into the software.

6. Select Stitch on the control panel. This adds the second profile onto the end 
of the first profile loaded as the Base Profile.

7. Repeat step 5 and step 6 for each additional profile you wish to stitch 
together. The software allows up to five profiles to be stitched together.

8. After you have finished loading and stitching all the profiles together, click 
OK to close the Stitch Control Panel.
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7.4.2.2 Displaying the Stitched Profile

From the Main software screen:

Click Analysis to open the Data Display window. The composite profile is 
displayed in the graph area.

From the Data Display window:

The composite profile is displayed in the Data Display after closing the Stitch 
Control Panel.

7.4.3 Multiple Scans

The Alpha-Step Development Series profiler software allows the user to display up 
to 10 profiles overlaid in a single Data Display window. The profiles must all have 
the same number of data points and the same scan length to be displayed together. 
This feature is designed to operate closely with the Stepping feature so the user can 
load many profiles simultaneously and compare them. Additionally, loading 
multiple files improves the instrument efficiency by allowing the operator to make 
measurements more quickly.

7.4.3.1 Using the Multiple Scan Feature

At the top of the Data Display window is a File Name box. Each profile loaded into 
the software has a color associated with it. This box shows the file names of the 
profiles loaded into the software and a color square that matches the color of the 
profile in the Data Display graph. The profile displayed at the top of the File Name 
drop-down list is defined as the Profile in Focus. Only the profile in Focus can be 
analyzed with the cursors and calculations results presented. The user can select a 
different profile at any time and choose a calculation without having to realign the 
cursors or change the setup. The procedure is described as follows:
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Loading Multiple Data Files

1. With the mouse cursor select the File drop-down list at the top left corner of 
the Data Display window.

2. Select the Load Data File option. The Load Data window is displayed.

3. Go to the data folder of interest and select the first file you wish to load by 
clicking once to highlight the file.

4. Loading consecutive and non-consecutive data files:

To load consecutive data files, hold the SHIFT at the same time as you 
click the last data file you wish to load. All the files in between the first 
and last file selected are highlighted.

To load non-consecutive files, hold the CTRL at the same time as you 
click a file. This highlights that file and allows you to also select and 
highlight additional data files.

5. Press the Open button to accept the choices. The Load Data window is 
closed and the selected profiles are loaded into the Data Display window.

NOTE

Up to 10 profiles can be loaded at one time. All of the Data files must have the 
same scan parameters or an error message is displayed. Clicking on the error 
message box closes the message and the data file is skipped from loading. All 
the data files chosen are loaded in the order they are displayed in the data folder 
alphabetically. The data files must all match the first file loaded.
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Adding Additional Profiles to the Data Display window

1. Click the File drop-down list at the top left of the Data Display window.

2. Click the Add Data File option. The Load Data window is displayed.

3. Go to the data folder of interest and select the first file you wish to load by 
clicking once to highlight the file. If you are only adding 1 data file, skip to 
step 5.

4. Loading consecutive and non-consecutive data files:

• To load consecutive data files, hold the SHIFT at the same time as you 
click the last data file you wish to load. All the files in between the first 
and last file selected are highlighted.

• To load non-consecutive files, hold the CTRL at the same time as you 
click a file. This highlights that file and allows you to also select and 
highlight additional data files.

5. Press the Open button to accept the choices. The Load Data window is 
closed and the selected profiles are loaded into the Data Display window.

NOTE

Up to 10 profiles can be loaded at one time. All of the Data files must have the 
same Setup parameters or an error message is displayed. Clicking on the error 
message box, closes the message and the data file is skipped from loading. All 
the data files chosen are loaded in the order they are displayed in the data folder 
alphabetically. The data files must all match the first file loaded.

Removing a Profile from Data Display window

The user can only remove one profile at a time. The software always removes the 
data file that is in Focus, the data file displayed in the Filename text box.

With the mouse cursor select the File drop-down list at the top left corner of the 
Data Display window, and click.

Click the Remove Data File option. The data file displayed in the Filename text box 
is removed from the Data Display window.
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7.4.3.2 Using the Calculations for Multiple Profiles

Calculation results are only displayed for the profile in Focus. To view calculations 
on one of the profiles loaded into the Data Display window, that profile must be 
chosen as the Focus data.

The illustration in Figure 7-6 displays the file name drop-down list of the data files 
loaded in the data display window. The file name highlighted is the profile in focus.

Figure 7-6 List of Data Files loaded into Data Display Window

Changing the Focus of a Profile

With the mouse cursor, select the File Name drop-down list at the top left of the 
Data Display software screen. This opens the drop-down list showing all the data 
files loaded into the Data Display window.

Click the data file, which you wish to have in Focus.

The chosen data file is displayed in the File Name text box with its corresponding 
color box displayed. Now this profile is in Focus.
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7.5 Height Histogram

The Height Histogram sorts the Z data information into Bins (the user can control 
how many bins the data is sorted into), each bin contains a range of height data. 
Each data point in the profile is categorized into a bin. The Histogram plots the 
number of data points in each bin as a function of the Z range. The Histogram is a 
plot of the frequency of the Z data. The image on the screen is the only output of this 
feature.

Figure 7-7 Height Histogram in Data Display Active window

Left: histogram of an accurate step height with virtually no noise in the data
Right: histogram of a not well defined step height, the data peaks are spread 
showing the spread in the data

7.5.1 How to Use the Height Histogram

The Height Histogram can be used to make a statistically significant step height 
measurement. The height histogram is used to display the height distribution of the 
profile Z data. When operating on a step data set, for example, the histogram has a 
two peak distribution shown in Figure 7-7. One peak corresponds to the data points 
at one height (the substrate surface) and the second peak corresponds to the data 
points at the second height (the top of the step). The peak width is defined by the 
flatness of the feature. The more data points that have the same Z value, the taller 
the corresponding histogram peak and the narrower the peak. In the case of steps 
with significant surface roughness the peaks are broad. Viewing the data using the 
Histogram function allows the user to qualitatively determine the relative noise in 
the measurement and to quantitatively measure the step height using all of the data 
in the profile. Thus the user can make a statistically significant step height 
measurement. The following directions assume that you have already taken a scan 
and leveled the data.
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From the Data Display window

1. Click Height Histogram located in the bottom right corner of the Display 
window.

The Height Histogram window displays a default histogram with 250 bins.

2. In the Number of Population Bins field, choose the number of bins you 
wish to sort the data. Increasing or decreasing the number of bins changes 
the resolution and size of the histogram peaks respectively.

3. Click Apply. The window re-displays your data with the revised number of 
bins.

4. Click Close at the bottom of the window to close the Height Histogram 
window and return to the Data Display window.
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8.1 Introduction

This chapter provides information about configuring Apex 2D/3D to work with the 
Alpha-Step system.

8.1.1 License Agreement

• The copyright laws and international treaties, as well as other intellectual 
property laws and treaties protect the software product.

• The software product is licensed as a single product. Its component parts 
cannot be separated for use on more than one computer.

• You cannot reverse engineer, decompile, or disassemble the software 
product.

• The source code was designed and developed by Digital Surf and is the 
property of Digital Surf, France.

• Apex 2-D and Apex 3-D are trademarks of KLA-Tencor Corporation.
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8.2 Overview of Apex 2D/3D

8.2.1 Starting the Software

To start the software, click the shortcut on the desktop, or click Start > All Program 
Files > Apex 3D Advanced 7.3 > Apex 3D Advanced (64-bit version).

The program displays a document with the data set that is open in the Alpha-Step 
software. See Figure 8-1.

Figure 8-1 Empty Apex Document

8.2.2 Loading a Studiable

Studiable is a word that refers to all data (2-D profile, 3D surface) that can be 
studied and that can be stored in a file. Apex can load files from a large number of 
measurement instruments.Refer to www.digitalsurf.fr/en/mntformats.htm for more 
information.

Click Studiables > Load a Studiable, or click the Load a Studiable icon in the 
General toolbar.
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If 2-D data set is opened, the Profile Curve ribbon is active. If a 3D data set is 
opened the Pseudo-color view ribbon is available. See Figure 8-2.

Figure 8-2 General Toolbar
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Navigate to the Example Data folder in the installation directory of the software, 
and click Studiables. Select one of the .sur or .pro files, for example double-click 
Wafer back.sur. See Figure 8-3.

Figure 8-3 Example Data Directory

The .sur file extensions are 3-dimensional surface files, whereas .pro file extension 
are 2-dimensional profile files.

The studiable is displayed in reserve at the top left side of the document.
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8.2.3 Applying an Operator or Carrying out a Study

An operator is a mathematical operation that is applied to a studiable and generates 
one or more new studiables.

To apply an operator, click any Studiable (the border is displayed as a dotted blue 
line), and then click an operator from the Operators menu (for example Zoom, 
Level, Spatial Filtering, Remove form). See Figure 8-4.

Figure 8-4 Applying an Operator

A study is a graphical representation of a Studiable (for example, 3D representation 
of a surface) or an analysis done on a Studiable (calculation of the Ra parameter).

To apply a study, select any studiable, then select a study from the Studies menu. 
See Figure 8-5.

Figure 8-5 Carrying out a Study

For complete information on how to use Apex, go to the Help menu and click 
Reference Guide.
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Building an Analysis Document

Apex contains all the tools needed to build and lay out a complete Analysis 
Document in a straight forward way.

Figure 8-6 3D Representation of the Measured Motor Cylinder
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Figure 8-7 Measurement of the Angle and the Distance between Grooves

Figure 8-8 Extraction of an Oblique Profile
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Figure 8-9 Removing the Circular Form

Figure 8-10 Separating Roughness and Waviness
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The calculation is based on the Circular form removed profile curve.

A Gaussian filter of 0.25 mm is applied in the calculation.

Figure 8-11 Calculating Roughness Parameters

Ra (GS 0.25 mm) = 0.129 μm,  Rq (GS 0.25 mm) = 0.159 μm.
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Chapter 9–Thin Film Stress Module
9.1 Introduction

This chapter describes the Thin Film Stress software and gives a tutorial on how to 
use the module. Also, described in this chapter is the optional Wafer Stress Chuck. 
The Stress Module has an additional capability that allows the user to subtract 
profiles and save the new profile. This Difference measurement can be used for 
comparing profiles or subtracting a background noise floor. A description and 
tutorial is included in this chapter.

9.1.1 Overview

It is important to monitor thin film stress as thin film stress data can be used to 
reduce process variations. Stress is generated in the thin film and substrate during 
thin film deposition. The deformation of the thin film can be monitored by the 
bending, compressing, or expanding of the substrate (as evident by the curvature of 
the substrate and film).

With the Thin Film Stress Option, the Alpha-Step Development Series profiler can 
be useful to determine the stress levels in a deposited film by measuring the 
deflection or curvature that the stress induces in the substrate. The software 
determines the curvature of the sample by calculating the least square fit of the trace 
data to a circle. The equation for stress is as follows:

ó = [1/6R] [E/(1-õ)] [ts2/tf]

where:

E/(1-õ) = substrate elastic constant

E = Young's Modulus õ = Poisson Ratio

ts = substrate thickness; tf = film thickness

R = radius of curvature
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The software calculates the radius of curvature by using a least squares fit method. 
This result can be verified by using the following equation for radius of curvature R:

R = L2/8B if L>>B Where:

B = bow (maximum between the trace and its chord)

L = chord length (scan length)

The software uses manually entered values for:

ts (substrate thickness)

9.2 Thin Film Stress Window

Figure 9-1 Thin Film Stress Control Window

The Alpha-Step Development Series profiler software calculates:

The average stress derived from the least square fit of the entire profile

The center stress computed at the center third of the profile

Thin Film Stress – The Thin Film Stress option window might be opened from the 
Tools drop-down list on the Main software screen.

Load Post Stress File – This button opens a Load Data File window. The user can 
Browse to the data file containing the measurement data after processing.
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Load Pre Stress File – This button opens a Load Data File window. The user can 
Browse to the data file containing the measurement data before processing.

Elastic Constant – This field allows the user to choose from a drop-down list of 
common substrate elastic coefficients or to directly enter a value into the text field. 
All the values are assumed to be in units of GPa.

Wafer Thickness (mm) – This field requires the user to enter the known sample 
thickness in units of millimeters (mm).

Film Thickness (Angstroms) - This field requires the user to enter the known film 
thickness in units of Angstroms.

Results – After the user loads the data sets into the software and enters the proper 
sample information and presses the Calculate button, the stress results are displayed 
in the Results field.

Stress Type – The software uses the Stoke Model for calculating the stress based on 
the curvature of the profile. The results are categorized as either Compressive or 
Tension Stress types.

Average Stress (MPa) – This field displays the calculated average stress of the film 
on the substrate for the length of the profile data.

Center Stress (MPa) - This field displays the calculated stress of the film on the 
substrate at the center of the profile data.
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9.3 Using the Thin Film Stress Option

The software allows the user to compare pre- and post-processing profiles to 
determine the curvature caused solely by the process induced stress. If no 
preprocessing scans are available, the software allows the operator to make a wafer 
stress calculation on post-processing scans and assume the sample was perfectly flat 
prior to the stress inducing process. The post-process stress measurement is 
inherently less accurate than the difference measurement method.

It is important that the sample be measured in the same location and with the same 
scan sequence to produce accurate and repeatable stress measurements using the 
difference measurement method. To facilitate sample placement, a chuck adapter 
should be used for the most accurate and repeatable results. This adapter keys off of 
the standard chuck (supplied with the system) and provides sufficient positional 
accuracy.

NOTE

It is important that the scans taken for the Thin Film Stress Option be measured 
using identical setup parameters or software error might occur.

9.3.1 Saving Data

To re-compute and display a difference measurement, both pre- and post-stress 
profiles must be saved. Saving the profiles allows the user to recalculate the stress 
value using different parameters.

The pre- and post-stress profiles are saved using the same instructions as described 
in Chapter 5, “Basic Operation,” on page 55.

9.3.2 Taking a Pre-stress Scan

Pre-stress data displays a profile of the sample before the sample is stressed by 
processing. The data establishes a baseline for later comparisons.
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9.3.3 Saving and Loading a Scan Recipe/Sequence Recipe

To save a scan recipe/sequence recipe,

1. From the Main window, select the required option from File drop-down list 
at the top left corner of the window.

2. Click Save Scan Recipe/Save Sequence Recipe.

A dialog box is displayed showing the save-in folder. 

3. Choose a folder and type the name of the scan recipe/sequence recipe, and 
then click Save. 

The current parameter settings are now saved in the selected folder as a scan 
recipe/sequence recipe. 

To load a scan recipe/sequence recipe,

1. From the Main window, select the required option from File drop-down list 
at the top left corner of the window.

2. Click Load Scan Recipe/Load Sequence Recipe.

A dialog box is displayed showing the folder of all the previously saved recipes. 

3. Choose the target scan recipe/sequence recipe, and then click Open.

The parameter settings in the selected scan recipe/sequence recipe are now loaded to 
the software. 
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9.3.4 Loading and Positioning the Sample

Alpha-Step D-600 Wafer Stress Chuck

The Alpha-Step D-600 wafer stress chuck (see Figure 9-2) is designed to support the 
wafer during wafer stress measurements. To add the wafer chuck to the standard 
chuck, use the instructions provided with the wafer stress chuck, Installing a 
Precision Locator.

Figure 9-2 Alpha-Step D-600 Wafer Stress Chuck

Three wafer support pins can be located for the wafers of nominal sizes 2 to 8 
inches.
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Universal Chuck

Universal chuck equipped with a stress precision locator can also be used for the 
film stress measurement on D-600. And it is available to enable exact positioning of 
a sample relative to a fixed reference, flat or notch. The chuck allows various 
positions for the locating pins and standoffs to accommodate wafers from 50 mm to 
200 mm (2 in. to 8 in.). See Figure 9-3.

Figure 9-3 Universal Chuck (for D-600)
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Alpha-Step D-500 Wafer Stress Chuck

The Alpha-Step D-500 wafer stress chuck (see Figure 9-4) is designed to support the 
wafer during wafer stress measurements on D-500. To add the wafer chuck to the 
standard chuck, use the instructions provided with the wafer stress chuck, Installing 
a Precision Locator.

Figure 9-4 Alpha-Step D-500 Wafer Stress Chuck

Three wafer support pins can be located for the wafers of nominal sizes 2 to 6 
inches.
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Placement of the Wafer

The procedure assumes that the stress locators are in place on the chuck. The wafer 
rests on the three stress locators, so the chuck does not change the shape or stress of 
the wafer.

For Alpha-Step Wafer Stress Chuck:

1. Place the wafer on the three pin locators. Rotate the wafer so that the 
flat/notch is facing the front of the stage towards the operator.

2. Center the wafer on the three pin locators. Use your finger tips to align the 
wafers outer edge on the pins.

For Universal Chuck:

1. Mount proper locating pins on the chuck according to the wafer size and 
reference type (notch/flat). 

2. Place the wafer on the three stress locators, use locating pins to precisely 
locate the wafer: the flat/notch is firmly against the locating pin(s), and the 
wafer left side is against the other locating pin. 

This ensures that the wafer is loaded in the correct orientation and location for the 
pre and post measurements. 

NOTE

When manually loading the sample, make note of the position of the sample on 
the sample chuck. To compare pre- and post‐stress measurements, you must 
duplicate the scan position for both measurements as close as possible to reduce 
user-induced variation to the calculations. Also, ensure that the scan parameters 
are identical for each of the scans or this might cause an error message to 
displayed when making the Wafer Stress Calculation.

For more information on loading and positioning the sample, refer to Chapter 5, 
“Loading the Sample,” on page 57 and Chapter 5, “Control Panel Tab,” on page 62.

Load a sample for which you already have a Scan Recipe/Sequence Recipe saved. 
Otherwise, refer Chapter 4, “Description of Features,” on page 23 for instructions 
on changing the Scan parameters.
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Profiling the Sample

Thin Film Stress measurement always requires a relatively long scan. For D-600, 
the maximum length of a single scan is 55 mm, and an auto-stitching scan can 
extend the scan length to 200 mm. To take an auto-stitching scan as a pre-stress 
scan:

1. Create and save a scan recipe with proper scan parameter settings. For the 
details about setting the scan parameters, refer to Chapter 4, “Scan 
Parameter Tab,” on page 42 for saving a scan recipe, refer to Chapter 9, 
“Saving and Loading a Scan Recipe/Sequence Recipe,” on page 148.

2. In Sequence Control panel, click Scan to load the previously saved scan 
recipe.

3. Move the sample to the starting point, and add the coordinates as the first 
measurement site.

4. Select Matrix Mode, select the Stitch check the box, set Rows (Y) and Pitch 
numbers based on the scan length.

5. Click Populate and the site coordinates is added to the site list automatically.

6. Click Save As to save the current sequence recipe. For details about saving a 
sequence recipe, refer to Chapter 9, “Saving and Loading a Scan 
Recipe/Sequence Recipe,” on page 148.

7. Click Start and a Sequence Scan File Name dialogue box is displayed.

8. Type the Root File Name, select the Data Path, and then click OK. It starts 
to scan. 

The Main window is displayed during the scan. After the scan is complete, the Data 
Display window is displayed with the stitched profile and individual profiles, and 
all the data files are saved in the target folder.
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9.4 Taking a Difference Measurement

A difference measurement compares the stress data in the current profile with 
pre-stress data from an earlier profile. An example of this would be measuring a 
deposited film step on a non-uniform surface and then removing the step feature and 
measuring the sample in the same location, then subtracting the substrate profile 
from the step profile to get only the step shape for a height measurement. The 
procedure requires a pre-process (or substrate) data file and a post-process (or 
feature of interest) data file. The two saved files are then be subtracted to get the 
profile of interest.

NOTE

If a pre‐stress profile has not been saved before computing a difference 
measurement, the difference measurement can be computed assuming a totally 
flat pre-stress sample profile.

9.4.1 Selecting a Sequence Recipe

You should use the same sequence recipe for the pre-stress and post-stress profiles. 
For details about loading a sequence recipe, refer to Chapter 9, “Saving and Loading 
a Scan Recipe/Sequence Recipe,” on page 148.

9.4.2 Loading and Positioning the Sample

Before loading the sample, check if following requirements are met:

• The sample has been processed.

• It was scanned before the processing.

• The pre-stress profile has been saved in the data folder.
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To position the sample for a difference measurement:

NOTE

Position the sample exactly as it was positioned for the pre-stress scan.

1. If you are using the Precision Wafer Chuck, use the precision locator with 
the three support points. Ensure that you position that sample the way it was 
positioned for the pre-stress scan paying particular attention to the rotation 
of the sample on the sample holder.

The precision locator has fittings that locate the wafers of various sizes 
in X, Y. It supports the wafers in a way that minimizes gravitational 
distortions, but also ensures that the residual gravitational distortion is 
the same for both the pre- and post-stress scans.

2. The user can program the instrument so that the load position moves the 
stage to exactly the right scan position.
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9.5 Taking a Single Post Stress Management

A single, post-stress measurement measures the current curvature of the sample. In 
such a calculation, the software assumes that the sample is flat before being 
processed and stressed.

To take a single, post-stress measurement:

3. Load the sample.

4. Profile the sample. Refer to Profiling the Sample on page 153 for details.

5. Go to Thin Film Stress Calculation window.

6. Enable the Calculate on Post stress data only box (this deactivates the 
post-stress file field).

7. Click Load Post Stress File and choose the post-stress file name applicable 
to the calculation.

8. Type the stress parameters in the appropriate fields of the Thin Film Stress 
Calculation window.

9. Click Calculate.

The stress calculations are displayed. You can print the calculation results from the 
Results dialog box.
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9.6 Recalculating Stress Measurements

The user can recalculate stress measurements provided the pre-stress profile and 
post-stress profile(s) have been saved. For example, you can do this to correct a 
mistake for film thickness that was entered when a previous wafer stress calculation 
was made.

To recalculate a measurement:

1. Open the Thin Film Stress Calculation window.

2. In the File field, load the pre-stress and post-stress profiles that you wish to 
use for the new wafer stress calculation or difference profile.

3. Enter the appropriate stress parameters and elastic constant (refer to “Thin 
Film Stress Window” on page 145 for details).

4. Select Apply Calculation to Data. The summary calculations are displayed 
in the dialog box and the difference is subtracted from the last open data set.

5. Close the Thin Film Stress Calculation window.

6. View the Data Display window to see the difference profile.

7. Save the new difference profile.
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9.7 Use a Difference Measurement to Subtract from a Scan Profile

The Thin Film Stress software feature provides the user with a means of removing 
systematic noise inherent to the profiler during sensitive measurements of very 
small features.

The procedure requires the use of an optical flat or similar sample that can be used 
as the background scan data which is subtracted from the sample scan data. The 
background scan is contains any systematic noise without contributing any data due 
to measurable features which when subtracted from the sample of interest is affects 
the final profile data.

9.7.1 Taking a Background Scan

1. Load the optical flat or comparable sample for which you already have a 
scan recipe or sequence recipe (otherwise refer to Chapter 4, “Scan 
Parameter Tab,” on page 42 for instructions).

2. Press Scan. The Main software screen is displayed during the scan. After the 
scan is complete, the Data Display window is displayed with the profile.

3. Right-click the Data Display window and select Save As.

4. The Data folder dialog box is displayed. Type a file name that can be easy to 
associate with the background systematic measurement.

5. Press ENTER or click Save.

To remove the systematic noise from a scan and display the difference profile and 
data:

1. With the sample loaded and ready, press the Scan button on the Main 
software screen.

2. The Data Display window opens with the profile. Save the data.

3. Open the Wafer Stress Calculation window.

4. In the Files box are two fields, the pre-stress file field and the post-stress file 
field.

• Click Load Pre-stress File. A dialog box opens listing the saved profiles 
in the Data folder. Choose the systematic background profile to be used 
for the subtraction.
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• Click the Load Post-stress File. A dialog box opens listing the saved 
profiles in the Data folder. Choose the sample of interest profile from 
which you wish the systematic noise to be subtracted.

5. Enter the stress parameters as described in, “Thin Film Stress Window” on 
page 145.

6. Select the Apply Calculation to Data button. Ignore the calculated stress 
values as they are erroneous.

7. Close the Thin Film Stress Calculation window.

8. Open the Data Display window. The profile data shown is the difference of 
the sample of interest and the systematic background noise.

9. From the Data Display window, right-click to open the drop-down list.

10. Select Save As.

11. In the Save As window, type a name for the profile. Press ENTER or click 
Save to save the data and close the window.
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Chapter 10–System Maintenance
10.1 Introduction

This chapter gives information that is useful in maintaining and troubleshooting the 
Alpha-Step Development Series profiler. Included in this chapter is a description 
of the KLA-Tencor Service Policy. A useful section for users with multiple styli or 
in the case one is replaced; there is a procedure for how to exchange a stylus. The 
Alpha-Step Development Series profiler Application has an electronic Help 
resource. We give a basic description of how to use this help tool. The Chapter ends 
with a list of common software Error messages and a description of the most 
common causes for the message and then a basic response to the message.
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10.2 Linear Calibration Procedure

The linear calibration procedure is an automated test and self-correction routine 
used to reduce measurement error across the entire sensing area of a given range. 
This is necessary in order to compensate for the natural non-linear response of the 
electro-optical system. Without correction the measurement accuracy of the tool is 
under-optimized.

During the procedure the user is given the option to calibrate any individual range, 
all short ranges (2.5 µm, 10 µm and 100 µm), or all long ranges (550 µm and 1200 
µm). Short Range and Long Range calibrations are done separately, as 2 different 
step-height standards are used in the procedures. A 1 µm (10,000 Å) step-height 
standard must be used when calibrating any Short Range, and a 50 µm standard 
must be used when calibrating any Long Range. Detailed in the following is a 
walk-through of the linear calibration procedure. It is critical to the performance of 
the instrument that these steps are followed when performing the linear calibration 
of any and all measurement ranges.

If all measurement ranges are to be calibrated always calibrate the Long ranges first.

10.2.1 Long Range Calibration

1. Calibration Sample: Place your 50 µm step-height standard on the scan-stage 
and align the step so that you can measure the calibrated region within the U 
shaped designators, as shown in Figure 10-1 (The arrow in Figure 10-1 
shows where both linear and Z-height calibrations should take place).

Figure 10-1 50 µm Step Measurement Feature
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2. Level Scan Stage: In order to ensure an accurate calibration the scan stage 
must be precisely leveled. Navigate to the toolbar and click File > Load Scan 
Recipe and open the Scan Recipe labeled CTD-D500-600-Linearity-50 
μm-StageLevel.rcp.

3. Click Data Analysis to view the Z(M) - Z(R) value of the cursor positions 
within the scan data, or simply observe the Delta Height value in the Data 
Control panel at the right of the screen. This value must be less than 2,000 Å 
before proceeding to the next step in the calibration procedure. Adjust the 
scan stage tilt wheel and continue to test scans until this requirement is 
achieved.

Refer to the Manual Stage Leveling section of the user manual for a 
description of the leveling process.

Figure 10-2 shows scan data resulting after proper stage leveling:

Figure 10-2 Measurement Feature (Precise Stage Leveling)
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4. Align the Step: After the sample is level navigate to the toolbar and click 
File > Load Scan Recipe and open the file labeled 
CTD-D500-600-Linearity-50 μm-Measurement.rcp. This file sets the auto 
functions to level and measure the feature with respect to particular 
locations. In order to ensure accurate measurements the Y-position of the 
stage must be set precisely so that the center of the step-height feature aligns 
with the center of the scan length.

5. Adjust the position of the step and perform subsequent test scans until the 
resulting scan data is displayed as shown in Figure 10-3:

Figure 10-3 Measurement Feature Centered in Middle of Scan Length

6. Begin Long Range Linearization: Type the L key, or select Tools > Linear 
Calibration from the tool bar, and the Linear Calibration panel is displayed 
as shown in Figure 10-4.
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Figure 10-4 Linear Calibration Panel

The upper and lower sections on the left-side of the panel provide the calibration 
options and the previous dates of calibration for each range (this is stated in standard 
US date notation: Day/Month/Year).

Because the 50 µm step-height is only used to calibrate the Long Ranges, only the 
section for the Long Ranges is of interest. Choose from among the Long Range 
options - individual calibrations of the 550 µm and 1200 µm, or All Long Ranges. 
The comprehensive All Long Ranges option is always recommended and takes 
roughly 25 minutes to complete. After the option is chosen,. click Start Calibration 
at the bottom of the panel.

Before the procedure begins, pop-up messages are displayed to ensure that the user 
has properly set-up the scans according to steps 2 and 3 of this procedure. The first 
asks if the stage has been leveled (as shown in Figure 10-5), while the second asks if 
the proper step-height standard has been chosen and aligned correctly (as shown in 
Figure 10-6).

Figure 10-5 Leveling Scan Stage
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Figure 10-6 Scan Over 50 µm Step Height

The automated routine begins if Yes is selected for both of the questions. Leave the 
instrument undisturbed during the routine.

7. End Long Range Linearization:

After the calibration successfully completes the dates in the panel is update. 
Close the Linear Calibration panel.

8. Z-Height Calibration:

Perform a Z-height calibration (refer to Calibrating the Measurement Head) 
on any range that was calibrated for linearity in the above sections.

Remove the 50 µm step-height standard from the scan stage.

10.2.2 Short Range Calibration

1. Calibration Sample: There are two types of 1 µm step height standards as in 
Figure 10-7. One of them is shipped with the tool. Place your 1 µm 
step-height standard on the scan-stage and align the step so that you can 
measure the calibrated region shown between the dotted lines as shown in 
Figure 10-7 (Between the dotted line are where both linear and Z-height 
calibrations should take place; for both types of step stands, the features that 
can be used are at the center of the standard.).
# 9019320-000 Rev. AC KLA-TENCOR CONFIDENTIAL -- RESTRICTED DISTRIBUTION D-500 & D-600 User Manual 167 



Chapter 10–System Maintenance
Figure 10-7 1 µm Step Measurement Feature

2. Level Scan Stage: In order to ensure an accurate linear calibration the scan 
stage must be precisely leveled. It is important to complete this step, even if 
the stage was previously leveled for Long Range calibration, because the 
two calibration samples (1 µm and 50 µm steps) might inherently have 
different degrees of tilt.

Navigate to the toolbar and click File > Load Scan Recipe and open the file 
labeled CTD-D500-600-Linearity-1 m-StageLevel.rcp. Perform a test 
scan.

Click the Data Analysis button to view the Z(M) - Z(R) value of the cursor 
positions within the scan data, or simply observe the Delta Height value in 
the Data Control panel at the right of the screen. This value must be less than 
100 Å before proceeding to the next step in the calibration procedure. Adjust 
the scan stage tilt wheel and continue to test scans until this requirement is 
achieved. Refer to “Manual Stage Leveling” on page 77 for a description of 
the leveling process. The Figure 10-8, shows scan data resulting after proper 
stage leveling:
168 D-500 & D-600 User Manual KLA-TENCOR CONFIDENTIAL -- RESTRICTED DISTRIBUTION # 9019320-000 Rev. AC 



Chapter 10–System Maintenance 
Figure 10-8 1 µm Step Measurement Feature after Precise Stage Leveling

3. Align the Step: Navigate to the toolbar and click File > Load Scan Recipe 
and open the Scan Recipe labeled 
CTD-D500-600-Linearity-1um-StageLevel.rcp This file sets the auto 
functions to level and measure the feature with respect to particular 
locations. In order to ensure accurate measurements the Y-position of the 
stage must be set precisely so that the center of the step-height feature aligns 
with the center of the scan length. Adjust the position of the step and 
perform subsequent test scans until the resulting scan data is displayed as 
shown in Figure 10-9 (centered in the middle of the scan length).
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Figure 10-9 1 µm Step Height Measurement Feature

4. Begin Short Range Linearization:

Type the L key, or select Tools > Linear Calibration from the tool bar, and 
the Linear Calibration panel is displayed as shown in Figure 10-10.

Figure 10-10 Linear Calibration Panel
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Because the 1 µm step-height is only used to calibrate the Short Ranges, 
only the section labeled Short Ranges is of interest. Choose from among the 
Short Range options - individual calibrations of the 2.5 µm, 10 µm, or 
100 µm ranges, or All Short Ranges. The comprehensive All Short Ranges 
option is always recommended and takes about 30 minutes. After the option 
is chosen, click Start Calibration at the bottom of the panel.

The user is prompted to answer two questions, ensuring that the scan-stage is 
level and that the scans have been properly aligned (refer to Appendix , 
“Long Range Calibration”). If the user selects Yes to both of the questions 
the automated routine begins.

If a scan disruption occurs more than twice during the calibration of a given 
range a dialog box is displays which alerts the user that the calibration setup 
must be verified and the test repeated.

5. End Short Range Linearization:

After the calibration successfully completes, the dates in the panel gets 
updated. Close the Linear Calibration panel.

6. Z-Height Calibration:

Perform a Z-height calibration (refer to Calibrating the Measurement Head) 
on any range that was calibrated for linearity in the above sections.

Remove the 1 µm step-height standard from the scan stage.

10.2.3 Linear Calibration Details

10.2.3.1 Linear Calibration Frequency

The frequency at which the linear calibration procedure should be performed 
depends solely on the amount of stress experienced by the stylus/pivot mechanism. 
This stress is related to the demands of the user's application, and by scanning 
habits. As a result, there is no exact interval at which calibrations should be 
performed, only a set of guidelines that the user should adhere to for best results. 
The following sections provide insight and instruction as to when the linear 
calibration procedure is necessary.

10.2.3.2 Long Ranges

The Long Ranges (greater than 550 µm) are extremely robust and is remains 
calibrated over long periods of time, roughly on the order of months. Unlike the 
high gain ranges (discussed in the next section), excessive flexure or disruption of 
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the pivot mechanism is not effecting the Long Range calibrations drastically. Within 
reason, anything short of a stylus change can be tolerated. If the instrument is 
located in an uncontrolled environment, however (such as a university or 
multi-purpose laboratory), it is recommended that all Long Ranges be re-calibrated 
once per month to ensure optimum accuracy.

10.2.3.3 Short Ranges

The two highest gain ranges (2.5 µm and 10 µm) are the most sensitive to 
calibration degradation. In most cases this is related to excessive flexure or 
disruption of the pivot mechanism. This can occur from impacting the stylus 
laterally; displacing the stylus to Z-heights greater than 1200 µm; or, in extreme 
cases by tripping the Z-stop electro-mechanical flag (a Z-height displacement of 
roughly 1350 µm). By simply engaging in a Step Down profile type in the 1200 µm 
range the stylus is displaced by 1200 µm. In any of these cases, it is recommended 
that the Short Ranges be re-calibrated before further measurements are made in the 
2.5 µm, 10 µm or 100 µm ranges.

If the user operates safely within these limits and the pivot mechanism is flexed 
minimally, the Short Range calibrations might remain accurate up to a month in some 
cases. It is recommended, however, that calibrations be performed on all Short 
Ranges every two weeks if the instrument is under regular use. Increased frequency 
of linear calibrations is improves the accuracy of the tool.

10.2.3.4 Linear Calibration Reminders

As a rule, all ranges - long and short - must be re-calibrated after a stylus change or 
following any maintenance of the pivot assembly. If all ranges are going to be 
calibrated always calibrate the Long Ranges before calibrating the Short Ranges. 
Provided in Table 8-1 is a list of cases when calibration would be appropriate:

Table 10-1 Typical Cases Requiring Calibration

Event Recommendation

Installation of Instrument Calibrate All Ranges (Long, then Short)

Stylus is changed Calibrate All Ranges (Long, then Short)

Stylus is displaced by >1200 µm Calibrate All Short Ranges

Z-Electrical Stop is reached Calibrate All Short Ranges

Every 2 weeks Calibrate All Short Ranges

Every 4 weeks Calibrate All Long Ranges
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Within the right-side of the Linear Calibration Panel there are fields for defining 
software reminders to aid the user in ensuring regular calibration. This is shown in 
Figure 10-11. Type the L key, or select Tools > Linear Calibration from the tool 
bar, and the Linear Calibration panel is displayed.

Figure 10-11 Linear Calibration Panel - Software Reminders

Although KLA-Tencor's recommended calibration frequency is the default, the user 
can define a preferred frequency for software reminders. The reminder is a pop-up 
message that is displayed at the start of the Alpha Step application, and only when 
the calibration of a range is past due as defined by the Reminder section of the 
Linear Calibration Panel. If a range is out-of-date the Linear Calibration Reminder 
box is displayed as shown in Figure 10-12.

Figure 10-12 Linear Calibration Reminder Panel

Ranges that are out-of-date are designated by a RED pointer, while ranges that are 
within calibration are designated by a GREEN check mark. As the reminder is only 
displayed at the start of the Alpha Step software it is important not to leave it 
running constantly, but to close the program from time to time.
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10.2.4 Troubleshooting Linear Calibration

10.2.4.1 Alignment Voltage is too Low

In order for the linear calibration to be successful the electro-optical system must be 
in proper alignment. When the system is properly aligned the bias position of the 
stylus, laser beam reflection, and photo-detectors produces a particular system 
voltage, called the alignment voltage. For the automated linear calibration routine to 
begin it is critical that the system recognize that the alignment voltage is within a 
certain tolerance.

Therefore, the alignment voltage is checked automatically before proceeding, and if 
a problem is detected the user is receiving the following message, as shown in 
Figure 10-13. The message specifically relates to the Long Range alignment; a 
similar warning message is displayed if there are detected issues with the Short 
Range alignment.

Figure 10-13 Warning for Error in Electro-Optical Alignment Voltage

This message is results from the stylus simply being contacted somewhere on the 
surface of a sample. This action naturally deflects the position of the stylus and 
yields a deviation from the system alignment voltage. In this case the user must 
drive the stylus UP and off of the sample before attempting to initiate the linear 
calibration routine again.

In a more serious case the alignment voltage might have changed due to some 
mechanical trauma experienced by the pivot assembly, resulting from a stylus crash, 
stylus change, an accidentally locked stylus, or some other disturbance to the stylus 
and/or pivot assembly. In these cases the reflected beam is miss-directed and must 
be re-aligned so that the proper alignment voltage is achieved. If it is suspected that 
the system is out of alignment a technical representative of KLA-Tencor should be 
contacted.
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10.2.4.2 Calibration Failure

In order for the linear calibration routine to complete successfully there are two 
conditions required by the system. The first is that the system needs to be able to 
engage to every programmed location across a given range, and the second is that it 
must be able to analyze good scan data.

If the system cannot engage to a given location there can be a time-out and the user 
receives the error message as shown in Figure 10-14.

Figure 10-14 Error Message - Unable to Engage for Scan

Receiving this error message during the linear calibration routine is an indication of 
either an optical misalignment, or of a mechanical error in the Z-stage mechanics. In 
either of these cases the system is prevented from engaging properly and a technical 
representative of KLA-Tencor should be contacted.

During the routine the software is attempting to reject any bad scans that can arise 
from excessive vibration, shock, or mechanical disruption. If a scan disruption 
occurs more than twice during the calibration of a given range, a dialog box is 
displayed which alerts the user that the calibration setup must be checked and the 
test repeated. In this case the warning is displayed as shown in Figure 10-15 (shows 
the error message that arises if too many scans are corrupted during the Linear 
Calibration procedure).

Figure 10-15 Error Message - Scans are Corrupted
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10.3 Calibrating the Measurement Head

The Alpha-Step Development Series profiler is calibrated before it leaves the 
factory. But, it is necessary to calibrate the measurement head for the specific height 
range that you are measuring. The following directions describe how to calibrate the 
instrument with a known step height standard.

The frequency of calibration is very dependent on the individual customer 
circumstances:

If the instrument is being used in a manufacturing environment with relatively tight 
process control parameters, the instrument should be monitored daily. The process 
engineer should regularly monitor the control charts and relative deviation of the 
step height to insure that daily calibration is appropriate for the process.

If the instrument is used in an R&D lab where deposition thickness is monitored by 
a step height weekly and the films are relatively thick, the system should be 
monitored monthly.

If the instrument is in a lab with several users, and it is critical to obtaining the most 
precise measurement possible, it is recommended the system be monitored prior to 
your first measurement and after the last measurement of a set for very tight 
calibration controls.

For more information on calibrating your system or creating a schedule for 
maintenance, contact the KLA-Tencor Customer Service Department.

10.3.1 Calculating the Calibration Factor

Each scan range has its own calibration factor in the registry, so the calibration 
should be done for each scan range separately.

1. In the Scan Parameters tab, select the scan range that you want to calibrate.

2. Load onto the sample stage the height standard representative of the height 
range that you are measuring or the standard sample included with your 
system.
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NOTE

Ensure that the Setup parameters are consistent with factory settings used 
during factory calibration as described in the certification documentation included 
with your system.

3. Scan the standard sample step height.

4. In the Data Display window, position the R and M cursors on the features of 
the scan that is the baseline (refer to Chapter 6, “Leveling the Profile,” on 
page 97 for more explanation).

5. Click Level Data.

6. Position the R cursor just outside a step.

7. Position the M cursor on the top of the step height feature.

8. Use the Average Mode for both cursors to maximize the number of data 
points being used to set the baseline and step height (refer to “Chapter 6, 
“Leveling the Profile,” on page 97) if not already done during the leveling 
procedure.

9. In the Data Display window, right-click the mouse button, select the 
Calibrate Height function.

10. The software prompts the user if the cursors are in the correct location for 
calibration. click OK if you have already positioned the cursors; click No to 
close the window and reposition the cursors.

11. In the Calibration Data dialog box, type the step height in Angstroms of the 
standard sample being measured. See Figure 10-16.

Figure 10-16 Calibration Data Dialog Box

12. Click OK. The software calibrates the system using the measured height 
value.

The system is now calibrated to a known certified standard.
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10.4 Changing the Stylus

Figure 10-17 Stylus Inserted into Stylus Clamp

Replacement Styli are available from KLA-Tencor.

To change the Stylus, follow these instructions:

1. Lock the pivot using the dowel plunger.

2. Using tweezers or small pliers gently grab the stylus shaft and pull the stylus 
straight out of the clamp.

NOTE

Be careful to not touch the diamond tip of the stylus you might cause damage 
and get dirt on the tip.

3. Store the old Stylus in a safe place.

4. Using tweezers grab the new stylus as shown in Figure 10-17.

5. Gently insert the stylus into the spring clamp with the flat side of the tapered 
end facing to the left (flat side the spring clip). You have to press fairly 
strongly depending on the tightness of the spring clam for that instrument. 
The stylus is slides into the clamp holder. Ensure that the stylus hits the back 
of the clamp.

6. Release the stylus lock by unlocking the dowel plunger (refer to “Unlocking 
the Pivot Assembly” on page 38”).

NOTE

The KLA-Tencor service policy does not cover damage to the stylus, the stylus 
arm assembly, or the pivot caused by operator error.
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10.5 Stylus Tip Centering

When the tool is installed, the stylus tip is located in the center of the video view for 
all the video magnifications. When a new stylus is replaced, the stylus tip could be 
slightly offset from the center of the video view for 1x magnification. But if the 
magnification is switched to 4x, the offset is more visible and this need to be 
corrected. The following is the procedure of how to center the stylus tip to the center 
of video view for magnification of 1.3x, 2x, and 4x.

1. Change the Magnification of Zoom Lens to 4X in the Control Panel. 

2. Focus the stylus on a sample.

3. Use CTRL + M to bring up Camera Utilities on top of video view.

4. Select Camera Utilities > Open Camera Parameters dialog box. Select 
Size tab and adjust the Left and Top offsets to center the stylus tip in the 
camera view as in Figure 10-18.

Figure 10-18 Camera Parameters Dialog Box
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5. After the stylus tip is centered in the video view, close the Camera 
Parameters dialog box.

6. Under the Camera Utilities, click Save Camera Parameters to save the 
changes made.

7. Repeat the same procedure for magnification of 2x and 1.3x.

NOTE

This procedure does not work on magnification of 1x. If the stylus tip is far off 
from the center of the video view, first check whether the stylus is mounted 
correctly. If the stylus is mounted correctly and the stylus tip is far off from the 
center of video view for magnification 1x, contact KLA-Tencor Service 
Department.
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10.6 Software Maintenance

10.6.1 Backing Up Files

It is a good user maintenance policy to make back up copies of the data and scan 
recipes. All profiler Data and Scan Recipes are stored under the software directory 
on the computer local disk drive C.

1. Go to the local disk drive C.

2. Double-click the KLA-Tencor folder.

3. Double-click the AlphaStep D folder.

4. Select the Data folder and the Setup folder and copy each one to a Server, 
CD-ROM, or other data storage device that your facility uses for backup 
purposes.

10.6.2 Restoring Data and Scan Recipes

Data or Scan recipes can be restored from a backup location if you did back up your 
data and scan recipes.

Restoring Files from a Backup Location:

1. Insert the CD-ROM, or other storage media into the appropriate drive 
location or use the Windows Explorer to locate the Network drive where the 
Data or Scan Recipes are backed up.

2. Right-click the Data or Setup folder to be copied. A drop-down list is 
displayed.

3. Select Copy to copy the folder to the computer Clipboard or Drag the folder 
to the software folder in drive C. The files are copied to their respective 
folders.

4. If there are already copies of the files in drive C, a prompt message 
indicating that the files overwrite is displayed.

5. Close the Windows Explorer program.
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10.7 Help Files

The Help files are accessed from the Main software screen or on the computer 
desktop. To access the Help files:

1. Click the Help drop-down list located at the top of the Main software screen.

2. Click Contents to open the help window.

3. Follow the directions in the help window.
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Appendix A–Profiler Specifications
A.1 Alpha-Step Development Series Profiler Specifications

Table A-2 Alpha-Step Development Series Profiler Specifications

PROFILER* 
SPECIFICATIONS

Alpha-Step D-600 Alpha-Step D-500

Sample Stage Diameter 200 mm 140 mm

Scan Length Range 55 mm maximum 30 mm maximum

X-Y Stage Translation 150 mm x 178 mm NA

Sample Thickness 30 mm (~1.25 
inches)

20 mm maximum 
(~0.75 in.)

Stage Positioning <5 µm Motorized and 
Programmable

Manual

Vacuum Chuck Standard None

Vertical Resolution: 0.38Å Least Sig bit 0.38Å Least Sig bit

Lateral Resolution: 100 nm (Stylus 
dependent)

100 nm (Stylus 
dependent)

Vertical Range: 1200 µm max 1200 µm max

Step Height Repeatability: 5 Å or 0.1% 
(one‐sigma), 
whichever is larger

5 Å or 0.1% 
(one‐sigma), whichever 
is larger

Max. Data Points per
Scan

400,000 400,000

Sample Viewing: Color Camera Color Camera

Standard Magnification: 1x, 1.3x, 2.0x. 4.0x 
digital zoom

1x, 1.3x, 2.0x. 4.0x 
digital zoom

Field of View: 13.8 mm x 3.2 mm 3.8 mm x 3.2 mm

Stylus Tip Radius: 2.0 microns 
(standard)

2.0 microns (standard)

Stylus Force Range: 0.03 -15 mg 
(programmable)

0.03 -15 mg 
(programmable)

Software Leveling: Yes‐cursor‐controlled 
or Auto-Leveled (for 
repeated scans)

Yes‐ cursor‐controlled 
or Auto-Leveled (for 
repeated scans)

Scan Filtering: Low-pass, high‐pass, 
and polynomial 
adjustable filter

Low-pass, high‐pass, 
and polynomial 
adjustable filter

Stress Option Yes Yes

* Specifications are subject to change. Contact KLA-Tencor for the latest system 
specifications.
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Table A-3 System Configuration

System Configuration

Microprocessor Intel

Operating System Windows 7 (or comparable 
operating system)

Interface Method Keyboard/Mouse

Monitor 19 in. Flat Panel or 
equivalent 

Power Requirements 115 V, 60 cycles or 230 V, 
50 cycles
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	2.1 Introduction
	2.2 How to Use this Guide
	2.3 Instrument Overview
	• Measurement of vertical features ranges from under 10Å to over 1 mm with a vertical resolution better than 1Å for the 2.5 µm range setting and 100nm resolution for the 1.2 mm range setting. Measurements can be taken in metric or English units,...
	• Up to 400,000 data points per profile guarantees that the horizontal resolution is generally limited by the stylus radius and not the number of data points.
	• Measurement of many roughness and waviness parameters with the roughness and waviness separated by user-selectable cutoff filters.
	• Motorized positioning of the sample surface to within 0.5 microns in X-Y using the Alpha-Step D-600 configuration.
	• Many easy to use features, including software adjustable force control, intuitive user interface, easy mouse control of measurement cursors and stage position.
	• Accommodates samples over 200 mm in diameter and heights up to 30 mm.
	• 3D Rendering advanced analysis package extends the measurement capabilities of the Alpha-Step D-600 platform without optional hardware requirements.
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	3.1.1 Facility Specifications
	3.1.2 Vibration and Noise
	3.1.3 Air Currents and Temperature Fluctuation
	3.1.4 AV Table Option

	3.2 Unpacking
	3.2.1 Shipping Contents

	3.3 Pre-power Preparations
	1. Inspect the boxes and crate for any signs of damage or mishandling.
	2. Inspect the Tiltwatch™ and Shockwatch™ stickers on the outside of the crate. If the sensor indicates mishandling, contact KLA-Tencor immediately and do not unpack the system further until confirming with KLA-Tencor service department.
	3. Use a wrench or socket ratchet to remove the bolts from the four sides of the crate.
	4. Lift the crate top from the base by lifting straight up (for Alpha-Step D-600 use two people to ensure that the instrument is not hit while removing the lid) and place aside.
	5. Carefully lift the instrument off the foam base of the crate and place on a cart appropriate for the weight of the instrument (specified for more than 150 lb and clean room compatible).
	6. Unpack the computer and monitor from their boxes and leave them in their respective plastic bag covers in preparation for placement into the clean room.
	7. Move the system into the gowning area of the clean room.
	8. Remove the plastic bag covers from the computer, monitor and Alpha-Step Development Series profiler system.
	9. Carefully place the Alpha-Step Development Series profiler system on a sturdy floor mounted bench, or for better results, a vibration isolation table. (For more information regarding recommended vibration isolation tables contact KLA-Tencor Custom...
	10. Gently peel back the tape from the windscreen of the Alpha-Step Development Series profiler cover, and gently remove the restraining tape from the stage. The stage is held in position with a block at the front of the stage, ensure to remove the p...
	Apply light pressure to the stage when removing the tape to prevent the stage from lifting from the optical flat.

	11. Locate the computer on the floor or near the Alpha-Step Development Series profiler instrument ensuring that the cables are not stretched taught, but hang loosely from the back of the instrument to the computer and monitor.
	12. Locate the monitor, keyboard, and mouse on the bench top above or next to the computer and profiler.
	13. Store the shipping crate and boxes in a dry accessible place. In the unlikely event that the instrument needs to be returned to the factory, it must be shipped in its original container.

	3.4 Cable Connections
	3.5 Cable Hook-up Instructions
	Figure 3-1 Cable Hook Up Instructions
	If the USB cable is plugged into the wrong USB port, the computer asks the user to install the proper driver. Do not continue the stop, reconnect the USB cables to their proper port.

	Figure 3-2 Computer Back Panel with Cable Connections

	3.6 Final Inspection
	1. Check that all the shipping restraints and stage block have been removed (see Figure 3-4 and Figure 3-5 for details).
	2. Check that the power, USB, and vacuum (if needed) are connected properly and securely.
	Inspect that the cables are not stretched taut between the computer and Alpha-Step Development Series profiler instrument as this affects the proper functioning of the instrument and cause noise which can affect your measurements. If you are using a ...

	1. Check to ensure the tabletop is free to move in all directions.
	2. Check to ensure the cables in the back of the instrument have a sufficiently large service loop to ensure minimal vibration is transmitted through the cables to the isolation table.
	KLA-Tencor Warranty Policy does not cover damage to the stylus, the stylus arm assembly, or the pivot caused by operator error or carelessness.


	3.7 Powering up the System
	1. Turn on the AC power to the computer (located on the front panel of the computer) and monitor.
	Allow the computer to startup completely before proceeding with the next step.

	2. Turn on the AC power to the Alpha-Step Development Series profiler instrument (located on the back panel of the instrument).
	Wait 10 seconds before proceeding to the next step in order to allow the USB communications to establish a connection.


	3.8 Shipping
	1. Disconnect the vacuum line from the back panel of the instrument.
	2. Raise the measurement head to its upper limit.
	3. Move the stage to its Home stage position (Applies to the Alpha-Step D-600 system only).
	4. Quit the Alpha-Step Development Series profiler software.
	5. Shut down the computer using proper Microsoft Windows procedure.
	6. Install the stage block as shown in Figure 3-3. Slide the block between the stage and front panel until it is snug (the stage block for the Alpha-Step D-500 model is smaller than shown in Figure 3-3).
	Figure 3-3 Stage Block Protects the Scan
	The protective block should be removed before starting up the instrument. Do not tap down on the block.


	7. Restrain the stage and block using threaded fiberglass tape along the Y direction of the stage as shown in Figure 3-4.
	8. Restrain the stage using two strips of threaded fiberglass tape along the X direction as shown in Figure 3-4 (For the Alpha-Step D-500 stage it might be necessary to use one tape strip across the stage to secure it).
	9. Close the stage door cover, making sure that the cover clears the block between the stage and front cover.
	10. Restrain the door cover using two strips of threaded fiberglass tape as shown in Figure 3-5.
	11. Cover the instrument in a plastic bag to keep it clean from the packing material.
	Figure 3-4 Stage Restraints

	12. Place the Alpha-Step Development Series instrument on the bottom foam pad of the shipping crate. Center the instrument on the foam.
	13. Slide the Crate cover over the base of the crate.
	Figure 3-5 Fiberglass Threaded Tape Holding
	Use two people to hold the crate cover and slide it straight down over the instrument to refrain from hitting or damaging the system.


	14. Tighten the eight bolts on all four sides using a ratchet or wrench.
	15. Package the computer and monitor in their original boxes.
	16. The system is ready to move to a new location or ship back to KLA-Tencor.
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	Description of Features
	Contents
	4.1 Introduction
	4.2 Screen Layout
	Figure 4-1 Alpha Development Series Screen Layout
	4.2.1 General Description
	Some controls might be disabled at times, depending on the mode of operation of the instrument.
	1. Application Drop-down lists are always shown at the top of the Application Window. These menus are accessible any time by using the cursor to choose one of the drop-down items. If a selection is disabled it is not available.
	2. Application Tool Bar is always displayed in the Main Application Window. The user cannot add or remove buttons to this tool bar. A list of the features and their description is given in the following.
	3. Video Capture window displays the video view from the CCD camera located on the measurement head. The default is for the Video Capture Window to open when the application is opened.
	4. Scan Parameter Control tab by default is docked at the bottom of the Alpha-Step Development Series profiler Application Window. This control tab displays the scan parameters. A more detailed description is given in “Scan Parameter Tab” on page 42
	5. Control Panel tab by default is docked to the right side of the application window. This control tab displays all of the stage controls for the video display, video zoom, vacuum, X-Y stage motion and Z stage motion. A more detailed description is ...
	6. Other Control Tabs:
	7. Data window is opened only after a profile scan is completed or the user loads a previous scan into the application.
	8. Data Analysis tab is available only after the user selects parameters from the Calculations Window and then selects to calculate results. The Data Analysis can show results from a single Data Window or from all open Data Windows.
	Figure 4-2 Data Window


	4.2.2 Alpha-Step Development Series Application Drop-Down Lists
	Figure 4-3 File Drop-Down List
	• Load Data File - This opens the Data Folder. Saved profiles can be loaded into the Alpha-Step Development Series profiler software for further analysis. Choose a filename to load the profile data. The profile is then viewed by opening the Data Di...
	• Save Data File - This opens the standard Windows save file dialog box. Choose a filename to save the current profile data. The profile is then saved in the folder selected.
	• Load Sequence Recipe - This button opens the standard windows and asks the user to open a saved sequence recipe. The Sequence Control Pane uses the parameters of the loaded recipe. The user can also load the sequence recipe from the Sequence Cont...
	• Save Sequence Recipe - This button prompts the user to name and save the current sequence recipe. The user can also save the sequence recipe from the Sequence Control Pane as described in Chapter 7, “Advanced Features,” on page 117.
	• Load Scan Recipe - This opens a dialog box and the user can load a pre-saved 2-D or 3-D scan recipe.
	• Save Scan Recipe - This opens a dialog box and asks the user to name and save the current scan recipe.
	• Print – This opens the standard dialog box prompting the user to choose a printer and the printer set up.
	• Print Preview – This opens a standard Windows preview window that displays the current profile data as it would look for printout.
	• Print Set-up – This opens a standard Windows Printer Set-up Window that allows the user to choose the printer settings before printout.
	• Exit – This quit the Alpha-Step Development Series profiler software (this does not shut down the computer).
	Figure 4-4 Settings Drop-Down List

	• Graph Scales – This opens the control window for the graph parameters for data displayed in the Data Display window.
	Figure 4-5 Graph Setup window
	Figure 4-6 Repeat Scan Window Control

	• Repeat Scans – This opens a Window to control the auto save and naming default for profile data. This feature allows the user to select a root name for scanned profiles that is automatically saved to a folder and named in numerical order.
	• Number of Scans – This field sets the number of scans that is repeated in the same location when the user activates this feature and then starts a scan.
	• Enable – This check box turns the feature on and off. It is off when empty and on when there is check mark in the box.
	Figure 4-7 Tools Drop-Down List

	• Thin Film Stress - This opens the Thin Film Stress option window. For details on using Thin Film Stress, refer to “Chapter 9, “Using the Thin Film Stress Option,” on page 147.
	• Stitch – This opens the Stitch control panel. This panel allows the user to add multiple profiles together to make a single larger profile up to 400,000 data points. The profiles being added must have the same data point spacing though they do ...
	• Tip Retract – This opens a menu that allows the user to choose from three predefined distances that the stylus is retracts from the sample surface after finishing a scan or by pressing the Home X-Y Stages or Load Positions buttons on the Main s...
	Figure 4-8 Load Position Control Panel

	• Load Position – This opens the Load Position Control Panel. The user can save up to 10 stage locations each with a location heading. The user must enter a location name in the corresponding text box to save a stage location. The user can clear ...
	Figure 4-9 Windows Drop-Down Lists

	• Close All – Closes all the open Data Windows inside the Alpha-Step Development Series profiler Application.
	• Cascade – Arranges the open Windows overlapping each other one on top of the other with a small offset displaying the title bar.
	• Tile Horizontally – Arranges the open Windows side by side and resizes them to fit the dimensions of the Alpha-Step Development Series profiler Application Window so that each one is equally visible.
	• Tile Vertically - Arranges the open Windows along the vertical direction and re-sizes them to fit the dimensions of the Alpha-Step Development Series profiler Application Window so that each one is equally visible.
	• View - This toggles on/off the visibility of the following panes, windows, or tabs: Video Capture window, Control pane, Data Control pane, Scan Parameters tab, Cursor Control tab, Real Time Display tab, and Sequence tab.
	Figure 4-10 Help Drop-Down List

	• Contents – This brings up the user manual PDF file.
	• About – Opens the Alpha-Step Development Series profiler software splash screen showing the software version, log level and company information.
	Figure 4-11 Applications Tool Bar

	• Open – Opens a new Data Window
	• Save – Opens the Save dialog box so the current data displayed in the active. Data Window can be named and saved.
	• Print Preview - Opens Print Preview Window of the active Data Window to show what the user sees when the page is printed.
	• Print – Opens the Standard Windows Print controls allowing the user to select a printer and print settings.
	• Set-up – Opens the Alpha-Step Development Series profiler calculation selection and Auto Step functions controls. This Window allows the user to make selections of the parameters for calculating results as well as the Auto Step settings. A more...
	• Data Analysis – Calculates the parameters chosen in the Calculations tab of the Set-up Window on all the open Data Windows.
	• Displayed Windows – Lists all the open Data Windows and including the Video Window. This drop-down list allows the user to select the active Window and move between different Windows.


	4.3 Windows and Tab Features
	4.3.1 General Description
	• Windows - Any Window that is floating in the Alpha-Step Development Series profiler application environment can be resized or moved by using the cursor to grab an edge or corner and then hold down the Left Mouse Button and drag that part of the W...
	• Tabs – Are as a default, anchored in the Alpha-Step Development Series profiler application environment. Each tab has a drop-down control in the upper right corner that shows available mode options for the tab. Any tab can have the following modes
	• A tab can be closed by clicking the upper right corner of the tab or Window (when it is Floating). If a tab is closed, it can automatically be reopened if the user selects the associated function.


	4.4 Measurement Head Hardware Description
	Figure 4-12 Measurement Head Assembly
	4.4.1 Video Camera Assembly
	4.4.1.1 Pivot Block Assembly
	Pivot Assembly Feature Descriptions
	• Pivot Clamp – The pivot clamp is a spring clamp design that allows for easy exchange of the stylus. All the styli have tapered D-shaped mounts so they self align when placed into the pivot clamp. The spring clamp design also allows for the styl...
	• Stylus Lock – The pivot and stylus can be locked using the spring loaded dowel post. The pivot lock is used when exchanging the stylus and for realigning the pivot assembly after service. Detailed instructions on using the pivot lock are given ...
	• Emergency Sensor Switch – The dowel post also serves as an emergency switch with the stylus clamp and pivot. The end of the dowel has a tapered end which sits inside the stylus clamp. If the pivot is accidentally moved too far up or down the do...

	Locking the Pivot Assembly
	1. Move the stylus to a safe distance above the stage or sample then gently grab the red knob on the right side of the pivot assembly (see Figure 4-12).
	2. Gently press the red knob towards the left and turn clockwise until you feel the dowel lock into the new position.
	3. Release the red knob, the pivot is now in the locked position and ready for stylus exchange.

	Unlocking the Pivot Assembly
	1. Move the stylus to a safe distance above the stage or sample then gently grab the red knob on the right side of the pivot assembly (see Figure 4-12).
	2. Gently turn the red knob in a counterclockwise direction until you feel the dowel release from the locked position.
	3. Allow the dowel to slide to the right into the unlocked position
	4. Release the red knob, the pivot is now in the unlocked position and ready for scanning.




	4.5 Protecting the Stylus Arm
	Do not start a scan or move the stage unless you know that the stylus is directly over the sample or you could damage the stylus.
	If the stylus is down, do not move the stage without monitoring the video image or you can damage the stylus.
	The stylus drops about 4 mm (165 mils) less than the measurement head.
	If you change the substrate or precision locator to a different height, reset the height of the stylus position. Otherwise, you can damage the stylus and measurement head.
	When designing custom jigs or fixtures, consider the precautions noted in this section. For instance, when designing a custom disk locator, its center section must be flush with the top of the disk surface. Damage can also occur when there is a hole ...

	4.6 Measurement Capabilities
	• The Alpha-Step Development Series profiler has a vertical scan range of up to 1.2 mm, without requiring any hardware options.
	• The Alpha-Step Development Series profiler has a 16 bit vertical resolution on all instruments rivaling the highest resolution available on a desktop profiler.
	• The Alpha-Step Development Series profiler can scan in both the forward and reverse directions.
	• The Alpha-Step Development Series profiler has basic programmability to make multiple measurements and automatically save the data. (Available in the D-600 model only.)
	• The Alpha-Step Development Series profiler can make 3D data sets and display the image in Apex software. (Available in the D-600 model only.)
	• The Alpha-Step Development Series profiler records up to 400,000 data points for a single profile scan.
	The horizontal resolution is not only a function of the number of data points in a profile; it is also dependent on the stylus tip radius.

	• The Alpha-Step Development Series profiler can scan at speeds ranging from 0.01 mm per second to 0.4 mm per second.
	• Integrated vacuum stage with software control (for D-600).
	• You can use movable cursors to make horizontal and vertical measurements that is displayed as either surface or step height data. The screen constantly displays these measurements.
	• Real-Time updates to any selected calculation parameters in the Data Analysis tab. The Analysis tab also supports Windows Copy, Paste, and Cut functions to easily select results and Paste them into a spreadsheet.
	• You can expand each cursor into a band to define a range (Average Mode). This enables averaging of step height measurements relative to two ranges rather than two points.
	• The cursors can be used to specify new zero points for re-leveling. You can also level using the Average Mode by setting the two cursor ranges.
	• The Alpha-Step Development Series profiler has Soft Zoom capability.
	• Surface parameter values can be displayed in preset metric or English units. Units for horizontal measurements are set independently of vertical units.
	4.6.1 Scan Stage

	4.7 Scan Parameter Tab
	Figure 4-13 Scan Parameters Tab
	4.7.1 Setting Scan Parameters
	1. Position the cursor over the field you wish to change.
	2. Click to highlight the field or click and drag the pointer over the field of interest to highlight the value. Release the mouse button.
	3. Type the new value in the field.
	1. Position the cursor over the arrow and click to open the drop-down list.
	2. Select the value you wish to enter in the field.

	4.7.2 Definition of Scan Parameters
	4.7.2.1 Parameters
	High speeds lose fine detail. Lower scan speeds are required to resolve the full height of a narrow peak, the edge of a corner, or the presence of a small feature.
	The minimum scan speed is limited by a minimum of 3 seconds scan time or larger than 30 mm. If the scan parameters do not result in a 3 second scan time an error message is displayed. You are not be permitted to continue until one or both of the para...
	Step Up/Down is the only one that can be used for samples that require low force settings.
	The 2.5 mm range only allows the Step Up/Down setting. It is required to ensure the high resolution and repeatability of these smaller ranges.
	The starting point for the Forward and Reverse direction is not the same. The user needs to first set the scan direction then reposition the stylus in relation to the sample feature to be measured.
	The number of data points needs to be large enough so that the lateral resolution of the profile is limited by the tip radius and not the number of data points.

	4.7.2.2 Calculation Settings
	Opening the Calculations Settings window
	Calculations Parameter Definitions
	Figure 4-14 Setup Window Calculations Tab



	4.7.3 Auto Functions
	Figure 4-15 Auto Functions Settings Window
	Figure 4-16 Accessing Auto Functions from Settings Menu
	• In the Settings menu, click Auto Functions as shown in Figure 4-16. The Auto Functions window is displayed.
	Figure 4-17 Accessing Auto Functions from Setup

	• In the Application toolbar, click Setup as shown in Figure 4-17. The Auto Functions window is displayed.
	4.7.3.1 Auto Functions Parameter Definitions
	Auto Level
	Auto Measure
	Step Detect



	4.8 Using Scan Recipes
	It is assumed that the operator has already made the changes to the Scan Parameters tab before following the instructions in the following.
	4.8.1 Saving a Scan Recipe
	1. From the profiler Application window, click the File drop-down list located at the top left corner of the screen.
	2. Scroll the cursor to Save Scan Recipe and click once. A dialog box is displayed. The scan recipe is saved in .rcp file format.
	3. Type in a File name and press ENTER or click OK.

	4.8.2 Loading a Scan Recipe
	1. From the Application window, click the File drop-down list located at the top left corner of the screen.
	2. Scroll the cursor to Load Scan Recipe and click once. A dialog box is displayed. Two types of scan recipes can be loaded: rcp format saved with D-500/D-600 or txt format imported from an older version of D-series profilers.
	3. Choose a File name and press ENTER or select Open. This loads the saved Setup parameters and Calculation parameters.

	4.8.3 Changing a Scan Recipe
	1. Follow the Loading a Scan Recipe directions above.
	2. From the Main software screen, choose File and click once.
	3. The Scan Parameters window is displayed with the Loaded Scan Recipe choices. Make any changes to the parameters.
	4. Follow the steps in Chapter 4, “Saving a Scan Recipe”.
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	Basic Operation
	Contents
	5.1 Introduction
	5.2 Powering up the Instrument
	1. Verify that the system power cord is plugged in.
	2. Verify the computer and monitor are powered on. If not, press the Power button. Wait until the Windows Operating System is fully loaded, showing the desktop, before proceeding to the next step.
	3. Turn on the power to the profiler on the back panel. Wait at least 10 seconds before running the profiler software to allow the Stage and computer to establish the USB connection.
	4. Double-click the icon located on the Windows desktop.
	5. The system is now ready to use.

	5.3 Loading the Sample
	1. Open the sample stage cover and place the sample on the stage table or precision locator. See Figure 5-1.
	Figure 5-1 D-500 Stage Table
	If you are using the precision locator, it is normally used in the 0 position.


	2. Using the finger dials, manually move the stage so the sample is moved under the stylus.
	3. When you have roughly placed the sample under the stylus, use the Z Stage controls to lower the stylus until you can see the stylus and sample in the Video window.
	Do not bring the stylus down too quickly or you might crash the stylus into your sample surface and damage one or both of them.

	4. Use the finger stage controls one at a time to fine position the sample under the stylus ready for a measurement.
	Look to see that the stylus is not engaged or too close to the sample surface before proceeding further.
	1. If the stage is not already at the sample load position (closest to the operator and out from under the stylus), on the Control Panel tab, click Load Positions, and use one of the preset stage positions or manually use the X-Y stage controls to mo...
	2. After the stage moves to its forward Load position, a message is displayed on screen telling the user the stage is at the home position. Press ENTER or click OK to continue.
	3. Open the sample stage cover and place the sample on the stage table or precision locator. See Figure 5-2.
	Figure 5-2 D-600 Stage Table
	If you are using the precision locator as shown in Figure 5-3, it is normally used in the 0 position. There are locating pins for precision locating, which support samples in the size of 2-8 in..

	Figure 5-3 D-600 Precision Locator (Universal Chuck)

	4. Engage the vacuum switch, click Vacuum located on the main software screen in the Z Stage controls panel, as shown in Figure 5-4. Users can find the vacuum unnecessary for their sample and can skip this step.
	D-600 stage table has vacuum rings as shown in Figure 5-2, turning off a vacuum valve which prevents the vacuum flow outside the related ring. You can choose different vacuum rings for different sample sizes.

	5. Move the stage in the Y+ direction using the X-Y Stage controls until the sample is positioned under the measurement head. The user can see roughly how close the sample is with the naked eye.
	6. Use the X-Y controls to position the sample for a measurement (see Figure 5-4 for positioning in X-Y for more detailed description of using the X-Y controls).
	7. Close the sample stage door cover.
	Ensure that the measurement head is above the sample and clearly above the surface in the Video window or by using the naked eye to see that the tip is off the sample surface before closing the stage door cover.
	Figure 5-4 Load Positions Video Capture



	5.4 Control Panel Tab
	5.4.1 Video Controls and Zoom
	Leaving the light on high is a heat source and can cause the sample to heat up over extended time.
	Figure 5-5 Control Panel Tab
	5.4.1.1 Viewing the Stylus in the Video Window
	• Z motion - motion of the measurement head up and down.
	• X-Y motion - motion of the sample stage left and right, and back and forward.

	5.4.1.2 Stage Positioning
	5.4.1.3 Using the Stage Controls

	5.4.2 Automatic Saving
	When using Date_Time, it appends _YYYY-MMDD_HHMMSS. When appending a number, it appends “_0000”. For example, if the number is 10, it would append “_0010”.


	5.5 Engaging the Stylus
	5.5.1 Using the Engage Button
	1. After the stylus is positioned over the sample, click Engage in the Z Stage control panel and click once. The profiler automatically brings the stylus down onto the sample surface and stops.
	2. If the measurement requires precise positioning, first click Focus in the Z stage control panel, then move X-Y stage to the desired position, and then engage the stylus.
	Figure 5-6 Stylus Near Sample Surface
	Always raise the stylus off the sample surface before moving the sample to a different location. Failing to lift the stylus off the surface before moving the X-Y stage can damage the stylus and the sample.



	5.5.2 Using the Scan Button
	1. After the stylus is positioned over the sample, Click Scan located in the Video Capture window of the Main software screen. After the Scan is clicked, the instrument automatically engages the stylus on the sample surface and begins the scan. To ca...
	Remember to raise the stylus off the sample surface and home the scan stage before repositioning the sample.



	5.6 Magnifying the Sample Image
	Figure 5-7 Lens Magnification Control

	5.7 Profiling a Sample
	1. Load the sample.
	2. Position the sample under the stylus and focus on the area of interest.
	3. Press the Scan button. For 3D scans, the user is need to select a directory and input the file name after press the Scan button. After the scan finishes, the 3D results are automatically saved.
	4. Display the Profile. For 3D scans, after the scan finishes, Apex is automatically open with the scan image.
	5. Save the results for 2-D scans.
	5.7.1 Loading a Sample
	1. Open the stage cover
	2. Place the sample on the stage. Align the sample so that the profile is along the path of interest.
	The profile is scanned along the Y stage direction. The default direction is from the back to the front of the instrument, the –Y direction.


	5.7.2 Position the Sample
	1. Either manually or with the motor controls, move the sample stage so the sample is under the stylus.
	2. When you have roughly placed the sample under the stylus, use the Z Stage controls to lower the stylus until you can see the stylus and sample in the Video window. Click Focus in the Z stage control panel, the sample to be in focused position and ...
	Do not bring the stylus down too quickly or you might crash the stylus into your sample surface and damage one or both of them.

	3. Use the fine position controls, either manual or motorized depending on the profiler model, to adjust the sample under the stylus until it is in position ready for a measurement.

	5.7.3 Set Scan Parameters
	1. Select the Scan Parameter tab on the bottom portion to be visible.
	2. Set the scan parameters appropriate for the measurement
	1. Click Scan located in the upper left corner of the Video Capture window. For 3D scans, the software asks the user to select the folder and input a file name for the 3D scan. The 3D scan result is automatically stored after the scan finishes.
	2. The stylus automatically lowers towards the sample surface until it engages the sample surface.
	3. If the user does not Abort the scan by clicking Cancel, the instrument automatically begins the scan. The Real Time Display shows the profile as it is scanned.
	4. When the scan is completed, the stylus lifts off the sample surface, the stage returns to its starting position above the start-of-scan location, and the Data Display window is opened with the profile plotted in dimensioned coordinates (see Figure...
	1. From the Data window Open the File drop-down list.
	2. Select Save Data File or Save As Data File. A dialog box is displayed.
	3. Type the name of the file you want to save in the dialog box and press ENTER.
	The Alpha-Step Development Series profiler Application can be set to automatically save a profile after each scan. A description of the Auto File Name function is given in Chapter 4, “Description of Features,” on page 23.



	5.8 Profiling from a Scan Recipe
	5.8.1 Loading a Scan Script
	It is not recommended to use a different folder location for saving the Scripts.
	1. In the Application window, select the File drop-down list.
	2. Select the Load Scan Script.
	3. A Windows File dialog box opens to the default directory.
	4. Select the Scan Script you wish to view. The software allows to load scan recipes with rcp or txt formats.
	5. The Scan Script parameters are automatically entered into the Scan Parameter tab fields.
	6. Review the Scan Parameter values and make changes if necessary before starting a scan.
	1. Click Scan located on the Video Capture window.
	2. The stylus descends to engage the sample surface. The Real Time Scan Display (located on the Main software screen below the Video image window) shows a trace as it is generated.
	3. When the scan is completed, the stylus lifts, the stage returns to its starting position above the start-of-scan location, and the Data Display window is displayed with the profile plotted in dimensioned coordinates (see Figure 5-11). 3D scan resu...
	The trace runs off scale or is not horizontal, refer to ““Manual Stage Leveling” on page 77.
	The scan can only be stopped after the stylus is engaged and the stylus has started moving.
	Figure 5-8 Abort Scan Message Box

	• On the Control panel, in the Z stage pane, click the up arrow. Click once to disengage the tip off the sample surface then raise the Z stage up a short distance to allow safe positioning of the sample under the stylus tip.
	• Ensure that in the video view and/or visually, the tip is clearly above the sample surface.
	• Focus in the Z stage control panel is a good choice to lift the stylus off the sample surface and keep the sample in focus position.


	5.9 Reading the Cursors, Saving and Printing Data
	Figure 5-9 Sample Data Window
	5.9.1 Reading the Cursors
	• To move the R cursor, position the mouse on the R cursor, click and hold the button. Move the mouse right or left to reposition the cursor in a desired location.
	• To move the M cursor, position the mouse on the M cursor, click and hold the button. Move the mouse right or left to reposition the cursor in a desired location.
	• The Delta Width and Delta Height calculate the difference or X distance between the two cursors and the difference or Z height respectively where the cursors intersect the profile.
	Figure 5-10 Data Control Tab with Cursor Information
	1. From the Data window, click the File drop-down list.
	2. Click Print Graph. A Standard Windows Print dialog box is displayed.
	3. Select a printer and make any necessary changes to the printer settings before continuing.
	4. Click Print.
	5. The current view of the profile data is sent to the default printer.
	You can also review the profile before printing in the Print Preview page.

	1. From the Data window, click the File drop-down list.
	2. Click Save Data File. A dialog box is displayed.
	3. Type the name of the file you want to save in the dialog box and press ENTER.



	5.10 Manual Stage Leveling
	Figure 5-11 Front View of Stage with Tilt Control Knob
	It is assumed that in the description that the sample being measured is placed in the center of the stage.

	1. Position the stage and measurement head to take a scan.
	2. Scan a sample.
	3. Watch the Profile trace in the Real Time Scan Display window.
	4. Adjust the Stage tilt using the following:

	5.11 Camera Settings
	Figure 5-12 Camera Utilities
	5.11.1 Camera Parameters Dialog Box
	• Auto Gain: Auto gain is a function to automatically adjust the video gain when imaging samples with different reflectivity. To turn on auto gain:
	1. Press CTRL + M to enable the Camera Utilities function it is not available on the top of video view.
	2. Select the Open camera parameters dialog under Camera Utilities.
	3. Select the Image tab.
	4. Select Auto under Master gain from Hardware Settings.
	5. Click OK to close the Camera Parameters dialog box.
	6. Under Camera Utilities, click Save Camera Parameters to save the change.

	• Color temperature: This is to adjust the display color of the sample. To change the display color:
	1. Press CTRL+ M to enable the Camera Utilities function it is not available on the top of video view.
	2. Select the Open camera parameters dialog under Camera Utilities.
	3. Select the Image tab.
	4. Change the gain factors for the three base colors: Red, Green and Blue. Each of them has its own gain factor. Adjust the gain factors to get the preferred display color.
	5. Click OK to close the Camera Parameter dialog box.
	6. Under Camera Utilities, click Save Camera Parameters to save the change.


	5.11.2 Save Camera Parameters
	5.11.3 Measure Illumination Uniformity
	5.11.4 Keystone Correction
	Figure 5-13 Video Before and After Keystone Correction
	1. Press CTRL+ M to enable the Camera Utilities function if it is not available on the top of video view.
	2. Enable the Apply keystone correction function under Camera Utilities. Now the camera view is corrected with keystone and the scale bar is available on the top left corner of the video.
	3. Disable the Apply keystone correction function under Camera Utilities to disable keystone correction.
	4. To hide the Camera Utilities functions, press CTRL+M again.
	During scanning, the Keystone correction is temporarily disabled.


	5.11.5 Set Keystone Correction Factor
	5.11.6 Select Scale Type
	5.11.7 Set Camera View Width/Height
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	Working with 2D Profiles
	Contents
	6.1 Introduction
	6.2 Data Analysis
	Figure 6-1 Data Window Example
	6.2.0.1 Data Windows
	There is a limit of 10 profiles displayed in the same Data window.
	Data Window Drop-Down Lists
	Figure 6-2 Data Window Tool Bar Drop-Down Lists
	Figure 6-3 File Drop-Down List
	When the Data window is closed it does not prompt the user to save the data first. Any unsaved data might be lost.

	Figure 6-4 Edit Drop-Down List
	Figure 6-5 Tools Drop-Down List
	Figure 6-6 Merge Data Control Window
	It is expected that the user has already placed the calibration standard onto the stage and made a first measurement (more detailed description of the procedure is given in Chapter 10, “System Maintenance”)

	Figure 6-7 Help Drop-Down List
	Figure 6-8 Files Displayed in Drop-Down List
	Figure 6-9 Data Window Alternative Drop-Down List
	Figure 6-10 Data Window Alternative Drop-Down
	Never use this function without the appropriate calibration standard. Follow the instructions in Chapter 10, “Calibrating the Measurement Head”carefully or you risk changing the calibration of the instrument and any measurements you make after that.



	6.2.1 Data Control Tab
	Figure 6-11 Data control Tab
	Figure 6-12 Cursor Control Tab


	6.3 Leveling the Profile
	• Software Leveling: The software has four methods of leveling. The user can manually level the data after a scan or the leveling can be set in the Setup parameters Auto Features tab to automatically level the profile by user specified parameters. ...
	• Mechanical Leveling: Mechanical leveling is discussed in Chapter 5, “Manual Stage Leveling,” on page 77.
	Figure 6-13 Data Display Window with Unleveled Profile
	1. Drag the R (reference) pointer to the location on the profile that you wish to be the baseline for any measurement.
	2. Use the mouse cursor, drag the M (measurement) pointer to the second location you wish to be the baseline for any measurement.
	3. Click Level Data located in the Level Method box.
	Ensure that the Cursor Location radial button is active before leveling the data.

	4. If desired, to undo the leveling use the mouse to click Reload Raw Data.
	Figure 6-14 Profile After Leveling
	Figure 6-15 Average Mode for Leveling Profile (Demo)

	1. Using the mouse, drag center line of the R (reference) pointer to the location on the profile that you wish to be the baseline for any measurement.
	2. Using the mouse, drag the center line of the M (measurement) pointer to the second location you wish to be the baseline for any measurement.
	3. Using the mouse, drag the hashed edge of the right or left side of the R pointer. Move the mouse to the right or left to expand or contract the area used for the Averaging Mode.
	4. Using the mouse, drag the hashed edge of the right or left side of the M pointer. Move the mouse to the right or left to expand or contract the area used for the Averaging Mode.
	5. Reposition the two R and M cursors, if necessary, to fine adjust the scan data you wish to use for leveling.
	6. Click Level Data located in the Level Method box.
	Ensure that the Cursor Location radial button is active before leveling the data.

	7. To undo the leveling, if desired, click Reload Raw Data and the software re-displays the profile as it was before leveling.
	1. Choose the R or M cursor button in the Cursor Control at the bottom right of the Data Display window. This activates the arrow keys for either the R or M cursor.
	2. Use the mouse cursor and Alpha-Step on the up or down arrow key to expand or contract the designated cursor respectively. A single push of the button widens or narrows the cursor one pixel in the chosen direction. The button must be pushed each ti...
	1. Choose the Auto Level-fixed radial button in the Leveling Method box.
	2. Press the Level Data Button, the profile is leveled using the predefined cursor positions set in the Auto Features tab found in the Setup Control Panel.

	1. Choose the Auto Level-Step radial button in the Leveling Method box.
	2. Press the Level Data button. The profile is leveled using the Step Detect settings set in the Auto Features tab found in the Setup Control Panel.

	6.4 Measuring Profile Features
	1. Move the pointer over the R cursor then drag the R cursor to the location on the profile that you wish to be the reference point.
	2. Move the pointer over the M cursor and drag the M cursor to the location on the profile that you wish to be the second location measured relative to the reference point.
	3. The Data Display shows the difference in Z and X position between the R and M cursors at any given time. The user can read these values from the Cursors control box (only for the main, red cursors) to get the height of a profile feature or the lat...
	1. Choose the R or M cursor button in the Cursor Control at the bottom right of the Data Display window. This is activates the arrow keys for either the R or M cursor.
	2. Use the mouse cursor and click the right or left arrow key to move the designated cursor to the right or left respectively. A single push of the button moves the cursor one pixel in the chosen direction. The button must be pushed each time to move...
	3. The Average Mode is available to the user for making a measurement as well as for use during leveling. It operates in exactly the same way as described in the Leveling section above.
	1. Position the cursors as explained in the “Average Mode” on page 99.
	2. Move the mouse cursor to the right boundary of the M cursor, drag the pointer and expand it to a desired width.
	3. Move the mouse cursor to the right boundary of the R cursor, drag the pointer and expand it to a desired width.
	4. Position the M cursor on the step height or feature you wish to measure. The value is displayed in the Cursor Display box.
	1. Choose the R or M cursor button in the Cursor Control at the bottom right of the Data Display window. This is activates the arrow keys for either the R or M cursor.
	2. Use the mouse cursor and click the up or down arrow key to expand or contract the designated cursor respectively. A single push of the button widens or narrows the cursor one pixel in the chosen direction. The button must be pushed each time to ch...
	6.4.1 Reading the Cursor Data
	Figure 6-16 Control Panel Tab Showing Cursor Data
	The profile is displayed and distorted by a much more sensitive scale on the vertical axis than on the horizontal axis. Do not try to estimate angles from the screen because angles that displayed to be significant on the screen might not be. There is...

	Figure 6-17 Data Display Window with Multiple Cursor Pairs
	Only the Red Primary Cursors can be used to level the profile. The added cursor pairs are used in the calculations only. Each cursor pair has different color.

	1. From the Data Display window right-click to open the functions menu.
	2. Select the Add Cursor option.
	3. A new set of R and M cursors are displayed in the Data Display window.
	Figure 6-18 Data Display with Zoom Box for Data Zoom
	Figure 6-19 Data Zoom in the Data Display window

	1. From the Data window, right-click to open the Alternative drop-down list.
	2. Use the cursor to select the Zoom options; this displays the Zoom drop-down list.
	3. Click In option.
	1. From the Data window, right-click to open the functions menu.
	2. Select the Zoom option to open the Zoom drop-down list.
	3. Click Window. A green Zoom box is displayed in the Data Display window.
	1. Position the mouse cursor inside the Zoom box.
	2. Click and hold the mouse button, a four arrow cursor is displayed.
	3. Move the mouse to reposition the Zoom box over a section of the profile you wish to magnify.
	4. Release the mouse button.
	5. Right-click to Zoom. The boxed data set is expanded in the Display screen.
	6. Repeat the above steps to Zoom into another feature of interest.
	1. While the zoom box is active in the Data window, right-click again to open a menu to accept or cancel the zoom area.
	2. Select the Zoom option to display the new magnified view of the profile section.

	6.4.2 Calculation Setup

	6.5 Scaling Data
	Figure 6-20 Graph Setup Window
	1. From the Data Display window, right-click to open a drop-down list.
	2. Select Set Graph Scales and the Graph Setup window is displayed.
	1. Deselect the check boxes for Auto Scale.
	2. Type a number in the X Maximum field.
	3. Type a number in the X Minimum field.
	4. Type a number in the Z Maximum field.
	5. Type a number in the Z Minimum field.
	If the user would like to use the new graph scale values for more than one scan, select the Use these values as defaults check box. Otherwise the graph scales can be set to the default auto scale for any additional scans.

	6. Click Ok to apply the new settings and close the Graph Setup window.

	6.6 Data Analysis Tab
	Figure 6-21 3 Profiles loaded in Data Display Window
	6.6.1 Data Analysis Tab Features
	Figure 6-22 Tool Bar Description

	6.6.2 Using the Data Analysis Tab
	To open the Analysis tab with any of the methods described in the followings it requires the user to have selected at least one parameter in the Calculation Control.
	1. From the Data window, select the Tools drop-down list.
	2. Click Data Analysis.
	3. The software calculates the selected Calculation parameters set in the Calculations window.
	1. From the Application window, select the Tools drop-down list.
	2. Click Data Analysis.
	3. The software calculates the selected Calculation parameters set in the Calculations window.
	1. From the Application window, select Data Analysis from the toolbar.
	2. The software calculates the selected Calculation parameters set in the Calculations window.
	The Data Analysis tab displays the Average and Standard deviation of the parameter results from all the profile data from all the open Data windows.



	6.7 Saving and Exporting Calculation Results
	6.7.1 Printing Calculation Results
	1. Select Print in the Results window.
	2. The software displays the Windows Printer dialog box for your default printer.
	3. Click OK or the press ENTER to print the results.
	4. Close the Results window to return to the Data Display window.

	6.7.2 Printing the Profile
	1. From the Data Display window, click the File drop-down list.
	2. Click the Print menu. The Printer dialog box is displayed.
	3. Select Print or press ENTER to print.

	6.7.3 Printing using the Screen Capture Function
	6.7.3.1 Full Screen Capture
	1. After you have displayed the profile, Results, or any part of the Alpha-Step Development Series profiler software, simultaneously hold down the PRINT SCRN.
	2. The monitor screen view window is saved to the Clipboard.
	3. Use the Paste function to place the Clipboard image into a word processor or graphics editing program (CTRL-V).
	4. The image is copied into the open word processor or graphic program.
	5. The image is ready to make any annotations, captions, or include in a presentation.

	6.7.3.2 Active Window Screen Capture
	1. After you have displayed the profile, Results, or any part of the Alpha-Step Development Series profiler software, simultaneously hold down the CTRL-ALT-PRINT SCRN keys.
	2. The Current window is saved to the Clipboard.
	3. Use the Paste function to place the Clipboard image into a word processor or graphics editing program (CTRL-V).
	4. The image is copied into the open word processor or graphic program.
	5. The image is ready to make any annotations, captions or include in a presentation.


	6.7.4 Saving Data
	1. Click the File drop-down list in the top left corner of the screen.
	2. Click Save Data File. A dialog box is displayed.
	3. Type the name of the file you want to save in the dialog box and press ENTER.
	1. Click the File drop-down list in the top left corner of the Data Display window and click Save As.
	2. Enter the file name to save in the Save As dialog box and press ENTER


	6.8 Software Filter Settings
	• Short wavelength filter cut off, known as High Pass
	• Long wavelength filter cut off, known as Low Pass
	6.8.1 Using Cutoff Filters
	Figure 6-23 High Pass and Low Pass Filters

	6.8.2 Using Polynomial Filters
	6.8.3 Using Step Fit
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	Advanced Features
	Contents
	7.1 Introduction
	3D scanning and Sequence Scans are only available for D-600 which has the motorized stage.

	7.2 3D Scanning
	7.2.1 Setting up and Running a 3D Scanning
	1. Select the Scan Parameters tab.
	Figure 7-1 Scan Parameters Tab

	2. Set up the scan parameters for the individual scans including scan Speed, scan Length, Profile type, scan height Range, scan Direction, Stylus Force and Filter Level. Refer to “Chapter 4, “Scan Parameter Tab,” on page 42 for the definition o...
	3. Select the 3D option to enable the 3D scanning.
	4. Type the Width of the scan area
	5. Type the number of Traces of the 3D scan. If either the value for Width or Spacing is changed, the traces are updated automatically.
	6. Type the Spacing between the traces. If the value of the number of traces is changed, the spacing is updated automatically.
	7. Click Scan in Video Capture to start the 3D scan. A pop-up window is displayed to select a directory and enter a file name for the 3D scan.
	8. After the scan is finished, the result is saved in the selected directory. At the same time, Apex automatically starts and opens the 3D result. If Apex is already open and has data inside, the new 3D result appends at the end of the Apex file.

	7.2.2 Viewing a 3D Data File
	1. Double-click the Apex icon on your desktop or start the program from the Windows Start menu.
	2. Select the File drop-down list or use the Open a Studiable icon on the tool bar of the Apex software screen.
	3. Navigate to the Data folder, or the folder that the 3D file you are interested in viewing is located.
	4. Select the file you want to open and the 3D top view of the data is displayed in the window.
	5. Click Open.
	6. The data is displayed in Apex.


	7.3 Sequence Scans
	7.3.1 Sequence Control Panel
	Figure 7-2 Sequence Control Pane
	Recipe
	Deskew
	• Adjust X: if this is selected, the X-coordinate of the deskew site is used as the X-coordinate of the first scan site, and the X-coordinate of all the other sites are adjusted the same way as the first site.
	• Adjust Y: if this is selected, the Y-coordinate of the deskew site is used as the Y-coordinate of the first scan site, and the Y-coordinate of all the other sites are adjusted the same way as the first site.
	1. Active the Sequence Control pane, load or setup a sequence recipe.
	2. Click Start, under Run Mode to start the sequence recipe.
	3. After selecting the folder and entering the file name to store the data, with the popup window, the Deskew function is displayed at the bottom of the Control Pane.
	Figure 7-3 Deskew Confirmation Function in Control Pane

	4. The stage then moves to the first scan site, focuses on the sample and then lifts up the stylus.
	5. Navigate the sample to a new location that is the deskew position for the Sites List.
	6. Click OK, see Figure 7-3, to accept the current stage location as the Deskew site. Then the sequence scan starts.
	7. Click Cancel to quit the Deskew function. Click Stop, under Run Mode to stop the sequence scan or move the stage to a new location and the Deskew function is available again.


	Coordinates
	• Discrete - If this is selected, the sequence can be a discrete sequence. All the following parameters Mode can be disabled, and the user can add or edit any site individually. If the Sites Table is created using Matrix Mode, changing Mode from Ma...
	• Matrix - This defines the Sites list is in a Matrix type. Changing Mode from Discrete to Matrix is creates a new Sites Table with the first available site together with the parameters in Matrix Mode.
	• Rows (Y) - The user needs to define the number of rows and the pitch between the adjacent rows for the Sites matrix.
	• Columns (X) - The user needs to define the number of Columns and the pitch between the adjacent columns for the Sites matrix.
	• Stitch -This option can be available only when the scan recipe is a 2-D scan recipe. If this option is checked, the tool can scan up to ten individual scans and then stitch the profiles together to form a long profile. In this way, the scan lengt...
	• Populate - If there is no site in the Sites table, this creates the matrix sites list using current stage coordinates and Matrix parameters. If there are sites in the Sites table, this is updating the sites table using the first site in the Sites...



	7.4 Stitch Pre-Saved Data
	7.4.1 Opening the Stitch feature
	1. With the mouse cursor, select the Tools drop-down list at the top left corner of the Main software screen.
	2. Select the Stitch option.
	1. From the Main software screen, press the ALT + T keys to open the Tools drop-down list.
	2. Press S to open the Stitch function.
	1. With the mouse cursor select and click the Tools drop-down list at the top left corner of the Data Display window.

	7.4.2 Stitch Control Panel Description
	Figure 7-4 Active Stitching windows
	Figure 7-5 Data window with Stitched Composite Profile
	7.4.2.1 Stitching
	1. Open the Stitch Control Panel.
	2. Press the Base Profile button to load the first profile. A Load Data window is displayed.
	3. Choose a profile that is the first profile of the composite profile and click OK to load the profile data into the software.
	4. Click Append Profile in the Stitch control panel. The Load Data window is displayed.
	5. Select the profile that is the second profile in the composite profile and click OK to load this profile data into the software.
	6. Select Stitch on the control panel. This adds the second profile onto the end of the first profile loaded as the Base Profile.
	7. Repeat step 5 and step 6 for each additional profile you wish to stitch together. The software allows up to five profiles to be stitched together.
	8. After you have finished loading and stitching all the profiles together, click OK to close the Stitch Control Panel.

	7.4.2.2 Displaying the Stitched Profile

	7.4.3 Multiple Scans
	7.4.3.1 Using the Multiple Scan Feature
	Loading Multiple Data Files
	1. With the mouse cursor select the File drop-down list at the top left corner of the Data Display window.
	2. Select the Load Data File option. The Load Data window is displayed.
	3. Go to the data folder of interest and select the first file you wish to load by clicking once to highlight the file.
	4. Loading consecutive and non-consecutive data files:
	5. Press the Open button to accept the choices. The Load Data window is closed and the selected profiles are loaded into the Data Display window.
	Up to 10 profiles can be loaded at one time. All of the Data files must have the same scan parameters or an error message is displayed. Clicking on the error message box closes the message and the data file is skipped from loading. All the data files...


	Adding Additional Profiles to the Data Display window
	1. Click the File drop-down list at the top left of the Data Display window.
	2. Click the Add Data File option. The Load Data window is displayed.
	3. Go to the data folder of interest and select the first file you wish to load by clicking once to highlight the file. If you are only adding 1 data file, skip to step 5.
	4. Loading consecutive and non-consecutive data files:
	5. Press the Open button to accept the choices. The Load Data window is closed and the selected profiles are loaded into the Data Display window.
	Up to 10 profiles can be loaded at one time. All of the Data files must have the same Setup parameters or an error message is displayed. Clicking on the error message box, closes the message and the data file is skipped from loading. All the data fil...


	Removing a Profile from Data Display window

	7.4.3.2 Using the Calculations for Multiple Profiles
	Figure 7-6 List of Data Files loaded into Data Display Window
	Changing the Focus of a Profile



	7.5 Height Histogram
	Figure 7-7 Height Histogram in Data Display Active window
	7.5.1 How to Use the Height Histogram
	1. Click Height Histogram located in the bottom right corner of the Display window.
	2. In the Number of Population Bins field, choose the number of bins you wish to sort the data. Increasing or decreasing the number of bins changes the resolution and size of the histogram peaks respectively.
	3. Click Apply. The window re-displays your data with the revised number of bins.
	4. Click Close at the bottom of the window to close the Height Histogram window and return to the Data Display window.
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	Apex 2D/3D - Getting Started
	Contents
	8.1 Introduction
	8.1.1 License Agreement

	8.2 Overview of Apex 2D/3D
	8.2.1 Starting the Software
	Figure 8-1 Empty Apex Document

	8.2.2 Loading a Studiable
	Figure 8-2 General Toolbar
	Figure 8-3 Example Data Directory

	8.2.3 Applying an Operator or Carrying out a Study
	Figure 8-4 Applying an Operator
	Figure 8-5 Carrying out a Study
	Building an Analysis Document
	Figure 8-6 3D Representation of the Measured Motor Cylinder
	Figure 8-7 Measurement of the Angle and the Distance between Grooves
	Figure 8-8 Extraction of an Oblique Profile
	Figure 8-9 Removing the Circular Form
	Figure 8-10 Separating Roughness and Waviness
	Figure 8-11 Calculating Roughness Parameters
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	Thin Film Stress Module
	Contents
	9.1 Introduction
	9.1.1 Overview

	9.2 Thin Film Stress Window
	Figure 9-1 Thin Film Stress Control Window

	9.3 Using the Thin Film Stress Option
	It is important that the scans taken for the Thin Film Stress Option be measured using identical setup parameters or software error might occur.
	9.3.1 Saving Data
	9.3.2 Taking a Pre-stress Scan
	9.3.3 Saving and Loading a Scan Recipe/Sequence Recipe
	1. From the Main window, select the required option from File drop-down list at the top left corner of the window.
	2. Click Save Scan Recipe/Save Sequence Recipe.
	3. Choose a folder and type the name of the scan recipe/sequence recipe, and then click Save.
	1. From the Main window, select the required option from File drop-down list at the top left corner of the window.
	2. Click Load Scan Recipe/Load Sequence Recipe.
	3. Choose the target scan recipe/sequence recipe, and then click Open.

	9.3.4 Loading and Positioning the Sample
	Figure 9-2 Alpha-Step D-600 Wafer Stress Chuck
	Figure 9-3 Universal Chuck (for D-600)
	Figure 9-4 Alpha-Step D-500 Wafer Stress Chuck
	1. Place the wafer on the three pin locators. Rotate the wafer so that the flat/notch is facing the front of the stage towards the operator.
	2. Center the wafer on the three pin locators. Use your finger tips to align the wafers outer edge on the pins.
	1. Mount proper locating pins on the chuck according to the wafer size and reference type (notch/flat).
	2. Place the wafer on the three stress locators, use locating pins to precisely locate the wafer: the flat/notch is firmly against the locating pin(s), and the wafer left side is against the other locating pin.
	When manually loading the sample, make note of the position of the sample on the sample chuck. To compare pre- and post-stress measurements, you must duplicate the scan position for both measurements as close as possible to reduce user-induced variat...

	1. Create and save a scan recipe with proper scan parameter settings. For the details about setting the scan parameters, refer to Chapter 4, “Scan Parameter Tab,” on page 42 for saving a scan recipe, refer to Chapter 9, “Saving and Loading a Sc...
	2. In Sequence Control panel, click Scan to load the previously saved scan recipe.
	3. Move the sample to the starting point, and add the coordinates as the first measurement site.
	4. Select Matrix Mode, select the Stitch check the box, set Rows (Y) and Pitch numbers based on the scan length.
	5. Click Populate and the site coordinates is added to the site list automatically.
	6. Click Save As to save the current sequence recipe. For details about saving a sequence recipe, refer to Chapter 9, “Saving and Loading a Scan Recipe/Sequence Recipe,” on page 148.
	7. Click Start and a Sequence Scan File Name dialogue box is displayed.
	8. Type the Root File Name, select the Data Path, and then click OK. It starts to scan.


	9.4 Taking a Difference Measurement
	If a pre-stress profile has not been saved before computing a difference measurement, the difference measurement can be computed assuming a totally flat pre-stress sample profile.
	9.4.1 Selecting a Sequence Recipe
	9.4.2 Loading and Positioning the Sample
	• The sample has been processed.
	• It was scanned before the processing.
	• The pre-stress profile has been saved in the data folder.
	Position the sample exactly as it was positioned for the pre-stress scan.
	1. If you are using the Precision Wafer Chuck, use the precision locator with the three support points. Ensure that you position that sample the way it was positioned for the pre-stress scan paying particular attention to the rotation of the sample o...
	2. The user can program the instrument so that the load position moves the stage to exactly the right scan position.



	9.5 Taking a Single Post Stress Management
	3. Load the sample.
	4. Profile the sample. Refer to Profiling the Sample on page 153 for details.
	5. Go to Thin Film Stress Calculation window.
	6. Enable the Calculate on Post stress data only box (this deactivates the post-stress file field).
	7. Click Load Post Stress File and choose the post-stress file name applicable to the calculation.
	8. Type the stress parameters in the appropriate fields of the Thin Film Stress Calculation window.
	9. Click Calculate.

	9.6 Recalculating Stress Measurements
	1. Open the Thin Film Stress Calculation window.
	2. In the File field, load the pre-stress and post-stress profiles that you wish to use for the new wafer stress calculation or difference profile.
	3. Enter the appropriate stress parameters and elastic constant (refer to “Thin Film Stress Window” on page 145 for details).
	4. Select Apply Calculation to Data. The summary calculations are displayed in the dialog box and the difference is subtracted from the last open data set.
	5. Close the Thin Film Stress Calculation window.
	6. View the Data Display window to see the difference profile.
	7. Save the new difference profile.

	9.7 Use a Difference Measurement to Subtract from a Scan Profile
	9.7.1 Taking a Background Scan
	1. Load the optical flat or comparable sample for which you already have a scan recipe or sequence recipe (otherwise refer to Chapter 4, “Scan Parameter Tab,” on page 42 for instructions).
	2. Press Scan. The Main software screen is displayed during the scan. After the scan is complete, the Data Display window is displayed with the profile.
	3. Right-click the Data Display window and select Save As.
	4. The Data folder dialog box is displayed. Type a file name that can be easy to associate with the background systematic measurement.
	5. Press ENTER or click Save.
	1. With the sample loaded and ready, press the Scan button on the Main software screen.
	2. The Data Display window opens with the profile. Save the data.
	3. Open the Wafer Stress Calculation window.
	4. In the Files box are two fields, the pre-stress file field and the post-stress file field.
	5. Enter the stress parameters as described in, “Thin Film Stress Window” on page 145.
	6. Select the Apply Calculation to Data button. Ignore the calculated stress values as they are erroneous.
	7. Close the Thin Film Stress Calculation window.
	8. Open the Data Display window. The profile data shown is the difference of the sample of interest and the systematic background noise.
	9. From the Data Display window, right-click to open the drop-down list.
	10. Select Save As.
	11. In the Save As window, type a name for the profile. Press ENTER or click Save to save the data and close the window.
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	System Maintenance
	Contents
	10.1 Introduction
	10.2 Linear Calibration Procedure
	10.2.1 Long Range Calibration
	1. Calibration Sample: Place your 50 µm step-height standard on the scan-stage and align the step so that you can measure the calibrated region within the U shaped designators, as shown in Figure 10-1 (The arrow in Figure 10-1 shows where both linea...
	Figure 10-1 50 µm Step Measurement Feature

	2. Level Scan Stage: In order to ensure an accurate calibration the scan stage must be precisely leveled. Navigate to the toolbar and click File > Load Scan Recipe and open the Scan Recipe labeled CTD-D500-600-Linearity-50 μm-StageLevel.rcp.
	3. Click Data Analysis to view the Z(M) - Z(R) value of the cursor positions within the scan data, or simply observe the Delta Height value in the Data Control panel at the right of the screen. This value must be less than 2,000 Å before proceeding ...
	Figure 10-2 Measurement Feature (Precise Stage Leveling)

	4. Align the Step: After the sample is level navigate to the toolbar and click File > Load Scan Recipe and open the file labeled CTD-D500-600-Linearity-50 μm-Measurement.rcp. This file sets the auto functions to level and measure the feature with re...
	5. Adjust the position of the step and perform subsequent test scans until the resulting scan data is displayed as shown in Figure 10-3:
	Figure 10-3 Measurement Feature Centered in Middle of Scan Length

	6. Begin Long Range Linearization: Type the L key, or select Tools > Linear Calibration from the tool bar, and the Linear Calibration panel is displayed as shown in Figure 10-4.
	Figure 10-4 Linear Calibration Panel
	Figure 10-5 Leveling Scan Stage
	Figure 10-6 Scan Over 50 µm Step Height

	7. End Long Range Linearization:
	8. Z-Height Calibration:

	10.2.2 Short Range Calibration
	1. Calibration Sample: There are two types of 1 µm step height standards as in Figure 10-7. One of them is shipped with the tool. Place your 1 µm step-height standard on the scan-stage and align the step so that you can measure the calibrated regio...
	Figure 10-7 1 µm Step Measurement Feature

	2. Level Scan Stage: In order to ensure an accurate linear calibration the scan stage must be precisely leveled. It is important to complete this step, even if the stage was previously leveled for Long Range calibration, because the two calibration s...
	Figure 10-8 1 µm Step Measurement Feature after Precise Stage Leveling

	3. Align the Step: Navigate to the toolbar and click File > Load Scan Recipe and open the Scan Recipe labeled CTD-D500-600-Linearity-1um-StageLevel.rcp This file sets the auto functions to level and measure the feature with respect to particular loca...
	Figure 10-9 1 µm Step Height Measurement Feature

	4. Begin Short Range Linearization:
	Figure 10-10 Linear Calibration Panel

	5. End Short Range Linearization:
	6. Z-Height Calibration:

	10.2.3 Linear Calibration Details
	10.2.3.1 Linear Calibration Frequency
	10.2.3.2 Long Ranges
	10.2.3.3 Short Ranges
	10.2.3.4 Linear Calibration Reminders
	Table 10-1 Typical Cases Requiring Calibration
	Figure 10-11 Linear Calibration Panel - Software Reminders
	Figure 10-12 Linear Calibration Reminder Panel


	10.2.4 Troubleshooting Linear Calibration
	10.2.4.1 Alignment Voltage is too Low
	Figure 10-13 Warning for Error in Electro-Optical Alignment Voltage

	10.2.4.2 Calibration Failure
	Figure 10-14 Error Message - Unable to Engage for Scan
	Figure 10-15 Error Message - Scans are Corrupted



	10.3 Calibrating the Measurement Head
	10.3.1 Calculating the Calibration Factor
	1. In the Scan Parameters tab, select the scan range that you want to calibrate.
	2. Load onto the sample stage the height standard representative of the height range that you are measuring or the standard sample included with your system.
	Ensure that the Setup parameters are consistent with factory settings used during factory calibration as described in the certification documentation included with your system.

	3. Scan the standard sample step height.
	4. In the Data Display window, position the R and M cursors on the features of the scan that is the baseline (refer to Chapter 6, “Leveling the Profile,” on page 97 for more explanation).
	5. Click Level Data.
	6. Position the R cursor just outside a step.
	7. Position the M cursor on the top of the step height feature.
	8. Use the Average Mode for both cursors to maximize the number of data points being used to set the baseline and step height (refer to “Chapter 6, “Leveling the Profile,” on page 97) if not already done during the leveling procedure.
	9. In the Data Display window, right-click the mouse button, select the Calibrate Height function.
	10. The software prompts the user if the cursors are in the correct location for calibration. click OK if you have already positioned the cursors; click No to close the window and reposition the cursors.
	11. In the Calibration Data dialog box, type the step height in Angstroms of the standard sample being measured. See Figure 10-16.
	Figure 10-16 Calibration Data Dialog Box

	12. Click OK. The software calibrates the system using the measured height value.


	10.4 Changing the Stylus
	Figure 10-17 Stylus Inserted into Stylus Clamp
	1. Lock the pivot using the dowel plunger.
	2. Using tweezers or small pliers gently grab the stylus shaft and pull the stylus straight out of the clamp.
	Be careful to not touch the diamond tip of the stylus you might cause damage and get dirt on the tip.

	3. Store the old Stylus in a safe place.
	4. Using tweezers grab the new stylus as shown in Figure 10-17.
	5. Gently insert the stylus into the spring clamp with the flat side of the tapered end facing to the left (flat side the spring clip). You have to press fairly strongly depending on the tightness of the spring clam for that instrument. The stylus is...
	6. Release the stylus lock by unlocking the dowel plunger (refer to “Unlocking the Pivot Assembly” on page 38”).
	The KLA-Tencor service policy does not cover damage to the stylus, the stylus arm assembly, or the pivot caused by operator error.


	10.5 Stylus Tip Centering
	1. Change the Magnification of Zoom Lens to 4X in the Control Panel.
	2. Focus the stylus on a sample.
	3. Use CTRL + M to bring up Camera Utilities on top of video view.
	4. Select Camera Utilities > Open Camera Parameters dialog box. Select Size tab and adjust the Left and Top offsets to center the stylus tip in the camera view as in Figure 10-18.
	Figure 10-18 Camera Parameters Dialog Box

	5. After the stylus tip is centered in the video view, close the Camera Parameters dialog box.
	6. Under the Camera Utilities, click Save Camera Parameters to save the changes made.
	7. Repeat the same procedure for magnification of 2x and 1.3x.
	This procedure does not work on magnification of 1x. If the stylus tip is far off from the center of the video view, first check whether the stylus is mounted correctly. If the stylus is mounted correctly and the stylus tip is far off from the center...


	10.6 Software Maintenance
	10.6.1 Backing Up Files
	1. Go to the local disk drive C.
	2. Double-click the KLA-Tencor folder.
	3. Double-click the AlphaStep D folder.
	4. Select the Data folder and the Setup folder and copy each one to a Server, CD-ROM, or other data storage device that your facility uses for backup purposes.

	10.6.2 Restoring Data and Scan Recipes
	1. Insert the CD-ROM, or other storage media into the appropriate drive location or use the Windows Explorer to locate the Network drive where the Data or Scan Recipes are backed up.
	2. Right-click the Data or Setup folder to be copied. A drop-down list is displayed.
	3. Select Copy to copy the folder to the computer Clipboard or Drag the folder to the software folder in drive C. The files are copied to their respective folders.
	4. If there are already copies of the files in drive C, a prompt message indicating that the files overwrite is displayed.
	5. Close the Windows Explorer program.


	10.7 Help Files
	1. Click the Help drop-down list located at the top of the Main software screen.
	2. Click Contents to open the help window.
	3. Follow the directions in the help window.
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